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DEEL A – HOE OM TE BEGIN: 

1. Algemeen – Diere Identifikasie en Nommering: 

 Individuele identifikasie: 
Individuele identifikasie van diere is natuurlik die basis van rekordhouding. Die mees algemene metode van 

identifikasie is ’n plastiese oorplaatjie met die die dier se unieke nommer daarop. Die verkeerde lees en/of 

neerskryf van oorplaatjie nommers is egter ’n algemene bron van foutiewe dierrekords. Elektroniese 
identifikasie is ’n metode wat vinnig veld wen, hoofsaaklik omdat die lees van ’n elektroniese ID nommer 

(EID) met behulp van ’n EID leser, vinnig en akkuraat is. BenguFarm intergreer ten volle met elektroniese 
identifikasie stelsels – gesels met jou BenguFarm agent of besoek bengufarm.co.za vir meer inligting. 

 
Ons beveel sterk aan dat minstens twee wyses van individuele identifikasie gebruik word, vir die eenvoudige 

rede dat indien die een verlore gaan (bv. ‘n plastiese oorplaatjie wat uitskeur of afbreek), die dier steeds 

geïdentifiseer kan word en die historiese rekords dus nie verlore gaan nie. Die identifikasie metode vir 
registreerde (stoet) diere word voorgeskryf deur die betrokke telersgenootskap. Dit bestaan gewoonlik 

uit ‘n permanente (primêre) metode (bv. brand of tatoeëer) en ‘n sekondêre metode (bv. oorplaatjie of 
oorknippe en/of elektroniese ID), afhangende van die betrokke ras. Die individuele identifikasie metode vir 

kommersiële (nie-stoet) diere word nie voorgeskryf nie, maar een van die volgende opsies word 

aanbeveel: 

• Brand of vriesbrand of tatoeëer + oorplaatjie (VID) of 
• Elektroniese ID (EID) + oorplaatjie of 
• Oorplaatjie + staal oorplaatjie of 
• Brand of vriesbrand of tatoeëer + elektroniese ID (EID). 

 

Kalwers behoort so gou prakties moontlik na geboorte gemerk te word met minstens een van bogenoemde 
metodes, gewoonlik ’n plastiese oorplaatjie of oorknippe en/of elektroniese ID. Wanneer kalwers gespeen 

word, behoort hulle dan ook met ’n tweede metode gemerk te word, bv. brand of tatoeëer. Dit word ten 
sterkste ontmoedig om by geboorte kalwers met ’n tydelike ID nommer in BenguFarm aan te teken en dan 

later, bv. wanneer hulle gespeen word en besluit word watter gehou gaan word, daardie kalwers se ID 

nommers te verander, aangesien dit onnodige ekstra werk skep en verwarring kan veroorsaak. 
 

ID Nommer formaat: 
Die nommer formaat vir registreerde (stoet) diere word voorgeskryf deur die betrokke telersgenootskap. 

Die internasionale ID nommer format is die betrokke kudde se Kuddekenmerk (bv. ABC) + Jaar van Geboorte 

(bv. 19 vir 2019) + Volgnommer (bv. 1 vir die eerste kalf gebore in die jaar). In hierdie voorbeeld sal die 
dier se ID nommer ABC191 wees. In BenguFarm behoort dit ABC190001 wees. Die voorafgaande nulle by 

die volgnommer is vir sortering doeleindes. Die nommer format vir kommersiële (nie-stoet) diere word 
nie voorgeskryf nie, maar ons beveel aan dat die ID nommer bestaan uit die betrokke kudde se Brandmerk 

(opsioneel) + Jaar van Geboorte (bv. 19 vir 2019) + Volgnommer (bv. 1 vir die eerste kalf gebore in die 

jaar). Die meeste kommersiële boere gebruik net die jaar van geboorte plus ‘n volgnommer. In bogenoemde 
voorbeeld sal die dier se ID nommer 191 wees. In BenguFarm sal dit 1901 of 19001 of 190001 wees, 

afhangende van hoeveel kalwers verwag word per jaar. 
 

Dit is baie belangrik dat daar in BenguFarm BEEF geen duplikaat nommers mag wees nie, aangesien dit 
talle probleme veroorsaak. Verkieslik moet verskillende ID nommers vir diere in verskillende kuddes op 

dieselfde databasis gebruik word, byvoorbeeld stoetdiere se volgnommers 1 – 499 en kommersiële diere se 

volgnommers 501 - 999. ’n Ander opsie is om in BenguFarm die ’n letter vooraan die nommer te sit wat die 
kudde aandui, bv. B191 vir die eerste Bonsmarakalf van 2019 en N191 vir die eerste Ngunikalf van 2019. 

Let wel: Gebruik twee (nie slegs een nie) karakters vir die jaar van geboorte (bv. 19 in plaas van 9 vir diere 
gebore in 2019) om te verhoed dat daar duplikaat nommers oor die lang termyn in die BenguFarm databasis 

ontstaan. Sien paragraaf 6, ID Metodes en Nommering, vir opstellings van verstek metodes en 

formate in BenguFarm. 

 
Alternatiewe nommers: 
Die IDnr (ook genoem die visuele ID of VID) is die primêre nommer van ‘n dier in die program. Diere word 

op hierdie nommer opgesoek en gesorteer. BenguFarm maak egter ook voorsiening vir, waar van toepassing, 

die rekordhouding van ander nommers, naamlik: Mikroskyfienommer (EID), Naspeurbaarheidsnommer, 
Rekenaarnommer (slegs stoet), Dier ID [amptelik] (slegs stoet), Dier Naam (slegs stoet), DNA Nommer 

(gewoonlik slegs stoet), Biobanknommer (slegs stoet), Skaalnommer en Lotnommer. Om ‘n dier op ‘n 
ander nommer op te soek, gaan na Diere > Soek Dier. 
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2. Installeer BenguFarm: 

BenguFarm is die oorkoepelende sagteware produk met verskeie modules, naamlik BEEF, 
SHEEP & GOATS, GAME, PIGS en GENETICS. In BenguFarm kan aparte databasisse vir die onderskeie 

modules opgestel word. Die module wat gebruik word vir die bestuur van vleisbeeste word BenguFarm BEEF 

genoem. Jy installeer dus BenguFarm, waarna ’n vleisbees databasis registreer word vir die BEEF module.  
 

Om die program van die Internet af te laai en te installeer: 

• Gaan na www.bengufarm.co.za > Downloads > Software. Volg die instruksies op die skerm om die 
volgende sagteware af te laai en te installeer: 

o Crystal Reports Basic Runtime for Visual Studio 2008 [18MB] (derdeparty sagteware wat gebruik 

word vir die skep van verslae); en  
o BenguFarm Installer 21 April 2022 [47MB] of nuwer weergawe. Nota: Indien jy ‘n 

sekuriteitswaarskuwing kry, kies "More Info > Run" of "Allow" of "Run Anyway". 
o Indien jy die opsionele BenguFarm GENETICS Telingsbestuur module saam met BenguFarm 

BEEF gekoop het, ook die BenguFarm GENETICS Installer. 

• Gaan na Downloads > Updates en laai die nuutste weergawe [10MB] van die BenguFarm sagteware af 
en installeer dit. Indien Windows die opsie "Discard" of "Keep" gee wanneer jy die opdateringslêer begin 

aflaai, kies "Keep". Indien jy Avast, Avira, Kaspersky, McFee of Norton as antivirus program op jou 

rekenaar het, mag dit nodig wees om dit tydelik te de-aktiveer (op eie risiko), aangesien hierdie antivirus 
programme dikwels die opgradering lêer sonder waarskuwing blokkeer. 

3. Maak BenguFarm vir die eerste keer oop: 

Dubbel kliek op die BenguFarm program logo op Windows se hoofskerm. ’n Boodskap “Do you want to allow 
this app (BenguFarm)…” sal vertoon. Kliek “Yes”. BenguFarm sal nou oopmaak en die “Welkom in 

BenguFarm” skerm vertoon. Op hierdie skerm moet jy die volgende invoer: 

• Taal: Kies die taal waarin jy verkies om op die program te werk. (Jy kan dit enige tyd verander 
indien nodig). 

• Geregistreerde Gebruiker Naam: Dit word op die BenguFarm verwelkomings epos aangedui. 

(Bv. Vetbees Boerdery BK). Maak asseblief seker dat dit korrek is, aangesien jy dit nie later self kan 
verander nie. (Hierdie naam sal aan die onderkant van alle BenguFarm BEEF verslae vertoon word). 

• Primêre kudde: Merk “Primêre Kudde (bv. Stoetkudde) wat ek op BenguFarm wil bestuur”.  
o By Module, kies “Cattle”. 
o By Ras/Spesie, kies die betrokke ras.  
o By Beskrywing, vul die naam van jou kudde, of primêre kudde indien jy meer as een kudde 

het, (bv. Mooibees Bonsmara Stoet) in. 
• Basiese (nie-stoet) Program Uitleg: Merk hierdie opsie indien die skerms, verslae en velde wat 

slegs op stoetkuddes van toepassing is, afgeskakel moet word. Hierdie opsie moet dus gemerk word 

indien dit ‘n kommersiële (nie-stoet) kudde is. 

• Sekondêre kudde: Merk “Sekondêre Kudde (bv. Kommersiële kudde) wat ek op BenguFarm wil 

bestuur” slegs indien ‘n tweede kudde van toepassing is.  
o By Module, kies “Cattle”. 
o By Ras/Spesie, kies die betrokke ras.  
o By Beskrywing, vul die naam van die betrokke kudde (bv. Vetbees Kommersieel) in. 

• Lees die instruksies by paragraaf 7 vir die skep van addisionele kuddes voordat jy besluit 
oor die opsie “Skep die Onderskeie Kuddes in dieselfde Databasis”. 

• Kliek op “Aanvaar hierdie Opstellings”. 

4. Registreer BenguFarm BEEF: 

Daar sal nou ’n skerm verskyn wat jou waarsku dat die program registrasie verval het/nog nie gedoen is nie 
en dat jy die program slegs vyf dae kan oopmaak sonder om te registreer. Indien jy onmiddellik wil registreer, 

kliek op “Registreer/Hernu Registrasie Nou”. Op die Registrasieskerm by “BenguFarm Module (Spesie)”, kies 
“Beeste”. Om te registreer, kontak asseblief Mev. Naomi Havenga by 082 696 8306 of stuur ’n epos na 

accounts@benguelasoft.co.za. Verskaf aan haar die volgende besonderhede: 

• Jou geregistreerde BenguFarm BEEF gebruiker naam (soos ingevul op die bestelvorm) en 

rekeningnommer (soos aangedui in die Welkom epos van BenguelaSoft), 

• Die Rekenaar Identifikasie Kode (kode links bo-aan die registrasie skerm), 

• Die aantal kuddes waarvoor jy die program wil registreer. 
Vul by Rekeningnommer jou BenguFarm rekeningnommer (BPU....) in, by Toegang die toegangskode wat 

Naomi vir jou sal gee en kliek dan op Verander Kliënt Rekeningnommer. Vul nou by Registrasie Kode die 

http://www.bengufarm.co.za/
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regisrasiekode en by Toegang die toegangskode in wat Naomi vir jou sal gee en kliek dan op 

Registreer/Herregistreer.  
 

Vir na-ure registrasies, kontak asseblief Mnr. Leslie Bergh (082 801 2026) of Mnr. Johan de Jager (083 305 

1042) en verskaf bogenoemde besonderhede. 
 

BenguFarm agente maak gebruik van Teamviewer sagteware vir afstand (Internet) ondersteuning. 
Teamviewer kan, indien geïnstalleer, vanuit BenguFarm oopgemaak word deur op die hoofskerm te gaan na 

Hulp > Teamviewer Afstand Ondersteuning. Indien nie geïnstalleer, kan Teamviewer afgelaai en geïnstalleer 
word by www.bengufarm.co.za > Downloads > Software > Teamviewer Remote Support Software. 

 

Let wel: 

• Indien BenguFarm op meer as een rekenaar geïnstalleer is, moet bogenoemde registrasieproses vir 
elke rekenaar gevolg word. 

• Indien jy die opsionele BenguFarm GENETICS Telingsbestuur module saam met BenguFarm BEEF 

gekoop het, moet jy die GENETICS module ook registreer. Om BenguFarm GENETICS te registreer, 
gaan in BenguFarm BEEF na Reproduksie > BenguFarm GENETICS Telingsbestuur Module en volg 

bogenoemde registrasie stappe. 

5. Hoofskerm en algemene funksies: 

Hoofskerm: 
• Om die taal te verander in BenguFarm, gaan na Opsies > Verander Taal. 

• Toegang tot alle invoerskerms, verslae en data stuur/intrek funksies word op die 

hoofskerm verkry deur die menu aan die bokant van die skerm of deur die ooreenstemmende ikone. 

• Die grootste gedeelte van die hoofskerm word gebruik om diere se data te vertoon. Daar 
is twee opsies, naamlik die Kudde Uitleg en die Dier Uitleg.  

• Om te wissel tussen hierdie twee hoofskerm vertoon opsies, kliek aan die linkerkant van die 

skerm op Kudde Uitleg of Dier Uitleg. 

o Algemeen: 
▪ Die diere wat in die lys van diere op die hoofskerm verskyn, word bepaal deur die 

algemene filters Aktief / Onaktief / Manlik / Vroulik aan- of af te skakel. Die Groep 

Filter (regs van die Vroulik filter) of die Kies Diere skerm (die  ikoon) kan gebruik 

word as addisionele filter.  
▪ Aktiewe diere is diere wat lewendig en in die betrokke kudde is. Onaktiewe 

diere is diere wat nie lewend in die betrokke kudde is nie, byvoorbeeld diere wat 
verkoop of dood is asook diere wat nooit in die kudde was nie, maar wat voorkom 

in die stamboom of nageslag van diere wat wel in die kudde is.  
▪ Diere se nommers word volgens geslag op verskillende agtergrondkleure 

vertoon: 

• Vroulik – Pienk 

• Manlik – Blou 

• Geslag Onseker – Rooi 

• Gekastreer – Oranje 

▪ Om die nuutste/opgedateerde data te sien, kliek op die Verfris Skerm ikoon. 
▪ Let wel: Indien diere na of van ’n groep geskuif word terwyl daardie groep met die 

groepfilter gekies is, sal die diere in die betrokke groep eers opgedateer vertoon 
word nadat die groepfilter afgeskakel is (Geen Groep Filter) en die betrokke groep 

weer gefilter word. 

 
o Kudde Uitleg: Hierdie uitleg word gebruik om sekere belangrike data van ’n groep diere 

(tipies alle diere in die kudde) in tabel uitleg te vertoon. Vir stap-vir-stap hulp, gaan in die 
hoofmenu na Hulp > Hulp met Hoofskerm > Kudde Uitleg. 

▪ Om die nuutste/opgedateerde data te sien, kliek op Verfris Skerm.   
▪ Om data in kolomme volledig te vertoon, kliek op Outo Wydte. 

▪ Om te kies watter data vertoon moet word, kliek op Vertoon Opsies onderaan 

die skerm en kies die betrokke afdelings of velde.  

• Om sekere data van diere te verlig “highlight” (bv. koeie met ’n 
gemiddelde tussenkalfperiode van meer as 400 dae) asook rangwaardes op 

te stel vir die gekose kriteria, kliek op die Stel Kuddeuitleg Verligting Op 
(ikoon met klein blokkies met verskillende kleure). Gebruik die Hulp funksie 

indien nodig. Let wel: Indien Aktiveer Verligting en Rangwaardes gemerk 
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is, word die veld OEK (Ouderdom Eerste Kalwing) van vroulike diere wat 

ouer as 36 maande is en nog nie ‘n kalf op rekord het nie, outomaties rooi 
verlig. Die kolomme IDNr, Vader en Moeder word ook outomaties 

onderskeidelik groen, blou en pienk verlig. 

• Om kolomme te vertoon vir Inentings, Doserings & Aanvullings, 

Siekte Toetse (bv. Brucellose), Mates en Punte (bv. kondisiepunt, 
algemene voorkoms punt), Prosedures (bv. kastreer, onthoring) en/of 

Addisionele Gewigte, kliek op die Stel My Kolomme Op om te Vertoon 
(ikoon heel bo).  

• Om die keuse van kolomme en verligting te stoor as die verstek 

opsies vir die betrokke kudde, kliek op Stoor Opsies as Kudde Verstek 
onder die hofie Stoor/Laai Uitleg. Die gestoorde opsies sal outomaties gelaai 

word wanneer die kudde die volgende keer oopgemaak word. 

• Om ‘n uitleg te stoor vir hergebruik, gee dit ‘n naam by Stoor Uitleg As 

onder die hofie Stoor/Laai Uitleg en kliek op die Stoor ikoon. 

• Om ‘n gestoorde uitleg te laai, kies by Laai Gestoorde Uitleg die 
betrokke uitleg en kliek op die Laai ikoon. 

• Let wel: Bestuursgroepe kolom: Indien ‘n dier aan meer as een 

bestuursgroep gekoppel is, sal slegs een van die betrokke groepe vertoon 
word.  

▪ Om ’n verslag te skep van die data wat op Kudde Uitleg vertoon word, kliek 

op Vertoon Verslag. Let wel: Alle kolomme en alle diere wat vertoon word, sal 
ingesluit word in die verslag. Om slegs sekere kolomme in te sluit in die verslag, 

kliek op Vertoon Opsies en kies slegs die benodigde kolomme. Om slegs sekere 
diere in te sluit in die verslag, kies die betrokke diere deur middel van die filters bo-

aan die skerm. 
▪ Om ’n spesifieke dier (of moeder of vader) se data in die Dier Uitleg 

hoofskerm uitleg te sien, kliek op die betrokke dier se ID nommer. Om terug te 

gaan na die betrokke dier in die Kudde Uitleg, kliek op die Kudde Uitleg skakel. 
▪ Om rekords te groepeer, kliek op die kolomopskrif en hou die muisknoppie in. 

Beweeg nou met die muis na die oop gedeelte aan die bokant van die verslag waar 
daar staan “Trek ’n kolomopskrif hiernatoe om volgens daardie kolom te sorteer” en 

los die muisknoppie. Die kolomnaam sal nou in hierdie oop gedeelte vertoon word. 

Rekords kan op meer as een kolomwaardes groepeer word. Om die groepering te 
verwyder, regs kliek op die kolomopskrif en kies "UnGroup". 

▪ Om rekords te sorteer, kliek op die betrokke kolom se opskrif. Om in die 
omgekeerde volgorde te sorteer, kliek 'n tweede keer op die betrokke kolom se 

opskrif. Om volgens verskeie kolomme gelyktydig te sorteer, hou die SHIFT sleutel 
op die sleutelbord in en kliek op die betrokke kolomopskrifte. 

▪ Om rekords te filter, kliek aan die regterkant van ‘n kolomopskrif op die filter 

knoppie. ‘n Lys met al die waardes wat in daardie kolom voorkom sal vertoon word. 
Om slegs rekords te vertoon wat 'n spesifieke waarde het, kliek op daardie waarde. 

Daar kan ook op "(Custom)" gekliek word. 'n Skerm sal oopmaak waar byvoorbeeld 
gekies kan word om om alle rekords te vertoon met 'n waarde groter as 'n sekere 

waarde. Let op dat meer as een kolom op 'n slag gefilter kan word. Om 'n spesifieke 

kolom se filter af te haal, kliek op "(All)" by die filter opsies van die betrokke kolom. 
Om alle kolomfilters af te skakel, kliek links onderaan die hoofskerm op die X. 

▪ Om ’n kolom tydelik te skuif na ’n ander posisie in die tabel, kliek op die 
betrokke kolom se opskrif en sleep (“drag”) dit tot waar dit geplaas moet word en 

los (“drop”) dit. Wanneer die betrokke skerm toegemaak en weer oopgemaak word, 

sal só ’n kolom weer op die oorspronklike plek vertoon word. 
▪ Om ’n kolom tydelik te verwyder vanaf die skerm, kliek op die betrokke kolom 

se opskrif en sleep (“drag”) dit weg totdat dit ’n groot kruis vertoon en los (“drop”) 
dit. Wanneer die skerm of program toegemaak en weer oopgemaak word, sal só ’n 

kolom weer vertoon word. 
▪ Om sekere data (bv. Natuurlike Dekkings, Kunsmatige Inseminasies / 

Laparoskopieë, Verander Diere (Tabel Uitleg) of Verkope, Vrektes en Uitskotte) aan 

te teken vir ’n groep diere, merk die betrokke diere in die “K” kolom en kies die 
betrokke aantekenskerm uit die menu aan die bokant van die skerm of kliek die 

ooreenstemmende ikoon. 
▪ Om diere te koppel aan ’n groep, merk die betrokke diere in die “K” kolom en 

kliek op Koppel Diere aan Groep. 
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▪ Om diere in die My Verslae skerm te vertoon, merk die betrokke diere in die 

“K” kolom en kliek op Vertoon in My Verslae. 
▪ Om die data te kopieër na die rekenaar se “Clipboard”, kliek op Kopieër na 

Clipboard. 

 
o Dier Uitleg: Hierdie opsie bestaan uit vertoonvensters wat gebruik word om die data van 

’n enkele dier te vertoon. Daar is verskeie vertoonvensters beskikbaar waarmee data van 
die dier wat links bo-aan die hoofskerm gekies is (natuurlik eers wanneer diere reeds in die 

BenguFarm databasis is), vertoon word. Daar is byvoorbeeld vertoonvensters vir algemene 
data, geboortedata, reproduksie- en nageslaggemiddeldes, stambome, fotos, ens. Vir stap-

vir-stap hulp, gaan in die hoofmenu na Hulp > Hulp met Hoofskerm > Dier Uitleg. 

▪ Die vertoonvensters is in vier groepe of subskerms ingedeel. Jy kan een 
vertoonvenster per groep op 'n slag kies om te vertoon. Kliek bloot op die skakel 

van die betrokke vertoonvenster aan die onderkant van die betrokke groep.  
▪ Om vertoonvensters wat nie gebruik word nie te verberg, kliek op die 

“Vertoon” menu en onder die hofie Kies Hoofskerm Opkykskerms verwyder die 

regmerkie langs die betrokke vertoonvenster.  
▪ Om ’n verslag te skep van die data wat in ’n vertoonskerm vertoon word, 

kliek op die drukker ikoon in die regterkanste boonste hoek van die betrokke 
vertoonvenster. Vir verdere vertoon opstellings, sien paragraaf 8. 

▪ Om ’n dier te kies (wat reeds in die BenguFarm databasis is) om op die hoofskerm 
te vertoon, kliek op die pienk of blou blokkie links bo-aan die hoofskerm of druk 

Ctrl+Z op die sleutelbord. Die dier kan uit die lys gekies word of die IDnr kan bloot 

ingetik word. Die pyltjies links en regs word gebruik om na die vorige en volgende 
diere en in die lys te beweeg. 

▪ Om subskerms te vergroot of verklein, gaan met die wyser op die bruin lyn 
tussen die subskerms en sleep en los (“drag and drop”) tot die verlangde grootte. 

o Wenk: Om die Kudde Uitleg (in plaas van die Dier Uitleg), te kies as die verstek uitleg 

vir die hoofskerm, gaan na Vertoon en kliek die opsie Gebruik Kudde Uitleg as verstek 
Hoofskerm Uitleg. 

• Vir verdere hulp met die gebruik van die hoofskerm, gaan na Hulp > Hulp met die Hoofskerm.  

• Wenk: Indien ’n dier(e) wat jy verwag in die dierlys moet wees nie gekry word nie, 

kontroleer die volgende: 
o Is jy in die regte kudde? 

o Is die korrekte algemene dierfilters gekies? Indien slegs aktiewe diere gelys word, kontroleer 
of die dier nie miskien onaktief is nie. 

o Indien wel, is die korrekte groepfilter gekies?  

o Indien wel, is die korrekte kolomfilter(s) gekies? Kyk links onderaan die skerm vir akiewe 
kolomfilters. 

o Is die diere op ID nommer gesorteer? 
o Is die nommerformaat van die betrokke dier korrek? (bv. A210001, A 210001, A21001). 

 

Kies Diere skerm: 
• Die Kies Diere skerm word oral in BenguFarm gebruik om diere te kies vir data aantekening óf vir 

insluiting in 'n verslag. Die gebruiker kan diere met die hand kies (regterkant van die skerm) of diere 

kies wat aan ’n groep(e) gekoppel is en/of aan ’n filter(s) (linkerkant van die skerm) se kriteria 

voldoen. Die skerm maak oop wanneer die gebruiker kliek op die  ikoon in ’n aanteken- of verslag 
skerm. Gebruik die Hulp funksie indien nodig. 

 
Algemene Funksies – Alle skerms: 

• Om 'n skerm oop te maak, moet alle ander skerms eers toegemaak word. Indien 'n skerm 

verklein (minimise) is, kan 'n ander skerm nie oopgemaak word nie. 

• BenguFarm kan slegs toegemaak word indien al die skerms toe is. 

• Om vinnig ’n dier op die hoofskerm of ander kieslys te vind, maak die betrokke lys oop en 

tik die dier se ID nommer in te tik. Dieslfde geld om vinnig ’n item te vind in enige tipe kieslys. 

• Geslag aanduiding op skerms: Die kolomopskrif is Manlik. Manlike diere het ’n regmerkie,  
vroulike diere nie. 

• Die algemene dierfilters (Aktief / Onaktief / Manlik / Vroulik) word op alle skerms waar diere 

gekies kan word, bo-aan die betrokke skerm vertoon as vier blokkies. Die beskrywing van elke 
betrokke filter kan vertoon word deur met die wyser (“pointer”) oor die betrokke blokkie te beweeg. 
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• Op alle aantekeningskerms is velde wat verpligtend/belangrik is om te voltooi op ’n geel 
agtergrond. Velde met ’n wit agtergrond is opsioneel. 

• Om van een veld/kolom na die volgende te gaan waar data ingevul moet word, gebruik die 

"Tab" of die “→” sleutels. 

• Om na die volgende of vorige lyn in ‘n kolom te gaan waar data ingevul moet word, gebruik 
die “↓” en die “↑” sleutels. 

• Numeriese velde (bv. gewig, prys) MOET ‘n waarde in hê (0 of ander). 

• Om 'n datum met behulp van die kalender te kies, kies eers die jaar, dan die maand en kliek 

dan op die dag. 

• Om bestaande data te wysig of te verwyder, sien paragraaf 15. 

• Om rekords op ’n skerm te sorteer of te filter asook om ’n kolom tydelik te skuif na ’n 
ander posisie in die tabel of tydelik te verwyder vanaf ’n skerm, sien die instruksies hierbo 

by Hoofskerm > Kudde Uitleg.   

• Die volledige beskrywing van ’n kolomopskrif kan vertoon word deur met die wyser (“pointer”) 

oor die betrokke kolomopskrif te beweeg. 

• Om diere te kies vir multi-verandering of verwydering, merk die K (Kies) kolom en verander 
die betrokke data bo-aan die skerm in die Multi Verander / Voeg Nuwe By deel van die skerm. 

• Dit word aanbeveel dat kostes en pryse sonder BTW aangeteken word. 

• Om ’n nuwe rekord te skep by Opstellings, kliek op die “+” regs onderaan die skerm. Om ’n 

rekord te verwyder, kliek op die “-“ regs onder-aan die skerm. 

• 'n Stap-vir-stap Hulp funksie is beskikbaar op die meeste skerms bo aan die regterkant van die 
skerm. Probeer dit gerus – jy sal verbaas wees hoe maklik dit werk. 

 

Verslae en Aantekenlyste: 
• Alle verslae kan geskep word via die Verslae menu item.  

• Verslae met “(aantekenlys)” agter die verslagnaam is verslae met sekere blanko kolomme in die 
verslag. Die doel hiermee is om die betrokke verslag (aantekenlys) te druk en na die 

kraal/drukgang/skaal te neem om data op aan te teken, bv. ’n Weeglys waarop gewigte 
aangeteken kan word. Die voordele om gedrukte aantekenlyste te gebruik is: 

o Diere is gesorteer, wat dit maklik maak om die data later in BenguFarm aan te teken; 

o Kan maklik kontroleer of alle diere gedoen is; 
o Alle benodigde info is op die aantekenlys gedruk; 

o Mors nie tyd om diere se ID nommers neer te skyf nie; 
o Foute met identifikasie van diere kan maklik opgespoor word. 

• Wanneer ’n verslag geskep word (Vertoon Verslag), is daar altyd opsies om die verslag te Druk of 

the Eksporteer. Met die eksporteer opsie kan ‘n verslag gestoor word in verskillende formate, 
bv. pdf of Excel of die verslag kan direk uit BenguFarm ge-epos word aan ’n kontak. Let wel: Die 

direkte stuur per e-pos werk, vir sekere tegniese redes, nie altyd nie. Indien jy ’n probleem ondervind 

met hierdie opsie, kontak jou BenguFarm agent vir hulp om die SMTP Direkte E-pos opsie op te stel 
[Opstellings > Kuddes > E-pos > Gebruik SMTP Direkte E-pos]. 

• Om ’n verslag te skep waarop diere van alle kuddes op die betrokke databasis ingesluit is (waar 

van toepassing), gaan na die “ALL” kudde [Lêer > Verander Aktiewe Kudde Na > ALL]. 

6. Opstellings: 

Wenk: Om die taal te verander in BenguFarm, gaan na Opsies > Verander Taal. 

 
Dit is baie belangrik dat elke kudde se opstellings gedoen word voordat jy die program begin 

gebruik om te verseker dat die program korrek en optimaal funksioneer. 
 

Kudde Opstellings: 
Gaan na Opstellings > Kuddes. Voltooi/verander waar nodig die inligting onder die volgende hofies op die 
grys gedeelte van die skerm. Let wel: Doen eerste die opstellings onder Algemeen, tweedens die 

Diensverskaffers en dan die res. Vir die meeste opstellings is daar reeds verstek waardes of opsies 
gekies. Kontroleer hierdie waardes en verander dit slegs indien nodig vir jou spesifieke behoeftes. 

Let wel: Velde met ’n geel agtergrond is verpligtend, m.a.w. dit moet voltooi word. Velde met 

’n wit agtergrond is opsioneel. 
o Algemeen:  

▪ Naam (verpligtend): Bv. Rooibees Bonsmaras. 
▪ Beskrywing (opsioneel): Bv. Bonsmara Stoetkudde. 

▪ Eienaar (opsioneel): Bv. Koos van der Merwe. 
▪ Plaasnaam (opsioneel): Bv. Soetwaterfontein. 
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▪ BenguFarm Module (verpligtend): Beeste. 

▪ Ras (verpligtend): Bv. BON - Bonsmara. Indien dit ’n kruisraskudde is, kies BCM – Commercial Beef 
Cattle. Hierdie opstelling is baie belangrik, want dit bepaal sekere ras-spesifieke verstek 

opstellings. As jy dit verander, maak die program toe, weer oop en gaan dan na Lêer > 

Ondersteuning > Herbereken Opsommend Data vir die verandering om in werking te tree. 
▪ Kuddetipe (verpligtend): Merk Stoet of Kommersieel. 

▪ KKM (geregistreerde KuddeKenMerk of die brand letters van die kudde - verpligtend): Bv ABC. 
▪ Voorvoegsel (kuddenaam - slegs van toepassing op stoetkuddes): Bv. Rooibees. 

▪ Genootskap Lidnr (slegs van toepassing op stoetkuddes en kommersiële kuddes wat registreer 
en/of prestasietoetsing doen deur SA Stamboek of die LNR of Breedplan): Voltooi die nommer met 

voorafgaande nulle sodat dit sewe syfers is, asook die raskode agteraan, bv. 0699999BON. 

▪ Maak Fakture uit Aan (opsioneel): Vul die naam in van die persoon of besigheid aan wie fakture 
uitgemaak moet word, bv. Rooibees Boerdery. 

▪ BTW Nr (opsioneel): Vul die BTW nommer in. 
▪ Posadres (opsioneel): Vul die posadres in. 

▪ Poskode (opsioneel): Bv 2500.  

▪ Landkode (opsioneel): Bv ZAR. 
▪ Kontak Persoon (verpligtend): Kliek op die kortpadknoppie heel regs (Skep outomaties 

kuddekontak vanaf kudde besonderhede). Kliek nou op die kortpadknoppie regs (wat lyk soos ’n 
rooi notaboekie) om die Kontakte skerm oop te maak en vul die ontbrekende inligting, spesifiek die 

naam & van, selnommer en epos adres, in. Stoor. Kies nou hierdie kontak uit die lys van kontakte. 
Nota: Die kontakbesonderhede hier ingevul (naam & van, selnommer en epos adres) sal bo-aan 

alle verslae gedruk word.  

▪ Teler, Eienaar en Standplaas (opsioneel): Kies die kontak wat jy hierbo opgestel het, bv. 
Rooibees Boerdery. 

o Diensverskaffers (slegs van toepassing op alle stoetkuddes en kommersiële kuddes wat amptelike 
prestasietoetsing doen  deur SA Stamboek, die LNR of Breedplan): [Nota: Sien Bylaag E vir opstelling 

instruksies vir Breedplan as diensverskaffer]. 

▪ Registrasie, Prestasietoetsing en Teelwaardes: Kies die betrokke diensverskaffer van hierdie 
kudde by elk. 

▪ Gebruik Logix Direk Lêer Oplaai Funksionaliteit (opsioneel – slegs van toepassing op Logix 
gebruikers. Lees asseblief die nota op die skerm en sien ook paragraaf 19): 

• Aanteken Gebruikersnaam: Vul jou Logix gebruikersnaam hier in. 

• Aanteken Wagwoord: Vul jou Logix wagwoord hier in. 

• Stuur e-pos Bekragtiging van Ontvangs van Data Na: Vul jou e-pos adres hier in. 

▪ E-pos adresse: 

• Indien Registrasie en Prestasietoetsing = Stamboek gekies is hierbo, moet die E-pos 
Dekkings, Geboortekennisgewings, Oordragte en Kansellasies Na asook E-pos 

Prestasietoetsdata Na adresse edata@studbook.co.za wees. 

• Indien Prestasietoetsing = LNR gekies is hierbo, verander die E-pos Prestasietoetsdata Na 

adres na intergis@arc.agric.za. 

• Indien Registrasie, Prestasietoetsing en Teelwaardes = Breedplan gekies is hierbo, sien 
Bylaag E of kontak  jou BenguFarm BEEF agent of mnr. Leslie Bergh by 

leslie@benguelasoft.co.za of 0828012026. 
o ID Metodes en Nommering: (Verwys paragraaf 1 vir algemene inligting oor ID metodes en 

nommering van diere) 

▪ Verstek ID Formaat: Die verstek ID formaat word gebruik om die formaat van die Dier ID No 
(visueel) veld in BenguFarm BEEF te bepaal volgens die dier se Kuddekenmerk (KKM), Jaar- en 

Volgnommer. Die verstek ID formaat in BenguFarm BEEF is HHHHYYNNNN. Die HHHH dui aan daar 
word voorsiening gemaak vir maksimum 4 karakters vir die Kuddekenmerk of brandmerk, die YY 

dui aan daar word voorsiening gemaak vir maksimum 2 karakters vir die Jaar van geboorte en die 
NNNN dui aan daar word voorsiening gemaak vir maksimum 4 karakters vir die volgnommer. 

Byvoorbeeld, as die kuddekenmerk ABC is, die jaar van geboorte 2020 en die volgnommer 123 is, 

sal die ID no geskep word as ABC200123. Kommersiële kuddes gebruik normaalweg net die jaar 
van geboorte en volgnommer om diere te identifiseer. In so ’n geval kan die verstek ID formaat 

gestel word as YYNNNN of YY-NNNN.  
▪ Verstek Hoof ID Metode (Permanente ID): Vir stoetkuddes is die verstek hoof ID metode 

volgens die betrokke telersgenootskap se voorskrif, bv. Brandmerk.  

▪ Verstek Sub ID Metode (Visuele ID): Vir stoetkuddes is die verstek sub ID metode volgens die 
betrokke telersgenootskap se voorskrif, bv. Oorplaatjie. 

▪ Aparte Volgnommers vir Verse en Bulle: Merk hierdie opsie slegs indien (binne hierdie kudde) 
daar nie een volgnommer reeks vir vers- en bulkalwers gebruik word nie. By Volgnommer Metode 
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moet die toepaslike opsie dan gekies word vir Manlik en Vroulik. Indien aaneenlopende reekse 

volgnommers (binne hierdie kudde) vir vers- en bulkalwers gebruik word (bv. 1-100 vir verskalwers 
en 101-200 vir bulkalwers OF 1-100 vir verskalwers en 1-100 vir bulkalwers), merk Aaneenlopende 

Volgnommers by albei geslagte. 

▪ Pas Volgnommer Opstellings van Eerste Kudde op Alle Kuddes toe: Kies hierdie opsie as jy 
twee (of meer) kuddes op dieselfde databasis het, en jy gebruik een volgnommer reeks vir albei 

kuddes. BenguFarm sal dan die volgende beskikbare volgnommer, ongeag die kudde, toeken 
wanneer nuwe kalwers op die Kalwingskerm aangeteken word. 

▪ Skep IDno (Visueel) vanaf EID (Mikroskyfie Nommer) waar geen IDno gespesifiseer is 
nie: Hierdie opsie moet slegs gekies word indien slegs mikroskyfie/elektroniese identifikasie gebruik 

word en BenguFarm BEEF outomaties visuele IDnos moet skep vanaf die mikroskyfie/elektroniese 

identifikasie nommers wat ingetrek word in BenguFarm vanaf ’n elektroniese identifikasie leser of -
skaal. 

o Dekking, Dragtigheid en Kalwing:  
▪ Huidige Kalfseisoen:  Ignoreer - sien Kalfseisoen opstellings hieronder. 

▪ Sien Bylaag F oor hoe Minimum Ouderdom van Verse by Eerste Dekking, Gemid. Periode 

van Kalwing tot weer Gedek Word en Normale Periode Dragtig gebruik word in die 
berekening van Verwagte Kalfdatum. 

▪ Sinchronisasie (indien van toepassing): Voltooi die # Dae van Insit tot Eerste Spuit; # Dae van 
Insit tot Tweede Spuit; # Dae van Insit tot Uithaal en # Dae van Uithaal tot KI / Lapa. 

▪ Ander velde: Kontroleer die verstek waardes/opsies en verander slegs indien nodig. 
o Prestasietoetsing: 

▪ Maksimum Toelaatbare Ouderdomsverskil tussen Diere in dieselfde 

Prestasietoetsgroep: Die verstekwaarde (gewoonlik 100 dae) is korrek. 
▪ Laat Jonger Minimum Speenouderdom van 60 dae toe weens Droogte:  Merk hierdie opsie 

slegs indien kalwers voor 150 dae ouderdom gespeen word weens droogte. 
▪ Prestasietoetsgroepe (waar geen teelseisoene gebruik word nie): Indien teelseisoene nie 

gebruik word nie, merk “Gebruik Verstek Groepe” en stel vier groepe van drie maande op. 

▪ Weeg Kalwers by Geboorte: Merk dit indien jy normaalweg kalwers weeg by geboorte. 
▪ Weeg Koeie by Kalwing: Merk dit indien jy normaalweg koeie weeg by kalwing. 

▪ Bereken Gemiddelde Moeder Speengewigverhouding gebaseer op Individuele Diere 
(m.a.w. by meerlinge word die speengewigte nie bymekaar getel nie). Ons beveel aan dat hierdie 

opsie AF moet wees, m.a.w. by meerlinge word die speengewigte bymekaar getel in die berekening. 

▪ Prestasietoets Fases waarin Diere getoets word: Merk die toepaslike fases waarin diere 
normaalweg getoets word. (Hierdie info word slegs gebruik vir outomatiese dagboekinskrywings). 

▪ Bereken Algemene Nageslag GDO: Merk hierdie opsie indien die GDO (Gemid. Daaglikse 
toename per dag van Ouderdom) bereken moet word vir kalwers wat nie prestasiegetoets is nie. 
Kies die minimum en maksimum ouderdom by weging vir die gewigte wat gebruik moet word asook 
die geboortegewigte wat gebruik moet word in die berekening vir kalwers wat nie geweeg is nie. 

o E-pos: 

▪ Gebruik Windows Opgestelde E-pos Program: Merk hierdie opsie indien jy enige ander e-pos 
program behalwe Microsoft Outlook gebruik, bv. Gmail. 

▪ Gebruik Microsoft Outlook vir E-posse: Merk hierdie opsie indien jy Microsoft Outlook gebruik 

vir e-posse. 
▪ Gebruik SMTP Direkte E-pos: Merk hierdie opsie slegs indien jou BenguFarm BEEF agent dit 

aanbeveel waar jy probleme het met jou gewone e-pos program. 
▪ Stuur E-pos Direk: Moenie merk nie. 

▪ Vertoon E-pos Sukses: Hierdie opsie moet gemerk wees. 
o Verstek Gidse vir Lêers: 

▪ Met die installering van BenguFarm word daar outomaties ‘n omslag (“folder”) “BenguFarm” geskep 

op die rekenaar se hardeskyf (C:\BenguFarm\) met ’n subomslag “Beef” met drie subomslae, 
naamlik “Imports”, “Exports” en “Backups” met subomslae vir jou kudde(s) in elk van hulle. Hierdie 

subomslae word dan outomaties as die verstek (“default”) gidse (“paths”) gestel in BenguFarm 
BEEF, waar data gestoor kan word. Let wel: Die verstek plek vir die stoor van rugsteun lêers 

(C:\BenguFarm\Beef\Backups\[Kudde]) is NIE ’n veilige plek nie, aangesien die rugsteun verlore sal 

wees indien die rekenaar gesteel word of iets oorkom. Dit is UITERS BELANGRIK om die 
rugsteun lêers op ’n VEILIGE PLEK te stoor, byvoorbeeld ’n web (“cloud”) gebaseerde plek 

soos Dropbox, GoogleDrive of OneDrive en/of ’n eksterne hardeskyf of geheuestokkie. Kliek op die 
knoppie met die drie kolletjies om ’n veilige plek te kies. 

▪ Verstek Gids waarin Fotos Gestoor word: Moet NIE die verstek gids verander nie.  
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▪ Konnekteer Netwerk Dryf as BenguFarm Oopmaak: Indien jy die BenguFarm databasis op ‘n 

netwerk wil plaas, kontak jou BenguFarm agent of Mnr. Leslie Bergh by 
leslie@benguelasoft.co.za of 082 801 2026 vir instruksies hoe om dit op te stel. 

 

o  Herinneraars: 
▪ Kontroleer die verstek waardes en verander slegs indien nodig. 

o Liggaamsmates: 
▪ Koeie se Raamgrootte: Die verstek raamgrootte is medium. Indien nodig, verander dit na klein- 

of grootraam. Hierdie raamgrootte word gebruik in die berekening van die ekwivalente aantal 
Grootvee-eenhede (GVEe). 

▪ Gebruik Heuphoogte in die Lengte/Hoogte Verhouding: Kies hierdie opsie indien BenguFarm 

die Heuphoogte in die Lengte/Hoogte Verhouding moet gebruik. 
▪ Mates: Selekteer watter liggaamsmates aangeteken word in groeitoetse van bulle vir 

prestasietoetsing.  
o Punting: 

▪ Ignoreer – die verstek is korrek. 

o Ander: 
▪ Kontroleer die verstek waardes en verander slegs indien nodig. 

▪ Verstek groep kategorie: Kies die groep kategorie wat die meeste gebruik sal word. 
▪ Laat Verkope, Vrektes en Uitskotte Rekords vir elke Kudde per Dier toe: Merk hierdie opsie 

slegs indien jy meer as een kudde (op dieselfde databasis) het en jy meer as een verkooprekord 
per dier wil kan aanteken, bv. die dier is eers verkoop aan jou voerkraal en dan aan ’n ander 

instansie.  

▪ Laat Data-aantekening in “ALL” Kudde Toe: Merk hierdie opsie indien jy meer as een kudde 
(op dieselfde databasis) het om toe te laat dat die meeste data (dekkings, dragtighede, inentings, 

siektes en behandeling, gewigte, mates en punte nie vir prestasietoetsing, kamp- en 
groepverskuiwings, aankope, prosedures, ens.) in die ALL kudde aangeteken kan word. 

 

Groepe – Kalfseisoene, kampe en bestuursgroepe: 
Sien paragraaf 18 vir die doel, opstelling en gebruik van kalfseisoene, kampe en bestuursgroepe. 

 

Kontakte: 
Om kontakte vir persone of besighede op te stel wat verskeie plekke in die program gebruik gaan 

word (bv. Eienaar, Bestuurder, Insemineerder, Kopers, Veeartse, Konsultante, Inspekteurs, ens.), gaan na 
Opstellings > Kontakte, kliek op die “+” (regter onderste hoek van die skerm) om ’n nuwe Kontak rekord te 

skep.  Let wel: Die Besigheid veld (persoon of besigheid se naam) is die veld wat vertoon gaan word in die 
seleksie lys en is die enigste verpligte veld om te voltooi.  

 

Ander Opstellings: 
Al die ander lyste het verstek items wat reeds in die betrokke lys ingesluit is. Jy kan nie hierdie verstek items 

verander of verwyder nie, maar, waar nodig, kan jy addisionele items byvoeg deur te kliek op die "+" aan 
die regter onderkant van die skerm. Die Medisyne lys is die een lys wat uitgebrei sal moet word met jou eie 

lys van medisynes. Wenk: By sekere opstellings (bv. Kalfseisoene; Kampe; Entstowwe, Doseermiddels & 

Aanvullings; Medisynes asook Siektes, Beserings & Parasiete) is daar ‘n "In Gebruik" kolom. Items wat by In 
Gebruik gemerk is, word in die betrokke kieslys bo-aan die lys vertoon en die res daaronder om dit makliker 

te maak om ‘n item te kies. By sekere items is daar ook ‘n “Toestel” kolom. Items wat nie by Toestel gemerk 
is nie, word verberg in die betrokke kieslys op die Mobile toepassing (“app”) en op die APR500/600 EID leser 

sodat die kieslys korter is.  

7. Skep ’n tweede kudde en wissel tussen kuddes: (indien van toepasing) 

• BenguFarm BEEF maak voorsiening dat jy meer as een kudde in die program opgestel kan word, sonder 
addisionele kostes, mits al die diere natuurlik aan een eienaar behoort. ’n Groep diere word as ’n 

ander kudde opgestel indien die ras en/of kudde tipe (stoet of kommersieel) verskil. 
o Telers wat stoet- en kommersiële diere het, word aanbeveel om aparte kuddes in 

BenguFarm op te stel, aangesien dit die vergelyking van jou stoetkudde se diere op 

BenguFarm met die diere op Logix/by die Genootskap vergemaklik, asook die stuur van data 
soos dekkings, geboortes, gewigte, verkope en vrektes na Logix/die Genootskap, omdat jy nie 

hoef uit te soek watter diere se data gestuur moet word nie. Omdat die meeste data 
(uitgesonderd Gewigte vir Prestasietoetsing, Kalwings asook Verkope en Vrektes) in die ALL 

kudde kan aanteken (mits jy by Opstellings > Kuddes > Ander die opsie Laat Data-aantekening 
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in “ALL” Kudde Toe gemerk gemerk het), bemoeilik twee aparte kuddes nie die aantekening van 

data wesenlik nie. 
o Stoettelers wat meer as een stoetkudde het waar die ras, telersgenootskap 

lidnommer, kuddekenmerk, voorvoegsel en/of ID nommer formaat verskil, moet ook 

verskillende kuddes opstel. 
o Telers wat meer as een kommersiële kudde het wat apart bestuur word (bv. op 

versillende plase), behoort ook aparte kuddes op te stel. 

• Verskillende kuddes kan óf op dieselfde databasis geskep word, of op aparte databasisse.  
o Indien diere gedeel word tussen kuddes (bv. bulle wat in twee kuddes gebruik word) en/of diere 

van tyd tot tyd tussen kuddes skuif (bv. kommersiële koeie wat goedgekeur is vir opgradering 
en na die stoetkudde toe oorskuif of afgekeurde verse wat terugskuif na die kommersiële kudde) 

en/of indien embrios wat uit koeie in een kudde (bv. stoet) gespoel is in koeie in die ander kudde 

(bv. kommersieel) ingeplant word, beveel ons aan dat die kuddes op dieselfde databasis geskep 
word. Die skep van ’n tweede kudde op dieselfde databasis het ook die voordeel dat sekere 

opstellings (bv. Kampe, Kontakte en Kalfseisoene) nie vir albei kuddes apart opgestel hoef te 
word nie en dat daar nie van elke kudde 'n aparte gerugsteun gemaak hoef te word nie. Dit het 

ook die voordeel dat, deur middel van die “ALL” kudde opsie, verslae en aantekenlyste geskep 

kan word wat alle diere, ongeag kudde, insluit.  
o Die enigste geval waar ons aanbeveel dat kuddes op aparte databasisse geskep word, is indien 

die versillende kuddes se rekordhouding in BenguFarm deur verskillende persone gedoen gaan 
word, bv. die bestuurder van plaas A hou die rekord van plaas A se kudde(s) op sy rekenaar en 

die bestuurder van plaas B hou die rekord van plaas B se kudde(s) op sy rekenaar. Dit het dan 
die voordeel dat elke bestuurder onafhanklik van die ander bestuurder(s) kan werk op 

BenguFarm en dat van elke plaas se BenguFarm data ’n aparte databasis rugsteun gemaak kan 

word en byvoorbeeld op die eienaar se rekenaar herstel word sonder om die ander plaas(e) se 
data te oorskryf.  

o Indien jy onseker is watter opsie om te kies of meer inligting oor die opstelling van 
kuddes benodig, bespreek dit asseblief met jou BenguFarm BEEF agent. 

• Om ’n tweede kudde op dieselfde databasis te skep, gaan na Opstellings > Kuddes > Algemeen 

en kliek op die "+" onder-aan die skerm. Vul ‘n naam in (bv. Kommersiële Kudde), kies die Ras en doen 

die res van die opstellings vir die kudde. Kliek op Stoor en Gaan Uit. Let wel: Sekere algemene kudde-
opstellings sal outomaties ingevul word indien dit reeds by die eerste kudde wat geskep is ingevul is. 

Dit word dus aanbeveel dat die eerste kudde se Algemeen opstellings eers gedoen word 
(sien paragraaf 6) voordat die addisionele kudde geskep word. Maak seker die Ras veld 

word voltooi vir elke kudde – dit is baie belangrik. 

• Om ’n tweede kudde op ’n aparte databasis te skep, gaan na Opsies > Databasisse. Kliek op + 
Voeg Nuwe By, kies die spesie (Beeste) en vul ‘n naam vir die databasis in (bv. Kommersiële Kudde) in 

die veld Databasis Beskrywing. Kliek Aanvaar, Stoor en Gaan Uit. 

• Indien nodig, skakel asseblief Naomi Havenga by 082 696 8306 of stuur ’n epos na 

accounts@benguelasoft.co.za om ’n addisionele kudde en/of databasis te registreer. 

• Om tussen kuddes te wissel in BenguFarm BEEF, gaan na Lêer > Verander Aktiewe Kudde Na. Kliek 
op Lys Alle en Selekteer, kies die betrokke kudde uit die lys en kliek Aktiveer. 

• Let wel: Indien meer as een kudde op dieselfde databasis geskep is, skep BenguFarm BEEF outomaties 

’n ALL “kudde”. Die hoofdoel met die ALL kudde is om verslae te skep wat diere in al die kuddes op 
die databasis insluit. Normaalweg word daar nie in die ALL kudde gewerk nie, aangesien daar slegs 

sekere data-aantekening in die ALL kudde gedoen kan word.  

o Om toe te laat dat sekere data (bv. dekkings, dragtighede, inentings, gewigte nie vir 
prestasietoetsing) in die ALL kudde aangeteken kan word, gaan na Opstellings > Kuddes 

> Ander en merk die opsie Laat Data-aantekening in “ALL” Kudde Toe. 
o Indien twee (of meer) kuddes op dieselfde databasis geskep word, poog om nie dieselfde ID 

nommers vir diere in die twee kuddes te gebruik nie, om verwarring met identifikasie te 
voorkom indien in die ALL “kudde” gewerk word. Indien een reeks nommers vir alle diere gebruik 

word, ongeag die kudde waarin hulle is, gaan na Opstellings > Kuddes > ID Metodes en 

Nommering en merk die opsie Pas Volgnommer Opstellings van Eerste Kudde op Alle Kuddes 
Toe. 

• Om diere tussen kuddes te skuif, sien paragraaf 37. 

 

8. Vertoon opstellings - Hoofskerm en ander: 
Die doel met die Vertoon opsies is om BenguFarm pas te maak vir jou spesifieke behoeftes deur sekere 

skerms en sekere velde op sommige skerms wat nie gebruik word nie, te verberg (“hide”). Dit is veral handig 
vir kommersiële (nie-stoet) telers om funksies en skerms wat nie gebruik word nie, te verberg. Om jou 
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BenguFarm BEEF op hierdie wyse pas te maak vir jou spesifieke behoeftes en meer gebruikersvriendelik te 

maak, gaan na die Vertoon menu item: 
o Om die Kudde Uitleg, in plaas van die Dier Uitleg, te kies as die verstek uitleg vir die 

hoofskerm, gaan na Vertoon en kliek op Gebruik Kudde Uitleg as verstek Hoofskerm Uitleg. 

o Om velde wat op die hoofskerm Kudde Uitleg vertoon word te kies of te verberg, gaan op 
die Kudde Uitleg na Vertoon Opsies. Om jou keuse van velde as die verstek opsies vir die betrokke 

kudde te stoor, kliek op Stoor Opsies as Kudde Verstek. 
o Om funksies en velde wat slegs op stoetkuddes van toepassing is te verberg op die 

Hoofskerm, Kalwingskerm en Voeg By & Verander Diere skerm, gaan na Vertoon > Kies 
Velde wat op Hoofskerm Opkykskerms Vertoon Word, kliek die opsie Merk Verstek Kommersieel Veld 

Keuses en Stoor. 

o Om funksies op die Hoofskerm en/of velde op die Kalwingskerm en Voeg By & Verander 
Diere skerm wat nie gebruik word nie te verberg, gaan na Vertoon > Verander Items wat 

Vertoon word in Program. Maak 'n regmerkie in die blokkie in die geel area langs “Vertoon slegs die 
gemerkte Funksies en/of Velde...”. Kliek op die "+" langs Hoof Skerm Funksies, Voeg By en Verander 

Diere skerm en Kalwingskerm om die funksies en/of velde te kontroleer en, indien nodig, te verander 

wat jy vertoon wil hê. Kliek op Stoor. Let wel: Funksies en/of velde wat hierdie wyse verberg word, 
sal van toepassing wees op alle kuddes in die betrokke databasis.  

o Om die opkykskerms (“view windows”) op die Dier Uitleg van die hoofskerm wat nie 
gebruik word nie te verberg, gaan na Vertoon en onder die opskrif Kies Hoofskerm Dier Uitleg 

Opkykskerms verwyder die regmerkie voor die betrokke opkykskerms. [Gebruik die Hulp funksie 
indien nodig]. Let wel: Opkykskerms wat op hierdie wyse verberg word, sal slegs van toepassing 

wees op die betrokke kudde. Indien dit van toepassing moet wees op alle kuddes in die betrokke 

databasis, merk die opsie Pas toe op Alle Kuddes in hierdie Databasis en kliek Stoor. 
o Om spesifieke velde op sekere opkykskerms (Algemeen, Geboorte, Laaste Dekking, 

Reproduksie & Nageslaggemiddeldes, Prestasietoetsdata en Teelwaardes) op die Dier Uitleg van die 
hoofskerm wat nie gebruik word nie te verberg, gaan na Vertoon > Kies Velde wat op 

Hoofskerm Opkykskerms Vertoon Word. Kliek op die betrokke opkykskerm (bv. Algemeen) en haal 

die regmerkies af by die velde wat jy nie gebruik nie. Doen dieselfde vir die ander opkykskerms. 
Wanneer klaar is, kliek Stoor. Let wel: Velde op opkykskerms wat op hierdie wyse verberg word, 

sal slegs van toepassing wees op die betrokke kudde. Indien dit van toepassing moet wees op alle 
kuddes in die betrokke databasis, merk die opsie Pas toe op Alle Kuddes in hierdie Databasis en kliek 

Stoor. 

o Om spesifieke velde op die Nageslag opkykskerm wat nie gebruik word nie te verberg, 
gaan na Vertoon > Kies Velde wat op Nageslag Opkykskerm Vertoon Word. Haal die regmerkies af 

by die velde wat jy nie gebruik nie en kliek Gaan Uit. Let wel: Velde op die Nageslag opkykskerm 
wat op hierdie wyse verberg word, sal van toepassing wees op alle kuddes in alle databasisse van 

alle modules, waar van toepassing. Sekere velde wat nie van toepassing is op die spesifieke 
BenguFarm module nie, sal outomaties verberg word. 

 

Wenk: Om ’n spesifieke dier (bv. jou gunsteling teelbul) te kies wat by verstek op die hoofskerm se Dier 
Uitleg vertoon moet word wanneer jy BenguFarm BEEF oopmaak, gaan na: Opstellings > Kuddes > Ander 

> Dier om te Vertoon wanneer BenguFarm BEEF Oopmaak. 
 

9. Stap-vir-stap hulp funksie: 
‘n Stap-vir-stap Hulp funksie is beskibaar op die meeste skerms. Hierdie funksie het ten doel om die 
gebruiker stapsgewys deur die funksionering van elke skerm te neem. Ons beveel aan dat jy hierdie 

stap-vir-stap Hulp funksies gebruik totdat jy vertroud is met die betrokke skerm. Die Help 
funksie word geaktiveer deur op die "Hulp" knoppie op die betrokke skerm te kliek. Kies dan die betrokke 

funksie wat jy wil uitvoer en volg die stap-vir-stap instruksies. Let op die flikkerende pyltjie op een van die 

hoeke van die hulpskerm. Hierdie pyltjie dui aan waar op die skerm data ingevoer/funksie geaktiveer moet 
word. Kliek op die ">>" knoppie om na die volgende stap gegaan. Kliek op die "<<" knoppie om na die 

vorige stap terug te gaan. Om die Hulpskerm toe te maak, kliek op die “X” knoppie.  
Kliek op die hoofskerm op die “Hulp” knoppie om jou te help met sekere basies funksies in 

BenguFarm BEEF, naamlik Algemeen, Hantering van verskillende Kuddes, Kudde Uitleg en Dier Uitleg. Die 

nuutste weergawe van die betrokke BenguFarm handleiding kan ook hier afgelaai en oopgemaak word. 

10. Trek dierdata in van eksterne bronne: (indien van toepasing) 

• BenguFarm is nou gereed dat dierrekords ingetrek of per hand ingelees kan word. Die eerste keuse is 

natuurlik om data vanaf een of ander elektroniese lêer(s) in te trek, indien sodanige lêer(s) beskikbaar 
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is. Indien sodanige lêer(s) (sien hieronder) nie beskikbaar is nie, moet die data per hand ingelees word. 

Sien paragraaf 11 vir instruksies hiervoor. 

• Afhangende wat se data beskikbaar is, kan data van een (of in gevalle waar nodig van meer as een) van 
die volgende bronne ingetrek word. Kontak asseblief jou BenguFarm agent indien jy enige hulp benodig 

met die intrek van data. 

• Let wel:  
o Maak seker jy is in die regte kudde waar die data ingetrek moet word. 

o Indien jy Stoetmeester en Logix/Intergis data wil intrek, moet jy eers die Stoetmeester data 

intrek en daarna die Logix/Intergis data. 
o Vir stoettelers is die aangewese opsie om data verkry van Logix (SA Stamboek) of van die 

betrokke telersgenootskap/registrerende owerheid wat van die Breedplan stelsel gebruik (waar 
van toepassing) in te trek.  

• Om Stoetmeester data in te trek:  

o Gaan na Data Stuur/Trek In > Trek In > Databasis > Stoetmeester.  

o Kliek op Soek en kies die gids (folder/directory) waar die Stoetmeester bees SM3 lêer(s) lê en 
kies die toepaslike intrek opsies en die kudde waarheen die data ingetrek moet word. Indien jy 

ook Logix data gaan intrek, beveel ons aan dat jy NIE die Stoetmeester prestasietoetse intrek 
nie, m.a.w. “Los toetse uit” moet gemerk wees.  

o Kliek op "Trek In".  

Let wel: Hierdie funksie is bedoel om data in 'n leë databasis in te trek. Indien daar reeds data 
in jou BenguFarm BEEF databasis is sal die bestaande data van 'n dier oorskryf word met dit 

wat in die Stoetmeester lêer is. Diere met dieselfde IDnr as diere wat reeds bestaan, sal nie 
gedupliseer word nie en inligting soos gewigte wat reeds bestaan sal ook nie gedupliseer word 

nie. 

• Om Herdmaster data in te trek: Kontak jou BenguFarm agent vir hulp. 

• Om Logix (of Intergis) data in te trek, sien paragraaf 12.  

• Om data van ’n ander BenguFarm BEEF gebruiker in te trek: Indien jy diere by ’n mede-
BenguFarm BEEF gebruiker gekoop het, kan hy vir jou ’n BenguFarm Dieroordraglêer met die 

betrokke diere se data skep [Data Stuur/Trek In > Stuur > BenguFarm Dieroordraglêer] en dit vir jou 

stuur. Jy kan hierdie lêer intrek by Data Stuur/Trek In > Trek In > Databasis > BenguFarm 
Dieroordraglêer. Let wel:  

o Maak seker jy is in die regte kudde waar die data ingetrek moet word. 
o Indien ’n dier(e) met dieselfde ID nommer in ‘n ander kudde(s) bestaan, maak seker die opsie 

Soek Slegs in Geselekteerde Kudde gemerk is.  

o Onder die Bestaande hofie, kontroleer of die Status van die diere korrek is en verander waar 
nodig. 

• Om data verkry vanaf ’n telersgenootskap/registrerende owerheid wat van die Breedplan 

stelsel gebruik maak in te trek, sien Bylaag E. 

• Om dierdata wat op Excel aangeteken is in te trek, sien Bylaag B of kontak jou BenguFarm BEEF 
agent of Mnr. Leslie Bergh by leslie@benguelasoft.co.za of 082 801 2026. 

• Om diere aangeteken op RFID Experts se APR500 / APR600 / AWR300 EID leser (aangeteken 

met die Registrasie taak) in te trek, sien Bylaag C. 

• Om diere aangeteken op die Tru-Test XR5000 skaal in te trek, sien Bylaag C. 

• Om Stamboek teelwaardes in te trek, sien paragraaf 32. 

• Om die algemene data van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Algemeen opkykskerm of gaan op die Kudde Uitleg na die Algemeen, Identifikasie en Geboorte afdelings. 

• Nadat die dierdata ingetrek is, kan die volgende data bygevoeg word, waar beskikbaar: 

o Om aankoopdata (bv. datum gekoop, aankoopprys, van wie gekoop, ens.) aan te teken, 

sien paragraaf 13. Gebruik die Hulp funksie indien nodig. 
o Om diere aan kampgroepe te koppel, sien paragraaf 18. Gebruik die Hulp funksie indien 

nodig.  
o Om die gemiddelde belasting- en markwaardes vir verskillende kategorieë diere aan te 

teken, gaan na Verslae > Dier Lyste en Getalle > Diergetalle en –waardes. Kies 

Berekeningsmetode links bo-aan die skerm en kliek op die kortpadknoppie Stel Op en Verander 
Berekeningsmetodes vir Diergetalle, voltooi die Markwaarde en Belastingwaarde kolomme en 

kliek Stoor. 
o Om die boekwaarde en markwaarde van individuele diere aan te teken, gaan na Diere 

> Verander Diere (Tabel Uitleg). Gebruik die Hulp funksie indien nodig. Let wel: Wanneer 
aankoopdata van diere aangeteken word (Ander Data > Aankope), sal die aankoopprys 

outomaties ook as die boekwaarde van die dier opgeneem word, mits daar nie reeds ‘n 

boekwaarde vir die dier aangeteken was nie. 
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o Om jou teelbulle en KI-bulle te merk as teel/KI bulle, gaan na Diere > Voeg by en 

Verander (Enkel dier uitleg) > Algemeen, merk ("highlight") die betrokke bul, maak ’n regmerkie 
in die veld "Teel/KI Bul" en kliek Stoor. Bulle gemerk as ’n teelbul word apart in die kategorie 
“Teelbulle” gelys op die hoofskerm se Kudde Uitleg in die Kategorie kolom asook in die 

Diergetalle en -waardes verslag. Die teelbulle word ook bo-aan die lys van bulle gelys wanneer 

dekkings aangeteken word. 
o Indien 'n bul gebruik word in meer as een kudde (bv. stoet en kommersieel) wat op 

dieselfde databasis is, gaan na Diere > Voeg By en Verander Diere (Enkel Dier Uitleg) > 
Algemene Data en merk die veld “Sigbaar vir Reproduksie in Alle Kuddes” en kliek Stoor. 'n Bul 

wat só gemerk is sal in die ander kudde(s) op die Dekkings skerm beskikbaar wees in die lys 
van bulle om te kies as die bul en by Kalwings om te kies as die vader van 'n kalf. Die bul sal 

egter nie in die ander kudde(s) gelys word as 'n aktiewe dier in die kuddelys nie. 

11. Skep dierrekords per hand: (indien van toepassing) 

• Indien die dierdata van alle diere in die kudde nie ingetrek kon word nie (verwys paragraaf 10), moet 
dit per hand geskep word. Vir hierdie doel word aanbeveel dat die Voeg Diere By Wizard skerm (Diere 

> Voeg Diere By Wizard) gebruik word om vinnig en maklik dierrekords te skep. [Die Voeg By en 

Verander Diere (Enkel Dier Uitleg) skerm kan ook gebruik word, maar die Voeg Diere By Wizard werk 
die maklikste vir die skep van nuwe dier rekords]. Gebruik asseblief die kalwing skerm 

(Reproduksie > Kalwing) om kalwings aan te teken. 

• Op die Voeg Diere By Wizard skerm, kies by “Wat wil jy doen?” die opsie wat van toepassing is op jou 
kudde en beskikbare data, byvoorbeeld Voeg ’n Nuwe Dier by: Beperkte Data – Kommersiële Dier en 

volg die aanwysings.  

• Die minimum data wat benodig word per dier is die IDnr, Geslag, Ras, Geboortedatum, Status (Akief 
= Lewendig/In kudde, Onaktief = Dood/Nie in kudde) en Geregistreerd of Kommersiëel. [Let wel: 

Indien die presiese geboortedatum onbekend is, kies ’n benaderde datum, byvoorbeeld 01 Okt 2014 vir 

diere gebore gedurende 2014 en merk die Geboortedatum Onseker (“?”) blokkie]. 

• Indien jy reeds op hierdie skerm die diere wil koppel aan ’n kamp, moet die kampe eers opgestel 
word. (Sien paragraaf 18 van hierdie handleiding). Indien Dier in Geen Kamp gekies word by Kamp, sal 

dit wat by verstek ingevul is by Datum in Kamp en Rede nie gestoor word nie, so laat dit onveranderd. 

• Die velde Kuddekenmerk (indien van toepassing) en Jaar (van geboorte) sal outomaties voltooi word. 
Sodra die Volgnommer voltooi word, sal die program outomaties die IDNr (Visueel) skep in 

die formaat soos opgestel by Opstellings > Kuddes > ID-Metodes en Nommering > Verstek ID Formaat. 

(Sien paragraaf 6 van hierdie handleiding). Indien nodig, kan die verstek IDNr verander word. 

• Begin by die oudste diere in die kudde en werk deur na die jonger diere. Indien jy die moeder en/of 
vader van ’n dier ook wil aanteken, skep eers ’n dierrekord vir die betrokke ouer(s) en wanneer jy dan 

die dier skep, kies jy die ouer(s) deur op die kieslys (dropdown) langs die betrokke ouer veld te kliek en 
die ouer te kies. Indien die betrokke vader of moeder nie in die kudde is nie, skep hom/haar dan met 

Status as Onaktief. 

• Om die algemene data van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Algemeen opkykskerm of gaan op die Kudde Uitleg na die Algemeen, Identifikasie en Geboorte afdelings. 

• Om ’n dierrekord te verander (of te verwyder), sien paragraaf 15. 

• Nadat die basiese dierinligting geskep is, kan die volgende data bygevoeg word, waar 

beskikbaar: 

o Indien die aankoopdata (bv. datum gekoop, aankoopprys, van wie gekoop) nie reeds op 
die Voeg Diere By Wizard skerm aangeteken is nie, kan dit op die Aankope skerm 

aangeteken word. Sien paragraaf 13. Gebruik die Hulp funksie indien nodig. 
o Om gewigte aan te teken, sien paragraaf 29. 

o Om die gemiddelde belasting- en markwaardes vir verskillende kategorieë diere aan 

te teken, gaan na Verslae > Dier Lyste en Getalle > Diergetalle en –waardes. Kies 
Berekeningsmetode links bo-aan die skerm en kliek op die kortpadknoppie Stel Op en Verander 

Berekeningsmetodes vir Diergetalle, voltooi die Markwaarde en Belastingwaarde kolomme en 
Stoor. 

o Om die boekwaarde en markwaarde van individuele diere aan te teken, gaan na Diere 
> Verander Diere (Tabel Uitleg). Gebruik die Hulp funksie indien nodig. Let wel: Wanneer 

aankoopdata van diere aangeteken word (Ander Data > Aankope), sal die aankoopprys 

outomaties ook as die boekwaarde van die dier opgeneem word, mits daar nie reeds ‘n 
boekwaarde vir die dier aangeteken was nie. 

o Om jou teelbulle en KI-bulle te merk as teel/KI bulle, gaan na Diere > Voeg by en 
Verander (Enkel dier uitleg) > Algemene Data, merk ("highlight") die betrokke bul, merk die 

veld "Teel/KI Bul" en kliek Stoor. Bulle gemerk as ’n teelbul word apart in die kategorie 
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“Teelbulle” gelys op die hoofskerm se Kudde Uitleg in die Kategorie kolom asook in die 

Diergetalle en -waardes verslag. Die teelbulle word ook bo-aan die lys van bulle gelys wanneer 

dekkings aangeteken word. 
o Indien 'n bul gebruik word in meer as een kudde (bv. stoet en kommersieel) wat op 

dieselfde databasis is, gaan na Diere > Voeg By en Verander Diere (Enkel Dier Uitleg) > 

Algemene Data en merk die veld “Sigbaar vir Reproduksie in Alle Kuddes” en kliek Stoor. 'n Bul 
wat só gemerk is sal in die ander kudde(s) op die Dekkings skerm beskikbaar wees in die lys 

van bulle om te kies as die bul en by Kalwings om te kies as die vader van 'n kalf. Die bul sal 
egter nie in die ander kudde(s) gelys word as 'n aktiewe dier in die kuddelys nie. 

 

12. Aflaai en intrek van Logix (of Intergis) data: (indien van toepassing) 
Indien jy ’n Logix (of Intergis) gebruiker is, kan jy data van jou eie diere en/of van aangekoopte diere 

vanaf Logix (of Intergis) aflaai vir opname in BenguFarm BEEF – sien die instruksies hieronder by paragrawe 
12.1 en 12.2.  

 

Indien jy nie ‘n Logix (of Intergis) gebruiker is nie, kan jy ongelukkig nie self diere (bv. ’n KI bul of 
aangekoopte diere) se data van Logix aflaai nie. Jy kan egter wel as ’n Logix gasgebruiker veilingskatalogusse 

en sekere ander verslae aflaai. Indien jy ‘n KI bul of geregistreerde diere wat jy aangekoop het se Logix data 
wil intrek in BenguFarm, kontak asseblief SA Stamboek by telefoonnommer 051 4100 900 of stuur ‘n e-pos 

na help@logix.co.za en vra om vir jou die betrokke diere se 5-generasie Logix BEEFDATA lêer te stuur.  
 

Sien paragraaf 10 vir ander opsies om nuwe diere en/of KI bulle se data in te trek. 

 
Indien jy, vir watter rede ookal, nie die betrokke diere se dierdata elektronies kan ingetrek in BenguFarm 

BEEF nie, moet jy dit per hand skep vanaf data verkry vanaf die verkoper of uit die veilingskatalogus. Sien 
paragraaf 11 vir instruksies om dit te doen. 

 

12.1 Aflaai van Logix (of Intergis) data: 
Let wel:  

• Nuut aangekoopte diere: 

o  Indien Logix/Intergis nie oopgestel is vir jou betrokke ras nie (met ander 
woorde jy het slegs toegang tot diere in jou eie kudde), moet nuut 

aangekoopte diere reeds oorgedra wees na jou kudde voordat jy hul data kan 

aftrek. 
o Indien Logix/Intergis wel oopgestel is (sodat alle telers toegang het tot alle 

diere in die spesifieke ras), kan jy nuut aangekoopte diere se data aftrek al is 
hulle nog nie oorgedra na jou kudde nie. 

 
Om jou hele kudde se Logix (of Intergis) data af te laai: 

▪ Gaan in Logix (of Intergis) na Dienste > Data Onttrekking > Plaassagteware Volledig 

(V4)> Voltooi Deelnemerskode > Kies die betrokke ras (indien van toepassing) > Kies 
aantal Generasies (ons beveel aan om 5 generasies te kies) > Stuur > Wag dat lêer 

geskep word.  
▪ Jy het nou die keuse om die data af te laai via een van twee formate, naamlik ’n csv of 

zip formaat lêer. Die zip formaat lêer is kleiner en sal dus vinniger aflaai. Kliek regs op 

die lêer formaat van jou keuse en kies Save Target As (of Save Link As, afhangende van 
die “browser” wat jy gebruik). Stoor die gekose lêer op ’n gepaste plek op jou rekenaar 

(bv. C:\BenguFarm\Beef\Imports\Kudde).  
Let wel: Moet NIE hierdie lêer in Excel oopmaak NIE, aangesien dit kan 

veroorsaak dat jy dit nie sal kan intrek in BenguFarm BEEF nie en/of dat datums foutief 
ingetrek word. 

▪ Sien “Intrek van Logix/Intergis Dierdata” hieronder vir instruksies om hierdie data in 

BenguFarm BEEF in te trek. 
 

Om ontbrekende of spesifieke diere se Logix (of Intergis) data af te laai: 

• Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 
diensverskaffer): 

▪ Let wel: Met hierdie funksie kan jy slegs data van diere wat reeds oorgedra is op jou 

naam aflaai en intrek. Om data van diere waarvan jy NIE die eienaar is nie (bv. ‘n KI 
bul of diere wat gekoop is maar nog nie oorgedra is nie asook leenbulle waar jy nie 

eienaar asook “keeper” is op Logix nie) af te laai en in te trek, sien Opsie 2 hieronder. 
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▪ Om ontbrekende diere (bv. wat onlangs aangekoop en reeds oorgedra is op jou 

naam) se data af te laai en in te trek, gaan in BenguFarm BEEF na Data Stuur/Trek In 
> Logix Direk > Trek Ontbrekende Diere In. 

▪ Om spesifieke diere se data af te laai en in te trek, gaan in BenguFarm BEEF na Data 

Stuur/Trek In > Logix Direk > Trek Diere In. Op hierdie skerm kan of die 
rekenaarnommer of die ras, geslag, KKM, jaarsyfer en volgnommer van diere wat 

ingetrek moet en die aantal stamboom generasies wat ingetrek moet word, 
gespesifiseer word. Dit word aanbeveel om 5 generasies te kies. 

• Opsie 2: 

▪ Gaan na die Logix webwerf www.logix.org.za (of Intergis webwerf 
www.intergis.agric.za) en teken aan met jou gebruikersnaam en wagwoord. (Indien jy 

nog nie ’n geregistreerde Logix gebruiker is nie, kan jy aanlyn aansoek doen op die 

Logix tuisblad).  
▪ Gaan in Logix (of Intergis) na Dienste > Data Onttrekking > Plaassagteware Volledig 

(V4) > Kies diere > Skep ’n nuwe groep (gee enige gepaste naam vir die groep, bv. 
Groep 1) of kies ‘n Bestaande Groep van die lysie, indien van toepassing, en kliek Gaan 

Voort > Voeg dier by > Voltooi die dier se rekenaarnommer of ID nommer in die formaat 

Raskode/Geslag/Jaar/Volgnommer > Stuur > Merk die dier in die blokkie links van 
sy/haar No > Voeg dier by lys [of Voeg dier by lys en kies nog, indien van toepassing] 

> Herhaal totdat al die betrokke diere gekies is en bygevoeg is tot die lys > Skep verslag 
> Kies die aantal stamboom generasies wat ingesluit moet word (ons beveel aan dat jy 

5 generasies kies) > Stuur > Wag dat die lêer geskep word. 
▪ Jy het nou die keuse om die data af te laai via een van twee formate, naamlik ’n csv of 

zip formaat lêer. Die zip formaat lêer is kleiner en sal dus vinniger aflaai. Kliek regs op 

die lêer formaat van jou keuse en kies Save Target As (of Save Link As, afhangende van 
die “browser” wat jy gebruik). Stoor die gekose lêer op ’n gepaste plek op jou rekenaar 

(Bv. C:\BenguFarm\Beef\Imports\Kudde).  
Let wel: Moet NIE hierdie lêer in Excel oopmaak NIE, aangesien dit kan 

veroorsaak dat jy dit nie sal kan intrek in BenguFarm BEEF nie en/of dat datums foutief 

ingetrek word.  
▪ Sien “Intrek van Logix/Intergis Dierdata” hieronder vir instruksies om hierdie data in 

BenguFarm BEEF in te trek. 
 

Notas: 

• Indien jy navrae het oor Logix elektroniese data, kontak asseblief SA Stamboek by 
telefoonnommer 051 4100 900 of stuur ‘n e-pos na help@logix.co.za. 

• Om jou e-pos adres op Logix te verander of by te voeg of om jou Elektroniese Data Opname 

keuse te verander of te kontroleer, kontak asseblief vir Philna Moelich by telefoonnommer 051 

4100 900 of stuur ‘n e-pos na philna@studbook.co.za. 
 

12.2 Intrek van Logix (of Intergis) dierdata in BenguFarm BEEF: 
• Voordat jy voortgaan om die data in BenguFarm BEEF in te trek, maak eers ’n rugsteun van jou 

BenguFarm BEEF databasis (Lêer > Rugsteun en Herstel > Rugsteun). 

• Gaan in BenguFarm BEEF na > Lêer > Verander Aktiewe Kudde Na en kies die kudde waarin die 

data ingetrek moet word. 

• Gaan na Data Stuur/Trek In > Trek In > Databasis > Logix (of Intergis) Hoof 

Datalêer. Soek die csv of .zip formaat datalêer (BEEFDATA_....) waar jy dit gestoor het. Let 
wel: Die zip formaat lêer kan direk ingetrek word, sonder om eers die data te “extract”. Maak 

seker die Stamboek/LNR Lidnommer (sewe karakters, bv. 0567890), KKM en Ras is voltooi. Kies 
die toepaslike opsies vir intrek (Die verstek opsies is normaalweg in orde) en kliek op Trek In. 

Let op die opsie Verwyder Bul Nageslag van Ander Eienaars om bulle (soos KI bulle) se 

nageslag wat in ander kuddes gebore is te verwyder tydens intrek ten einde te verhoed dat 
onnodige diere in die databasis ingetrek word. Gebruik die Hulp funksie indien nodig.  

• Gaan in BenguFarm BEEF na Lêer > Ondersteuning en doen Verwyder DBNul waardes asook 

Herbereken Opsommende Inligting. 

• Om te kontroleer of die dierdata korrek ingetrek is, kliek op die pyltjie langs die wit blokkie bo-
aan die hoofskerm en kyk of die betrokke diere in die “Aktief” lys verskyn.  

Let wel:  
o Indien die Stamboek/LNR LidNr nie korrek voltooi is met die intrek van die data nie, sal die 

aktiewe diere verkeerdelik gelys word met status as “Onaktief”. Om jou Stamboek/LNR LidNr 

in BenguFarm BEEF op te stel, gaan na Opstellings > Kuddes > Algemeen > Genootskap 
(Stamboek) LidNr. 
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o Diere wat aangekoop is maar nog nie oorgedra is na jou kudde nie wanneer jy die 

data aftrek via Logix, sal, nadat hul data ingetrek is in BenguFarm BEEF, onder die onaktiewe 
diere gelys word. Om hul te skuif na die aktiewe lys, skakel die “Onaktief” filter aan, soek 

die betrokke dier(e), gaan na Diere > Voeg by en Verander Diere en verander in die Status 

veld van “Onaktief” na “Aktief”. 
o Indien jy ‘n betrokke dier(e) ook nie by die onaktiewe diere kry nie, maak seker die ID 

nommer is nie byvoorbeeld ABC 180038 (met ‘n spasie na die KKM) in plaas van ABC180038 
nie. Probeer om die dier op rekenaarnommer te soek by Diere > Soek Dier. 

o KI bulle en ander bulle waarvan jy nie nie die eienaar is nie, sal ook met Status 
"Onaktief" ingetrek word. Hulle sal dus nie op jou "Aktiewe diere" kuddelys verskyn nie. Om 

hulle maklik (bo-aan) jou lys van bulle te kry by die Dekkings/KI skerms, gaan na die Voeg 

by en Verander Diere  skerm, skakel die Onaktiewe dier filter aan, soek die bulle en merk 
("highlight", nie regmerkie) elk van hierdie bulle in die lys van diere. Maak ’n regmerkie in 

die veld "Teel/KI Bul" en kliek Stoor. Let wel: Die veld "Teel/KI Bul" sal slegs vertoon word 
indien die betrokke dier wat gekies is, 'n bul is. 

• Indien jy voorheen reeds die betrokke diere per hand op BenguFarm ingevoer het, maak seker 

dat daar met die intrek van die Logix data nie duplikaat dierrekords geskep is nie. 

Om duplikaat diere soek, sien paragraaf 45. 
 

13. Aankope – Diere en semen van KI bulle: 
 Aangekoopte diere: 

• Om die dierdata van aangekoopte diere in te trek of aan te teken, sien paragrawe 10 en 11 

hierbo.  

• Om aankoopinligting (by wie gekoop, aankoopdatum, prys, ensovoorts) van aangekoopte diere 

aan te teken (of verander/verwyder), gaan na Ander Data > Aankope. Gebruik die Hulp funksie indien 
nodig. Let wel: Indien dierrekords per hand geskep word met behulp van die Voeg Diere By Wizard 

skerm, kan die aankoopinligting daar aangeteken word. 

• Om ’n verslag te skep van diere wat aangekoop is, gaan na Verslae > Aankope, Veilings, Verkope, 
Vrektes en Uitskotte > Aankope. 

• Om die aankoopdata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Algemeen opkykskerm en rol af tot by die aankoopdata velde of gaan op die Kudde Uitleg na die Aankope 

afdeling. 
 

Aangekoopte semen van KI bulle: 
• Om die dierdata van ’n KI bu(le) in te trek of aan te teken, sien paragrawe 10 en 11 hierbo. 

o Aangesien jy nie eienaar van die KI bu(le) is nie, sal jy die opsie om spesifieke diere se Logix/Intergis 

data af te laai moet gebruik om die data van Logix af te laai en in te trek. 

o Sulke KI bu(le) sal met status Onaktief ingetrek word. Hou die status van KI bulle as Onaktief om te 
verseker dat hulle nie ingesluit word in jou kuddelys nie. 

• Om die semen van KI bulle aan te teken in die semen voorraad register (opsioneel), sien 

paragraaf 60. 
 

Algemeen: 
• Om te verseker dat die teelbulle, insluitende KI bulle, bo-aan jou lys van bulle vertoon word 

op die Natuurlike Dekkings en KI skerms, gaan na Diere > Voeg by en Verander (Enkel dier uitleg) 

> Algemeen, merk ("highlight") die betrokke bul, maak ’n regmerkie in die veld "Teel/KI Bul" en kliek 
Stoor. Bulle gemerk as ’n teelbul word ook apart in die kategorie “Teelbulle” gelys op die hoofskerm se 

Kudde Uitleg in die Kategorie kolom asook in die Diergetalle en -waardes verslag (Verslae > Dierlyste 

en -getalle > Diergetalle en -waardes). 

• Indien 'n bul gebruik word in meer as een kudde (bv. stoet en kommersieel) wat op dieselfde 
databasis is, gaan na Diere > Voeg By en Verander Diere (Enkel Dier Uitleg) > Algemene Data en merk 

die veld “Sigbaar vir Reproduksie in Alle Kuddes” en kliek Stoor. 'n Bul wat só gemerk is sal in die ander 
kudde(s) op die Dekkings skerm beskikbaar wees in die lys van bulle om te kies as die bul en by Kalwings 

om te kies as die vader van 'n kalf. Die bul sal egter nie in die ander kudde(s) gelys word as 'n aktiewe 

dier in die kuddelys nie. 

• Indien jy hulp nodig het met die aflaai van Logix data van ‘n KI bul of geregistreerde diere 
wat jy aangekoop het, kontak asseblief SA Stamboek by telefoonnommer 051 4100 900 of stuur ‘n 

e-pos na help@logix.co.za en vra om vir jou die betrokke diere se 5-generasie Logix BEEFDATA lêer 
te stuur. 

• Om diere aan kamp- of bestuursgroepe te koppel, sien paragraaf 18. Gebruik die Hulp funksie 

indien nodig. 
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14. Kontroleer of alle diere op rekord is: 
• Om die belangrikste data van diere in tabel uitleg op die hoofskerm op te kyk, gaan na die 

Kudde Uitleg. 

• Om die data van ’n enkele dier op die hoofskerm op te kyk, gaan na die Dier Uitleg, kies die 

betrokke dier se IDnr in die blokkie (pienk of blou) links bo-aan die hoofskerm en kliek dan op die 

betrokke opkykskerm se skakel. 

• Om te kontroleer of alle diere in BenguFarm BEEF is, kan jy ’n kuddelys verslag skep deur te 
gaan na Verslae > Dier Lyste en Getalle > Kuddelys. Let wel: Indien die Stamboek/LNR LidNr nie korrek 

voltooi is met die intrek van die Logix data nie (sien hierbo), sal die aktiewe diere verkeerdelik gelys 
word met status “Onaktief”. 

• Om ‘n diergetalle en -waardes verslag te skep wat die aantal diere in die kudde per kategorie 

(kalwers, koeie, bulle, ensovoorts) aandui, gaan na Verslae > Dier Lyste en Getalle > Diergetalle en -

waardes. Sien paragraaf 18 vir meer inligting oor hoe die kategorieë gedefiniëer word, ens. 

• Om te kontroleer of daar duplikaat dierrekords geskep en/of ingetrek is, sien paragraaf 45. 
 

15. Verander of verwyder data: 
• Om algemene dierdata (bv. geslag, geboortedatum, ID Nommer, vader, moeder en status) te 

verander of verwyder, is daar basies drie moontlike skerms wat jy kan gebruik, naamlik: 

o Diere > Voeg By en Verander Diere (Enkel Dier Uitleg): Gebruik hierdie skerm vir 

veranderings op enkel diere of velde wat uniek is per dier, byvoorbeeld ID Nr. Gebruik die Hulp 
funksie indien nodig. 

Wenk: Die Voeg By en Verander Diere skerm kan gebruik word vir enkeldier veranderings asook 
vir multi-dier veranderings. Om ‘n enkele dier te kies, moet daar net EEN keer op die dier se 

nommer gekliek word sodat die nommer net uitgelig is. Om verskeie diere te kies, moet daar 
DUBBEL gekliek word op ‘n dier se nommer sodat daar ‘n regmerkie in die blokkie langs die 

nommer verskyn. Kliek dan links onderaan die skerm op Multi Verander. 

o Diere > Verander Diere (Tabel Uitleg): Gebruik hierdie skerm vir dieselfde veranderings op 
’n aantal diere, byvoorbeeld om ’n groep kalwers se kalfseisoen te verander. Die skerm kan ook 

gebruik word om dierrekords te verwyder, indien nodig. Gebruik die Hulp funksie indien nodig. 
o Reproduksie > Kalwingskerm: Indien jy iets (bv. ’n kalfdatum) op ’n bestaande kalwing wil 

verander, kies die betrokke koei, kliek op die “N” langs haar nommer en kies die kalwing wat jy 

wil verander. Gebruik die Hulp funksie indien nodig. 

• Om spesifieke (nie-algemene) data (bv. dekkings, dragtigheidsondersoeke, gewigte/mates/punte 
nie gekoppel aan ’n toets, inentings, siektes en behandelings, prosedures, aankope en verkope) te 

verander of te verwyder, gaan na die skerm waar die betrokke tipe data oorspronklik ingelees is. 
Indien natuurlike dekkings byvoorbeeld verander moet word, gaan na Reproduksie > Dekkings > 

Natuurlike Dekkings. Om die bestaande data wat verander moet word te vertoon, kliek regs bo-aan die 

skerm op Laai Bestaande Rekords. Wanneer die betrokke dier of groep diere gekies is, kan daardie 
dier(e) se data verander en gestoor word. Indien dieselfde verandering by verskeie diere aangebring 

moet word, merk die spesifieke diere wat se data verander moet word met ’n regmerkie in die eerste 
(“K” = Kies) kolom. Verander nou die betrokke data in die Multi Verander / Voeg Nuwe By area bo-aan 

die skerm en stoor. Gebruik die Hulp funksie indien nodig. 

• Die Data Navigeerder skerm [Diere > Data Navigeerder] kan ook gebruik word om verskeie tipes data 
te verander of te verwyder. Gebruik die Hulp funksie indien nodig. 

 

16. Rugsteun en herstel van die databasis(se) en ander inligting: 
• BAIE BELANGRIK!!! Lees asseblief die volgende paragraaf noukeurig deur. 

o Die BenguFarm databasis, fotos, ensovoorts word NIE in die “cloud” gestoor NIE, dit 

word op die rekenaar self gestoor. Dit beteken dat, indien die rekenaar gesteel word of die 
hardeskyf beskadig word of ’n virus die rekenaarlêers beskadig, die BenguFarm data, ensovoorts 

verlore sal wees. 
o Dit is dus krities belangrik om GEREELD 'n rugsteun te maak van jou BenguFarm 

databasis(se), gestoorde verslaguitlegde, fotos & dokumente en die Genetics databasis (indien 
van toepassing), veral nadat jy heelwat nuwe data opgeneem of data verander het, voordat jy 

iemand anders laat werk aan jou rekenaar, ens. 

o Dit is net so belangrik om die rugsteun op ’n VEILIGE PLEK te stoor, byvoorbeeld ’n 
web (“cloud”) gebaseerde plek soos Dropbox, GoogleDrive of OneDrive en/of ’n eksterne 

hardeskyf of geheuestokkie. Bêre hierdie eksterne hardeskyf of geheuestokkie apart van jou 
rekenaar op 'n veilige plek sodat dit nie saam met jou rekenaar gesteel kan word nie.  
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• Om die verstek plek waar rugsteun lêers gemaak word te verander, gaan na Opstellings > 
Kuddes > Verstek Gidse vir Lêers > Verstek Gids waar Rugsteunlêers gemaak sal word. Let wel: Die 

vooropgestelde plek op die rekenaar se hardeskyf (C:\BenguFarm\Beef\ Backups\[Kudde]) is NIE ’n 
veilige plek om die rugsteun te stoor nie, aangesien daardie rugsteun verlore sal wees indien die rekenaar 

gesteel word of iets oorkom. 

• Om ’n rugsteun te maak, gaan na Lêer > Rugsteun en Herstel. Onder die hofie Maak ’n Rugsteun, 
kies die tipe data (Databasis(se), Gestoorde Verslaguitlegde, Fotos & Dokumente) waarvan jy ’n rugsteun 

wil maak. Onder die hofie Maak Rugsteun In, kies die plek waar jy die rugsteun lêer wil stoor. Kliek aan 

die regterkant op Rugsteun om die rugsteun te maak. Gebruik die Hulp funksie indien nodig. 

• Indien jy meer as een databasis in BenguFarm het, onthou om van elke databasis ’n rugsteun te maak. 

• Om ’n rugsteun te maak wat alles (databasis(se), gestoorde verslaguitlegde, fotos & dokumente, 
ens.) insluit, kies Volledige Stelsel Rugsteun (BFSysBackup gids). 

• Van tyd tot tyd kan ou rugsteun lêers wat nie meer benodig word nie, verwyder (“delete”) word. 

• Om op te stel dat BenguFarm BEEF jou herinner om gereeld 'n rugsteun te maak, gaan na 

Opstellings > Kuddes > Herinneraars. 

• Om ’n rugsteun te herstel: 
o Gaan na Lêer > Rugsteun en Herstel. 

o As jy meer as een databasis op BenguFarm het, maak seker jy is in die regte databasis. Dit is 

altyd ’n goeie idee om eers ’n rugsteun te maak van die huidige data voordat ’n rugsteun herstel 
word - net vir ingeval iets verkeerd loop.  

o Om ‘n databasis rugsteun te herstel, moet onder die hofie Herstel ‘n Rugsteun die opsie Herstel 
Volldige Stelsel Rugsteun (Kies BFSysBackup… gids) NIE gekies word NIE. Kliek op Soek, gaan 

na waar die rugsteun gestoor is, kies die Database Backup_[datum+tyd] lêer (“file”), kliek 
Maak Oop en kliek Herstel. 

o Om ‘n volle stelsel rugsteun te herstel, kies onder die hofie Herstel ‘n Rugsteun die opsie 

Herstel Volldige Stelsel Rugsteun (Kies BFSysBackup… gids). Kliek op Soek en gaan na waar die 
rugsteun gestoor is, kies die BFSysBackup_[datum+tyd] gids (“folder”), kliek Maak Oop en 

kliek Herstel. Let wel: Indien ‘n volle stelsel rusteun herstel word, word ALLE databasisse se 
data oorskryf.  

• Om data van een rekenaar na ’n nuwe of ander rekenaar oor te dra: 

o Op die ou rekenaar: 

▪ Plaas ‘n geheuestokkie waarop jy ‘n BenguFarm rugsteun gaan maak in die rekenaar. 
▪ Maak BenguFarm oop en gaan na Lêer > Rugsteun en Herstel.  

▪ Onder Maak ‘n Rugsteun, kies onder Van Watter Data Moet ‘n Rugsteun Gemaak Word die 
opsie Volledige Stelsel Rugsteun (BFSysBackup gids). 

▪ Kliek op Soek en kies die geheuestokkie drywer en gids (“folder”) waar jy die rugsteun wil 

maak. 
▪ Kliek op Rugsteun. In die gids (“folder”) wat gekies is, sal 'n sub-gids geskep word met die 

naam BFSysBackup_[datum+tyd] waarbinne al die betrokke data gestoor word. 
▪ Verwyder die geheuestokkie met die rugsteun daarop uit die rekenaar. 

o Op die nuwe rekenaar: 
▪ Plaas die geheuestokkie met die rugsteun daarop in die nuwe rekenaar. 

▪ Maak seker BenguFarm is dieselfde of nuwer weergawe as op die ou rekenaar. (Kyk bo-aan 

die hoofskerm vir die weergawe datum).  
▪ Maak BenguFarm oop en kies Herstel ‘n Rugsteun vanaf die Welkom skerm. 

▪ Onder die hofie Herstel ‘n Rugsteun, kies die opsie Herstel Volldige Stelsel Rugsteun (Kies 
BFSysBackup… gids). Kliek op Soek en gaan na waar die rugsteun op die geheuestokkie is 

en kies die BFSysBackup_[datum+tyd] gids (“folder”). 

▪ Kliek op Herstel. 
▪ Om BenguFarm op die nuwe rekenaar te registreer, bel Naomi Havenga by 082 696 8306 

en gee vir haar die Rekenaar Identifikasie Kode links bo-aan die Registrasie skerm asook 
julle BenguFarm rekeningnommer (BPU___). 

▪ Al jou BenguFarm data, fotos, opstellings en eie verslae behoort nou op jou nuwe rekenaar 
te wees. 

• Let wel: Alle opstellings van al die kuddes (waar van toepassing) op die betrokke databasis word 

ingesluit in die rugsteun van die databasis. Bestaande opstellings word dus oorskryf wanneer ’n rugsteun 

herstel word. 
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17. Toegang tot en sinchronisasie van data tussen rekenaars: 
BenguFarm mag op meer as een rekenaar geïnstalleer word met een lisensie (d.w.s. geen ekstra 
koste nie), solank as wat dit slegs vir die geregistreerde gebruiker se kudde(s) gebruik word. Volg dieselfde 

proses vir installasie en registrasie op die addisionele rekenaar(s) as vir die eerste rekenaar. 

 

BAIE BELANGRIK!!!  
Die BenguFarm databasis is NIE “cloud” gebaseer nie, dit is op die hardeskyf van die betrokke 
rekenaar waarop die program geïnstalleer is. Dit beteken dat data ingevoer/verandering 

normaalweg slegs op een rekenaar gedoen kan word, tensy die BenguFarm databasis na ‘n 

netwerkbiediener (“server”) geskuif word – sien die netwerk opsie hieronder.  
 

Indien BenguFarm op meer as een rekenaar geïnstalleer is, is daar verskeie opsies om die data 
tussen die rekenaars te sinchroniseer en vir alle persone wat op die program moet werk 

toegang te gee tot die nuutste data op BenguFarm. Hierdie opsies is: 

• Meester rekenaar opsie: Met hierdie opsie (wat tans deur die meeste boere gebruik word), moet die 

eienaar besluit op 'n meester rekenaar, met ander woorde die enigste rekenaar waarop nuwe data 
opgeneem en verander word. ’n Rugsteun (“backup”) van die BenguFarm databasis word dan op ’n 

gereelde basis op die meester rekenaar gemaak, gedeel (bv. via geheuestokkie, e-pos, Teamviewer se 
File Transfer of Dropbox) met die ander gebruikers en elkeen van hulle herstel die rugsteun dan weer 

op sy/haar rekenaar. Die ander gebruikers gebruik dus die program net vir navrae en verslae, m.a.w. 
hulle voeg geen data by of verander of verwyder data nie. Hierdie proses is baie vinnig en maklik. Nota: 
Die eerste keer wat 'n rugsteun op een rekenaar gemaak en op ander rekenaar herstel word, word 'n 
registrasie- en toegang kode benodig om die BenguFarm databasis te registreer op die nuwe rekenaar. 

Daarna kan ‘n rugsteun gemaak en herstel word sonder dat 'n registrasie en toegang kode benodig 
word. [Sien paragraaf 16 vir rugsteun en herstel funksies]. 

• Netwerk opsie: As die rekenaars gekoppel is aan 'n netwerk, bv. 'n LAN, kan BenguFarm geïnstalleer 

word op die verskillende rekenaars, die BenguFarm databasis kan op die bediener gesit word en elke 
rekenaar se BenguFarm gekoppel word aan die databasis op die bediener. Op hierdie wyse het almal 

gelyktydig toegang tot die dieselfde lewendige databasis. Afhangende van 'n paar tegniese aspekte, kan 

die program in sekere gevalle 'n bietjie stadiger wees, omdat dit toegang moet verkry tot die databasis 
via 'n netwerk. Baie van ons kliënte maak gebruik van hierdie opsie, en op voorwaarde dat die bediener 

altyd aan is en al die mense altyd toegang het tot die bediener, werk hierdie opsie goed. Vir instruksies 
om BenguFarm vir ’n netwerk op te stel, kontak jou BenguFarm agent of Mnr. Leslie Bergh by 

leslie@benguelasoft.co.za of 0828012026. 

• Veelvuldige databasis opsie: Hierdie opsie werk goed waar daar byvoorbeeld twee bestuurders, 

elkeen op 'n afsonderlike plaas, is wat elk verantwoordelik is vir die data opname op BenguFarm van die 
kuddes/spesies op ‘n spesifieke plaas, bv. plaas A en plaas B onderskeidelik. In so 'n geval kan 'n aparte 

databasis vir elke bestuurder/plaas opgestel en registreer word. Op die eienaar se rekenaar word twee 
databasisse opgestel en registreer, een vir plaas A en een vir plaas B. Die bestuurder van plaas A kan 

op 'n gereelde basis 'n rugsteun van plaas A se databasis op sy rekenaar maak en dit stuur (per e-pos, 
Dropbox, ens.) aan die eienaar. Die eienaar kan die rugsteun op sy rekenaar herstel sonder om die data 

van plaas B te beïnvloed. Dieselfde geld vir die plaas B. Op hierdie manier kan die eienaar toegang hê 

tot die nuutste data sonder om direk te werk op die twee meester databasisse. 

• TeamViewer opsie: TeamViewer sagteware stel ‘n persoon in staat om (deur middel van ‘n ID kode 
en toegangskode wat die ander persoon moet verskaf) toegang tot die ander person se rekenaar te 

verkry deur die internet. Die TeamViewer opsie kan werk as die betrokke partye relatief vinnige internet 
diens het. Die enigste probleem met hierdie opsie is dat die afgeleë (“remote”) rekenaar nie beskikbaar 

is vir die persoon om op te werk terwyl die afgeleë persoon besig is om via TeamViewer daarop te werk 

nie. 
 

 
NOTA: 

Tot by paragraaf 17 is nodig om BenguFarm BEEF reg te kry vir vedere gebruik. In Deel B van 
die handleiding verduidelik ons die rekordhouding en funksies wat nodig is vir die basiese 

gebruik van BenguFarm BEEF. Sekere van hierdie funksies is slegs van toepassing op kuddes wat lid is 

van SA Stamoek se Logix Beef en/of prestasietoetsing doen deur die LNR se Nasionale Vleisbeesaantekening 
en -verbeteringskema. Waar van toepassing, word hierdie funksies so aangedui in die onderskeie afdelings. 

Addisionele funksies word in Deel C verduidelik. 
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DEEL B – BASIESE FUNKSIES: 
 

18. Groepe – Kalfseisoene, Kampe, Bestuurgroepe en Ander: 
 

Diergetalle kategorieë: 
BenguFarm koppel diere outomaties aan ‘n Diergetalle kategorie (bv. Verskalwers, Jong Verse, Teelbare 
Verse, Jong Koeie, Volwasse Koeie, Ou Koeie) op grond van die dier se ouderdom, geslag en (vir vroulike 

diere) of daar nageslag op rekord is (koei) of nie (vers). Wanneer ‘n vers se eerste kalwing aangeteken word 
in BenguFarm, sal haar kategorie byvoorbeeld outomaties verander van Teelbare Verse na Jong Koeie. Let 

asseblief op dat ouer vroulike diere sonder nageslag op BenguFarm, ongeag ouderdom, as Teelbare Verse 
gekategoriseer word. Die diergetalle kategorieë word onder andere op die hoofskerm > Kudde Uitleg > 

Algemeen > Kategorie vertoon. 

 
Om die kriteria vir die onderskeie diergetalle kategorieë te sien, gaan na Verslae > Dier Lyste en 

Getalle > Diergetalle en -Waardes. Links bo-aan die skerm by Kies Metode van Berekening, kliek op die 
opstellings kortpad knoppie (rooi notaboekie). Die Verstek Beesgetalle metode kan nie verander word nie. 

Indien die Verstek Beesgetalle metode nie aan jou behoeftes voldoen nie, kan jy jou eie metode opstel deur 

op Nuwe of Kopiëer te kliek. Ons beveel aan dat die Kopiëer opsie gekies word, net te verander waar nodig 
en dan te stoor met ‘n naam. Bespreek dit asseblief jou eie kriteria met jou BenguFarm BEEF agent om seker 

te maak dat die kriteria só opgestel is dat sekere diere nie uitgesluit word uit die telling nie. Wenk: Om 
gemiddelde belasting- en markwaardes vir die verskillende kategorieë diere aan te teken, voltooi die 

Markwaarde en Belastingwaarde kolomme en Stoor. Om ‘n ander berekeningsmetode te kies as die verstek 
metode vir die betrokke kudde, gaan na Opstellings > Kuddes > Herinneraars > Verstek Diergetalle 

Berekeningsmetode.  

 
Om ‘n diergetalle en -waardes verslag te skep wat die aantal diere in die kudde per kategorie aandui, 

gaan na Verslae > Dier Lyste en Getalle > Diergetalle en -waardes. Daar is twee opsies vir die verslag: Die 
Kategorie Uitleg lys die aantal diere per kategorie met waardes (indien opgestel) en grootvee-eenhede (GVE). 

Met die Kamp Uitleg word die aantal diere per kategorie per kamp gelys. 

 

Eie Opgestelde Groepe: 
In BenguFarm BEEF kan verskillende tipe groepe opgestel en diere daaraan gekoppel word. Die verskillende 
tipe groepe word genoem Kategorieë, bv. Kalfseisoene, Kampe, Bestuursgroepe, ens. Onder elke kategorie 

word die betrokke groepe opgestel. Onder Kalfseisoene kan daar byvoorbeeld ’n kalfseisoen “Lente 2019” 

opgestel word om alle kalwers gebore in daardie seisoen aan te koppel.  
 

Groepe word gebruik om ’n groep diere maklik, vinnig en akkuraat te kies om data voor aan teken (bv. om 
uitslae van dragtigheidsondersoeke aan te teken vir alle diere in Kamp 1) of vir insluiting in ’n verslag (bv. 

om ’n weeglys te skep vir alle kalwers gebore in die Lente 2019 seisoen), om ‘n inventaris te hê om te 
kontroleer of al die diere in ‘n kamp of groep is, om te weet in watter kamp of groep ‘n dier is, om voer- 

en/of  lekverbruik per kamp te kan aanteken en om die weiding benutting per kamp te kan bereken. 

 
Let wel: 

o Diere kan nie aan ‘n kategorie gekoppel word nie, hulle moet aan die groepe van die betrokke 
kategorie gekoppel word. 

o Groepe in verskillende kategorieë is onafhanklik van mekaar. ’n Dier kan byvoorbeeld gelyktydig aan 

’n sekere kalfseisoen, kamp en bestuursgroep gekoppel wees. 
 

Kalfseisoengroepe:  
• Kalfseisoene word gebruik om, wanneer dekkings en dragtighede aangeteken word, die seisoen aan te 

dui waarin die betrokke koeie sal kalf. Wanneer kalwers se geboortedata op die Kalwingskerm 

aangeteken word, sal BenguFarm, indien die kalfseisoen gekies is, die kalwers aan die betrokke 

kalfseisoen koppel. Dit kan dan as groep gebruik word om die betrokke kalwers te kies wanneer nodig 
vir wegings, inentings, ens. Ons beveel sterk aan dat jy kalfseisoene opstel en dit gebruik wanneer jy 

dekkings en kalwings aanteken. Wenk: Indien kalwers vir een of ander rede nie aan ’n kalfseisoen 
gekoppel is nie of aan ’n verkeerde kalfseisoen gekoppel is, kan dit gedoen/reggestel word by Diere > 

Verander Diere (Tabel Uitleg). 

• LET WEL: Wanneer dekkings aangeteken word, moet sleg die betrokke dekrekords aan ’n kalfseisoen 
gekoppel word, nie die koeie self nie. Wanneer die kalwers gebore word, word die kalwers gekoppel aan 

’n kalfseisoen. Kalfsiesoen kan dan later gebruik word as ’n groep om kalwers te kies vir die aantekening 

van gewigte, inentings, ens. 
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• Om ’n nuwe kalfseisoen op te stel, gaan na Opstellings > Kalfseisoene en kliek op die “+” (regter 
onderste hoek van die skerm). Dit word aanbeveel dat die jaar en eerste letter van die seisoen gebruik 

word vir die kalfseisoen kode, byvoorbeeld: 
 

 Kalfseisoen Dekseisoen Kalwings  

Kudde In 
Gebruik 

Kode Naam Begin Dek Eindig Dek Begin End 

ALL √ 2017L Kalwers gebore 

2017 Lente 

15 Nov 2016 15 Feb 2017 word 

bereken 

word 

bereken 
 

Nadat die nuwe kalfseisoen gestoor is, kies die Huidige Kalfseisoen in die geel gedeelte van die skerm en 

kliek Stoor. 
 

Let wel: Onthou om met elke nuwe kalfseisoen die nodige opstelling te doen en daardie kalfseisoen te kies 
as die huidige kalfseisoen. 

 

Wenk: Vir ’n artikel oor die voordele en implimentering van teelseisoene, kontak Mnr. Leslie Bergh by 
leslie@benguelasoft.co.za of 082 801 2026. 

 

Kampgroepe: 
• Kampe word gebruik om diere in BenguFarm aan te koppel sodat rekord gehou kan word van watter 

diere in watter kampe is of was op ’n spesifieke datum. Dit kan dan gebruik word vir voorraadopname 

(“stock take”). Dit word ook gebruik om die weidingbenutting per kamp te bereken en ook om voer- 
en/of  lekverbruik per kamp te kan aanteken. 

• Om ’n nuwe kamp op te stel, gaan na Opstellings > Kampe en kliek op die “+” (regter onderste 

hoek van die skerm), byvoorbeeld: 
 

Kudde In 

Gebruik 

Toestel Kode Naam Skaal 

ID 

Grootte 

(ha) 

Tipe 

Weiding 

Drakrag 

(ha/GVE) 

Totale 

GVE 

ALL √ √ UK1 Uitsig Kamp 1 UK1 25 Suur bosveld 5 5 

ALL √ √ UK2 Uitsig Kamp 2 UK1 32 Suur bosveld 6 5.3 

 

Let wel:  
o Die opstel van kampgroottes en drakrag per kamp is opsioneel, maar dit is belangrik om die volle 

voordeel van die Weidingbenutting per Kamp verslag te kry (sien die gedeelte hieronder vir meer 
inligting).  

o Indien jy ‘n voerkraal het, kan jy die onderskeie krale as “kampe” opstel in BenguFarm. 
o Die kategorie Kampe op Plaas is só opgestel dat ’n dier slegs in een kamp op ’n slag kan wees. 

Indien ’n dier geskuif word van een kamp na ’n ander, word dit outomaties uit die vorige kamp 

gehaal. 
o Indien van toepassing, vul in die Skaal ID veld die kamp se kode in soos dit op jou skaal se sagteware 

aangeteken is. 
 

Bestuursgroepe: 
• Bestuursgroepe word gebruik om diere wat saam bestuur word, ongeag in watter kamp(e) die betrokke 

groep is, in BenguFarm aan ’n groep te koppel, byvoorbeeld Jong Verse, Dragtige Verse, Eerstekalf Koeie 
en Volwasse Koeie. Let wel: Die werklike bestuursgroepe op die plaas dikteer hoe die bestuursgroepe 

in BenguFarm opgestel moet word, nie andersom nie. Wenk: Indien kampgroepe nie gebruik gaan word 
nie (bv. waar drukbeweiding toegepas word en diere kort-kort wissel tussen kampe), kan die kategorie 

Kampe op Plaas gebruik in plaas van Bestuursgroepe vir die opstel van bestuursroepe. Dit het verskeie 

voordele, onder andere dat die Kamp groep opsie op die Selekteer Diere skerm gebruik kan word om ‘n 
spesifieke bestuursgroep vining en maklik te kies, rekord kan gehou word in BenguFarm van datums en 

redes waarom diere geskuif is tussen bestuursgroepe, verskuiwings kan op verskillende plekke in 
BenguFarm aangeteken word, ens. 

• Ons beveel aan dat Bestuursgroepe opgestel word dat ’n dier slegs in een bestuursgroep 

kan wees. Om dit te doen, gaan na Opstellings > Groepe en Kampe > Kies Kategorie > Bestuursgroepe 
> Voeg By/Verander/Verwyder Kategorieë en merk die opsie Slegs in Een Groep. 

• Wenk: By Opstellings > Kuddes > Ander > Verstek Groep Kategorie kan die groepe kategorie wat die 

meeste gebruik word, gekies word. 
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Uitskot- en Verkoopgroepe: 
• Uitskot en Verkoopgroepe word gebruik om diere wat uitgeskot of verkoop moet word, in BenguFarm 

aan ’n groep te koppel, byvoorbeeld koeie vir moontlike uitskot, speenkalwers om te verkoop, voerkraal 
diere om te verkoop en produksieveiling diere. Hierdie groepe stel jou in staat om, ongeag in watter 

kampe of bestuursgroepe diere wat uitgeskot of verkoop moet word is, te kan kies. Diere gekoppel aan 

’n uitskot- of verkoopgroep, bly dus steeds in hul betrokke kamp- of bestuursgroep, tot tyd en wyl hulle 
verkoop is. 

• Die kategorie Uitskot- en Verkoopgroepe se verstek opstelling is dat ’n dier in meer as een uitskot- of 

verkoopgroep op ’n slag kan wees. Om dit te verander sodat ’n dier slegs in een uitskot- of verkoopgroep 
groep op ’n slag kan wees, gaan na Opstellings > Groepe en Kampe > Kies Kategorie > Voeg 

By/Verander/Verwyder Kategorieë > merk die opsie Slegs in Een Groep langs die Uitskot- en 
Verkoopgroepe > Stoor > Gaan Uit. 

 

Koppel diere aan ’n kamp of groep en skuif diere: 
• Om diere aan ‘n groep (bv. ’n kamp of bestuursgroep) te koppel of om diere te skuif tussen 

groepe of kampe: 

o Gaan na Ander Data > Verskuif Diere na ‘n ander Kamp of Groep. Gebruik die Hulp funksie 
indien nodig; OF  

o Diere kan ook op die hoofskerm se Kudde Uitleg en die meeste aantekenskerms asook sekere 

verslagskerms aan kampe of groepe gekoppel of verskuif word deur die betrokke diere te kies 
in die K-kolom en dan te kliek op Koppel Diere aan Groep. Hierdie funksie het verskeie opsies, 

bv. om gekose koeie se kalwers na dieselfde of ’n ander kamp te skuif as die moeders.  
o Diere kan aan ’n kamp gekoppel word op die Voeg Diere By Wizard, Voeg By en Verander Diere 

(Enkel Dier Uitleg) en Verander Diere (Tabel Uitleg) skerms. 

• Om diere wat in ‘n bestuursgroep is ook aan ‘n kamp te koppel (of andersom): 

o Gaan na Ander Data > Verskuif diere na 'n ander Kamp of Groep. Kies die kamp waarna die 
diere geskuif moet word regs bo-aan die skerm as die aktiewe groep. In die middel van die 

skerm (onder die opskrif Voeg By/Verwyder Diere d.m.v. Groep/Kamp), by Kategorie, kies 
Bestuursgroepe. By Groep/Kamp, kies die betrokke bestuursgroep. Kliek aan die regterkant van 

die Groep/Kamp op die swart pyl om die diere in die betrokke bestuursgroep in die betrokke 
kamp te plaas. Gebruik die Hulp funksie indien nodig; OF 

o Gaan op die hoofskerm na die Kudde Uitleg en by die groepfilter (regs van die Vroulik filter), 

kies die betrokke bestaande groep/kamp. Kies die diere in die K-kolom en kliek Koppel Diere 
aan Groep. Koppel hulle dan aan die verlangde groep of kamp.  

• Om bestaande kampverskuiwings van ’n dier te verander, gaan na Diere > Voeg By en Verander 

Diere (Enkel Dier Uitleg) > Algemeen. By die Kampe veld, kliek op die Verander 
Kampverskuiwingsgeskiedenis knoppie. 

• Om ’n verslag te skep van diere per kamp of groep, gaan na Verslae > Kampe en Kuddes > Diere 

per Kamp of Groep. Let wel: Die diere wat nie in ’n kamp geplaas is nie, sal gelys word in ‘n “kamp” 

met kode “[geen]”.  

• Om ’n verslag te skep van diere se verskuiwings/bewegings tussen kampe, gaan na Verslae 
> Kampe en Kuddes > Kamp Verskuiwings. 

• Om ’n verslag te skep van die weiding benutting van kampe vir ’n sekere tydperk, gaan na 

Verslae > Kampe en Kuddes > Weiding Benutting per Kamp. Hierdie verslag sal slegs beskikbaar wees 
indien die kampe opgestel is met minstens die kampgroottes. Wenk: Kliek op die Berekenings 

inligtingsknoppie regs onderaan die skerm om te sien hoe die berekenings gedoen word. Let wel: 
o Hierdie verslag maak gebruik van die kampverskuiwings geskiedenis in BenguFarm. Dit is dus 

krities dat hierdie data beskikbaar is vir die tydperk waarvoor die verslag geskep word. 

o Om die volle voordeel van hierdie verslag te kry, spesifiek die persentasie wat die onderskeie 
kampe reeds benut is, is dit belangrik om kampgroottes en die drakrag (GVE/ha) per kamp op 

te stel by Opstellings > Kampe.  
o Diere wat verkoop of dood is, moet by Verkope, Vrektes en Uitskotte aangeteken word met ‘n 

datum, ens. (dit wil sê hul status moet nie net na Onaktief verander word nie) om te verseker 

dat die periode in die laaste kamp korrek bereken word.  
o Om te sien hoe die aantal GVE bereken word vir verskillende kategorieë diere, gaan na 

Opstellings > Kuddes > Herinneraars > Verstek Diergetalle Berekeningsmetode en kliek op die 
opstellings knoppie. Maak seker dat die toepaslike raamgrootte gekies is by Opstellings > 

Kuddes > Liggaamsmates > Koeie se Raamgrootte, 

o Die aantal GVE word bereken volgens die kategorie waarin die betrokke dier was op die tydstip 
toe die dier in die kamp was. 
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• Om die kampdata van ‘n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Algemeen opkykskerm en rol af tot by die kamp inligting of gaan op die Kudde Uitleg na die Kamp 

afdeling. Wenk: Filter die betrokke kamp by die Groepfilter om slegs ’n spesifieke kamp se diere te sien 
op die Kudde Uitleg. 

• Om ander groepe (bv. bestuursgroepe) waarin ’n dier is op die hoofskerm op te kyk, gaan 

op die Dier Uitleg na die Algemeen opkykskerm en rol af tot by die My Groepe veld of gaan op die Kudde 
Uitleg na die Algemeen afdeling. Indien daar op die Kudde Uitleg nie ‘n kolom is vir Bestuursroepe nie, 

gaan na Vertoon Opsies, merk die Vertoon Groepe van Kategorie opsie, kies Bestuursgroepe en kliek 

Stoor Opsies as Kudde Verstek. 
 

Prestasietoetsgroepe: 
• ’n Prestasietoetsgroep is normaalweg 'n subgroep van diere wat almal in dieselfde kalfseisoen gebore 

is. Die funksie van prestasietoetsgroepe is om 'n groep diere saam te stel waar die 

ouderdomverspreiding binne die toelaatbare ouderdomverspreiding is vir prestasietoetsing (sien 

Opstellings > Kuddes > Prestasietoetsgroepe). Hierdie groepe kan dan gekies word om diere in te sluit 
in ’n spesifieke prestasietoets. Kalwers word outomaties op die kalwingskerm ingedeel in 

prestasietoetsgroepe. So byvoorbeeld sal die kalwers wat in die eerste 100 dae van kalfseisoen 2017L 
gebore is, ingedeel word in prestasietoetsgroep 2017L-0, die volgende 100 dae in prestasietoetsgroep 

2017L-1, ens.  

• Indien nodig, kan prestasietoetsgroepindelings verander word deur te gaan na Prestasietoetsing 

> Prestasietoetsgroep Indelings. Gebruik die Hulp funksie indien nodig. 

• Let wel: Diere hoef nie aan ’n prestasietoetsgroep gekoppel te wees om hulle in te sluit in ’n 
prestasietoets nie – dit maak dit net makliker om diere te selekteer vir ‘n toets. 

 

Filtergroepe: 
'n Filtergroep is 'n groep diere soos gekies deur 'n sekere stel kriteria. Hierdie kriteria kan opgestel en gestoor 

word in die My Dierdata Verslae [sien Verslae > My Verslae > Dierdata > Selekteer Diere (Kriteria)]. Jy kan 
byvoorbeeld kriteria opstel om alle aktiewe vroulike diere wat gebore is in 'n bepaalde jaar en nog nie gekalf 

het nie te lys. Hierdie kriteria kan dan gestoor word vir latere gebruik. Diere kan deur middel van gestoorde 
filtergroepe gekies word op die Kies Diere skerm, hoofskerm > Kudde Uitleg > Groepfilter asook in die My 

Dierdata verslae.  Let wel: Dit is belangrik om daarop te let dat 'n filter groep nie as 'n spesifieke keuse van 
diere gestoor word êrens in die databasis nie. Die diere in die groep word bepaal deur die toepaslike 

gestoorde kriteria vir die filter op die tydstip wanneer die filter groep gekies word. 

 

Geboorte Kontemporêre Groepe opstellings: 
• Let wel: Hierdie opstellings hoef slegs gedoen te word indien jy ’n stoetkudde het, SA 

Stamboek (Logix) gebruik as diensverskaffer en kalwers weeg by geboorte.  
• Geboorte kontemporêre groepe word slegs gebruik om kalwers se geboortegewigte in die toepaslike 

kontemporêre groepe in te deel vir die beraming van geboortegewig teelwaardes.  

• Om ’n nuwe geboorte kontemporêre groep op te stel, gaan na Opstellings > Geboorte 

Kontemporêre Groepe en kliek op die “+” (regter onderste hoek van die skerm). 

• Die Geboortegewig Kontemporêre Groepkode word saamgestel uit Jaar van Geboorte + Seisoen + 

Plaas/Bestuursgroep. In die kolom Jaar kies jy die jaar waarin (die meeste van) die betrokke groep 
kalwers gebore is. In die Seisoen kolom kies jy die (sub)seisoen waarin die groep kalwers gebore is. Ons 

beveel aan dat dieselfde seisoenkode toegeken word aan kalwers wat maksimum twee maande in 
ouderdom verskil. Indien jou kalwers byvoorbeeld van 1 September tot 30 November aankom, dan 

kies jy seisoen Vroeë Lente vir die kalwers gebore 1 Sept – 15 Okt en seisoen Laat Lente vir die kalwers 

gebore 16 Okt – 30 Nov. In die Plaas/Bestuursgroep kolom word ’n kode (dit moet twee karakters wees) 
ingevul vir die plaas en/of bestuursgroep, byvoorbeeld UA vir die kalwers van die plaas Uitkyk waar die 

koeie op Aangeplante weiding geloop het en UV vir die kalwers van die plaas Uitkyk waar die koeie op 
Veld weiding geloop het. Byvoorbeeld: 

 

Kudde In Gebruik Jaar Seisoen Plaas/Bestuursgroep Naam (Beskrywing) 

ALL √ 2017 Vroeë Lente UA 2017 Vroeë Lente  kalwers van 

Uitkyk op Aangeplante weiding  

ALL √ 2017 Vroeë Lente UV 2017 Vroeë Lente  kalwers van 
Uitkyk op Veld weiding 

ALL √ 2017 Laat Lente UV 2017 Laat Lente  kalwers van 

Uitkyk op Veld weiding 

 

Let wel: Onthou om met elke nuwe kalfseisoen die nodige geboortegewig groepkode opstellings te doen. 
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Wenk: Vir ’n artikel oor die nodigheid en samestelling van kontemporêre groepe vir geboortegewig, kontak 
Mnr. Leslie Bergh by leslie@benguelasoft.co.za of 082 801 2026. 

 

19. Stuur en intrek van elektroniese data: 
Om data aangeteken op RFID Experts se APR500 / APR600 mikroskyfie leser in te trek, sien 

Bylaag C. 
 

19.1 Sinkronisasie van data met BenguFarm MOBILE: 
BenguFarm-MOBILE is ‘n toepassing (“app”) wat beskikbaar is vir Android en Apple iOS 
bedryfstelsels. BenguFarm-MOBILE kan gebruik word om alle belangrike data onmiddelik vas te lê 

terwyl daar met die diere gewerk word. Data wat aangeteken kan word, sluit in nuwe diere 
(registrasie), sinchronisasie van ovulasie, dekkings, dragtigheidsondersoeke, kalwings, gewigte, 

algemene notas, inentings, kamp-/groepverskuiwings, toetse vir siektes, siektes, behandelings, 

inspeksies, diere gesien (“sightings”), mates en punte, prosedures, verkope en vrektes, kamp 
aktiwiteite (bv. voer en lek uitgesit) asook reënval.  

 
Die inligting wat aangeteken is op BenguFarm-MOBILE kan dan gesinchroniseer word met die 

BenguFarm databasis op die PC/skootrekenaar(s). Sinchronisasie van data kan deur middel van Wi-
Fi of Internet (“cloud”) koppeling gedoen word, afhangende van watter metode beskikbaar is en 

watter metode die gebruiker verkies. 

 
Sien die BenguFarm MOBILE handleiding vir instruksies om data tussen BenguFarm MOBILE en 

BenguFarm BEEF te sinkroniseer. 
 

19.2 Stuur en intrek van Logix (of Intergis) data: 
Let wel: Hierdie gedeelte is slegs van toepassing op telers van genootskappe wat deur 
SA Stamboek registreer en/of lid is van Stamboek of die LNR se Nasionale 

Vleisbeesaantekening en -verbeteringskema.  
 

Indien jy lid is van ‘n genootskap wat van die Breedplan stelsel gebruik maak, sien 

Bylaag E of kontak jou BenguFarm BEEF agent of Mnr. Leslie Bergh. 
 

As gevolg van die interafhanklikheid van BenguFarm BEEF en data van diere op Logix (of Intergis), 
sal ons telkens verwys na Logix, die internet toegang (www.logix.org.za) tot die Logix databasis van 

SA Stamboek (of Intergis, die internet toegang (www.intergis.agric.za) tot die LNR/Intergis 
databasis), en hoe Logix inskakel by BenguFarm BEEF. Vir meer inligting oor Logix, kontak Herman 

Labuschagne van SA Stamboek by 051 4100 900. 

 
Met BenguFarm BEEF kan jy elektroniese lêers skep en stuur vir dekkings, embrio inplantings, 

geboortekennisgewings, prestasietoetsdata (Fase A & B gewigte), oordragte en kansellasies  vir 
opname en verwerking op Logix. Daar is verskeie opsies om data na Logix te stuur, maar ons beveel 

aan dat die Logix Direk Lêer Oplaai Funksionaliteit gebruik word. Om dit op te stel, gaan 

na Opstellings > Kuddes > Diensverskaffers. Merk die opsie Gebruik Logix Direk Lêer Oplaai 
Funksionaliteit, vul jou Logix gebruikersnaam, -wagwoord en jou e-posadres in en klik op Stoor. Op 

dieselfde skerm, maak ook seker die korrekte epos adresse is opgestel. (Sien paragraaf 6, Opstellings 
> Kudde Opstellings > Diensverskaffers vir die toepaslike epos adresse). Op dieselfde skerm, kliek 

op die Algemeen skakel bo-aan die skerm en maak seker die Ras en Genootskap / Stamboek 

Lidnommer is ingevul en korrek. Indien só opgestel, sal die Data Stuur funksies wat elektroniese 
lêers skep, Logix Direk (in plaas van jou epos program) gebruik om data te stuur na Logix. 

 
Ontbrekende rekenaarnommers, PEN diere se afdelings, DNA geverifieerde ouerskappe, 

ontbrekende diere, inspeksiedata, amptelike prestasietoetsdata (gekorrigeerde gewigte, indekse, 
ens.) en teelwaardes kan dan baie maklik met die Logix Direk funksies in BenguFarm BEEF ingetrek 

word (óf deur middel van die elektronies lêers wat per e-pos ontvang word) om sodoende jou 

BenguFarm BEEF data op datum te hou met jou kudde se data op die Logix databasis. Ons beveel 
aan dat die Logix Direk funksies in BenguFarm gebruik word (Data Stuur/Trek In> Logix Direk). 

 
Om gebruik te maak van die Logix funksies, moet jy op Logix 'n e-pos adres op rekord 

hê en "Ja" gemerk wees vir Elektroniese Data Opname. [Om dit te kontroleer, gaan na 

www.logix.org.za > Navrae > Deelname > Deelnemer Besonderhede. Indien jy nie ’n Logix gebruiker 

http://www.logix.org.za/
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is nie, kan jy ’n aansoekvorm aan-lyn invul op die Logix tuisblad by www.logix.org.za]. Indien jy nie 

geaktiveer is vir elektroniese data nie, kontak asseblief SA Stamboek by telefoonnommer 051 4100 
900 of stuur ‘n e-pos na help@logix.co.za. 

 

20. Sinchronisasie: (indien van toepassing) 
• Maak seker die toepaslike waardes is opgestel by Opstellings > Kuddes > Dekking, Dragtigheid 

en Kalwing vir # Dae van Insit tot Eerste Spuit; # Dae van Insit tot Tweede Spuit; # Dae van Insit tot 

Uithaal en # Dae van Uithaal tot KI / Lapa. 

• Om ’n lys te skep van alle dekbare verse en koeie, gaan na Verslae > Dekkings, Dragtighede en 
Kalwings > Dekbare Verse en Koeie (aantekenlys). 

• Om sinchronisasies asook die daaropvolgende aksies aan te teken (of verander/verwyder), 

gaan na Reproduksie > Sinchronisasie. Om addisionele/opvolg aksies data aan te teken by bestaande 

rekords, kliek op Laai Bestaande Rekords. 

• Om ’n verslag te skep van sinchronisasies asook die daaropvolgende aksies, gaan na Verslae 
> Dekkings, Dragtighede & Kalwings > Sinchronisasie. Let wel: Aksies wat reeds gedoen is, word in 

normale lettertipe vertoon; aksies wat nog gedoen moet word, word in vetdruk (“bold”) vertoon en 
aksies wat reeds gedoen moes wees, word in rooi vetdruk vertoon. 

• Om sinchronisasiedata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Dek-, en Dragtigheidgeskiedenis opkykskerm (die Vertoon Sinchronisasies opsie regs bo-aan die 
opkyksubskerm moet aangeskakel wees) of gaan op die Kudde Uitleg na die Sinchronisasies afdeling. 

 

21. Dekkings en inteel berekening vir beplande parings: 
Ons beveel aan dat jy natuurlike dekkings en/of kunsmatige inseminasies/laparoskopieë (KIs) in BenguFarm 

BEEF aanteken sodra die bulle by die koeie gesit is en/of die KIs gedoen is. Dit het verskeie voordele, onder 

andere dat lyste om dragtighede op aan te teken uit BenguFarm BEEF gedruk kan word en dat dragtigheid- 
en kalfpersentasies bereken kan word per bul (of bulgroep) en seisoen. Wanneer kalwings in BenguFarm 

BEEF aangeteken word op die Kalwing skerm, word die moontlike of mees waarskynlike vader van die kalf 
dan ook outomaties gekies vanuit die bestaande dekkings vir die betrokke koei. 

 
Stoettelers kan met die opsionele GENETICS module, met behulp van teelwaardes en stambome, 

die beste parings te bepaal volgens teeldoelwitte wat hulle self kan opstel vir hul eie kuddes. Vir meer 

inligting, kontak jou BenguFarm agent of Mnr. Leslie Bergh by leslie@benguelasoft.co.za of 082 801 2026 of 
besoek www.bengufarm.co.za > Products > Genetics. 

 
Vir instruksies om die rekordhouding van embriospoelings of die kolleksie van oösiete en in vitro 

bevrugting en embrio-inplantings te doen, sien Bylaag D. 

 

• Om ’n lys te skep van alle dekbare verse en koeie, gaan na Verslae > Dekkings, Dragtighede en 

Kalwings > Dekbare Verse en Koeie (aantekenlys). Wenk: Kliek Vertoon Werkblad om diere aan groepe 

(bv. kampe of dekgroepe) te koppel. 

• Om ’n lys te skep waarop spesifieke, waargenome dekkings op aangeteken kan word (indien 
van toepassing), gaan na Verslae > Dekkings, Dragtighede en Kalwings > Dekkings (aantekenlys). 

• Om die inteelpersentasies van die nageslag van moontlike parings te bereken, gaan na 

Reproduksie > Inteel Berekening vir Beplande Parings. Nota: Inteelpersentasies in rooi is hoër as die 
waarde opgestel (verstek = 6.25%) vir “Waarsku indien Inteelpersentasie hoër is as” by Opstellings > 

Kuddes > Dekking, Dragtigheid en Kalwings en sulke parings moet liefs vermy word. Gebruik die Hulp 

funksie indien nodig.  

• Wenke: 
o Klik op die Algemene Inteel % knoppie onderaan die skerm vir die inteel persentasies van 

sekere algemene parings. 
o Wanneer die inteelpersentasies van die nageslag van moontlike parings bereken is en daar is 

inteling, gaan na die Stamboom opkykskerm op die Dier Uitleg van die hoofskerm van die 
betrokke ouers om te sien watter dier(e) die gemeenskaplike voorouer is.  

o Dekkings kan direk op hierdie skerm aangeteken word deur die betrokke bul(le) en koei 

kombinasies te kies en onderaan die skerm die dekkings aan te teken vir die gekose kombinasies. 
o Vir ’n artikel oor die gevare van inteling, kontak Mnr. Leslie Bergh by 

leslie@benguelasoft.co.za of 082 801 2026.  
o Om ’n stamboom verslag te skep, gaan na Verslae > Dier, Stamboom en Nageslag > 

Stamboom. Gemeenskaplike voorouers (wat inteling tot gevolg het) word op ‘n rooi 

agtergrond vertoon op die stamboom om hulle maklik te identifiseeer.  
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o Om te sien watter diere verwant is aan ‘n spesifieke dier (bv. ‘n bul), gaan na Verslae 

> Dier, Stamboom en Nageslag > Verwante Diere.  

• Indien geen dekseisoene gebruik word nie, teken die dekkings aan met die Datum Bul(le) In die 
datum waarop die betrokke bul(le) by die betrokke groep koeie gesit is en die Datum Bul(le) Uit die 

verwagte of beplande datum wanneer die betrokke bul of, in die geval van multi-bul dekkings, een of 

meer van die bulle uitgehaal/vervang gaan word. Die Datum Bul(le) Uit van bestaande dekkings kan, 
wanneer nodig, verander word. 

• Voordat dekkings in BenguFarm BEEF aangeteken word: 

o Maak seker dat alle die koeie, verse en teelbulle (ook KI bulle) op rekord is in BenguFarm 
BEEF.  

o Indien semen aangekoop is en rekord gehou word van semenvoorraad, teken die nuwe semen 
aankope aan by Reproduksie > Semenvoorraad. 

o Om te verseker dat jou teelbulle bo-aan die lys van bulle vertoon word op die Natuurlike 

Dekkings en KI/lapa skerms, gaan na die Voeg by en Verander Diere (Enkel Dier Uitleg) skerm, 
soek die bul (onthou om die Onaktiewe dier filter aan skakel in geval van KI bulle) en merk 

("highlight") die bul. Maak ’n regmerkie in die veld "Teel/KI Bul" en Stoor. Dit sal ook tot 
gevolg hê dat die aktiewe teelbulle apart in die kategorie “Teelbulle” gelys word op die 

Diergetalle verslag (Verslae > Dier Lyste en Getalle > Diergetalle). 

o Indien 'n bul in meer as een kudde gebruik word (bv. stoet en kommersieel) wat op 
dieselfde databasis in BenguFarm BEEF is, gaan na Diere > Voeg By en Verander Diere (Enkel 

Dier Uitleg) > Algemene Data en merk die veld Sigbaar vir Reproduksie in Alle Kuddes en Stoor. 
'n Bul wat só gemerk is sal by Dekkings beskikbaar wees in die lys van bulle om te kies as die 

bul en by Kalwings as die vader van 'n kalf. Die bul sal egter nie in die ander kudde gelys word 
as 'n aktiewe dier in die kuddelys nie. 

o Maak seker dat die betrokke kalfseisoen geskep is met die dektydperk. [Verwys die Opstellings 

afdeling om kalfseisoene te skep].  
o Indien diere gekoppel is aan kamp- of bestuursgroepe, onthou om die nuwe teelgroepe se 

diere in BenguFarm te skuif na die betrokke kamp of bestuursgroep in BenguFarm voordat die 
nuwe dekkings in BenguFarm aangeteken word, want dan kan die kamp of bestuursgroep 

gebruik word om die diere te kies vir die aanteken van dekkings. Indien daar ook kalwers in die 

kamp is, merk by Bestaande Groepe ook Geboortedatums en kies die geboortedatums só dat 
die kalwers uitgesluit word. 

• Om dekkings aan te teken (of verander/verwyder), gaan na Reproduksie > Dekkings en kies die 

betrokke dekmetode (bv. Natuurlike Dekking). Gebruik die Hulp funksie indien nodig. 

• Indien KI opgevolg word met natuurlike dekkings (“optel” bulle), teken die KI rekords aan op 
die KI/Lapa skerm en dan die natuurlike dekkings op die Natuurlike Dekkings skerm. 

• Indien koeie/verse op dieselfde dag met meer as een bul ge-KI word, teken ‘n aparte KI rekord 

vir elk van die bulle vir elk van die betrokke koeie/verse aan. 

• Indien multi-bulle dekgroepe gebruik word, kies in die Bul veld die verstek “?MULTISIRE?” rekord 
wat direk onder die teelbulle gelys word.  

o Let wel: Moet NIE self ‘n “Multisire” dier rekord skep NIE, aangesien BenguFarm dit as 'n 

werklike bul sal beskou en dan sal alle diere met "Multisire" as vader verwant wees.  
o Om die bulle in die spesifieke multi-bul groep te kies, merk die Multi Bulle blokkie en kliek dan 

op die “+” om die betrokke bulle te kies.  
o Om te sien watter bulle die moontlke vader van ’n dier is, gaan op die hoofskerm na die 

Dier Uitleg > Geboorte opkykskerm > Dek Bul(le).  

• Indien ’n bul gedurende die dekseisoen nie verder kan dek nie (siek/beseer/dood): 

o Verander die Bul Uit datum op die bestaande dekrekords [Nauurlike Dekkings > Laai Bestaande 
Rekords]; 

o Indien die bul dood is, verwyder die Teel/KI Bul merk by die bul se rekord en teken die vrekte 
aan op die Verkope, Vrektes en Uitskotte skerm; 

o Indien die bul vervang word met ’n ander bul vir die res van die dekseisoen, teken dekrekords 
vir die vervangingsbul aan by Nauurlike Dekkings.  

• Om ’n verslag te skep van bestaande dekkings, gaan na Verslae > Dekkings, Dragtighede & 

Kalwings > Bestaande Dekkings (Deklyste). Sien Bylaag F vir verwagte kalfdatum berekening. 

• Om die laaste dekkingsdata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na 

die Laaste Dekking opkykskerm of op die Kudde Uitleg na die Vorige- en Laaste Dekking afdelings. Let 
wel: Slegs bestaande dekkings, met ander woorde dekkings waarvan die koei nog nie gekalf het nie, 

word hier vertoon. Om alle dekkings- en dragtigheidsdata van ’n dier op die hoofskerm op te kyk, gaan 
op die Dier Uitleg na die Dek- en Dragtigheidsgeskiedenis opkykskerm.  
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22. Stuur dekkings: (Slegs van toepassing op kuddes wat lid is van SA Stamoek se Logix Beef) 
• Nadat die dekkings ingelees is in BenguFarm BEEF (Reproduksie > Dekkings), moet die dekkingsdata na 

SA Stamboek (of LNR) gestuur word om die dekkings en/of KI data op te neem in die Logix (of Intergis) 
databasis. 

• Om dekkingsdata in elektroniese formaat (csv) te stuur na SA Stamboek (of Intergis) (of dit 

te druk indien jy dit nie elektronies kan stuur nie), gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR 

> Dekkings. Kies die betrokke dekkings wat jy wil stuur en kliek op Lys Dekkings volgens Seleksie Kriteria. 

• Kontroleer of daar enige foute is. Indien daar wel Foute voorkom, moet jy dit eers regmaak, aangesien 
BenguFarm BEEF jou NIE sal toelaat om dekkings data te stuur indien daar foute voorkom nie. Om die 

beskrywing van die fout te vertoon, beweeg die rekenaar se wyser oor die kolomopskrif. Gebruik die 
Hulp funksie indien nodig. Let wel: Om multi-bul dekkings te kan instuur, moet die betrokke bulle 

gekies gewees het toe die dekkings aangeteken is. 

• Indien jy seker is dat alle data korrek en volledig is, kliek op Skep Elektroniese Lêer om ’n elektroniese 

lêer van die betrokke dekkingsdata te skep en te stuur. Indien die Gebruik Logix Direk Lêer Oplaai 
Funksionaliteit (sien Opstellings > Kuddes > Diensverskaffers) of die Gebruik SMTP Direkte E-pos opsie 

(sien Opstellings > Kuddes > E-pos) gekies is, sal die elektroniese lêer direk (m.a.w. nie d.m.v. jou e-
pos program nie) gestuur word na Logix. Indien data suksesvol gestuur is, sal ’n boodskap “Data 

suksesvol deur Logix ontvang” vertoon word. Indien nie, sal BenguFarm BEEF die elektroniese lêer 
outomaties aan ’n e-pos boodskap heg en in jou verstek e-pos program (bv. Outlook) se “Outbox” plaas. 

Die e-pos sal dan gestuur word wanneer jy aan-lyn is. 

• Indien BenguFarm BEEF vir een of ander rede nie die elektroniese lêer kan stuur nie, sal ’n boodskap 

verskyn om jou hiervan te waarsku. Let op waar jy die lêer stoor wat aan die e-pos geheg moet word 
(bv. C:\BenguFarm\Beef\Exports\Kudde of C:\Program Files\BenguelaSoft\BenguFarm\Electronic\Send). 

Volg asseblief die instruksies op die waarskuwingboodskap skerm vir hulp om self ’n nuwe e-pos 
boodskap met jou e-pos program (bv. Outlook) te skep, die betrokke lêer aan die e-pos te heg en dit te 

stuur na edata@studbook.co.za (SA Stamboek) of intergis@arc.agric.za (LNR) afhangende wie jou 

diensverskaffer is. Nota: Onthou waar jy die lêer gestoor het om aan te heg aan die e-pos. [Vir hulp 
om probleme met die versending van data op te los, kontak jou BenguFarm agent]. 

• Sodra die data ontvang is, stuur Logix outomaties ’n e-pos boodskap na jou terug as bevestiging van 

ontvangs. Indien jy nie so ’n e-pos ontvang nie, kontak asseblief SA Stamboek by telefoonnommer 051 
410 0900 of stuur ‘n e-pos na help@logix.co.za. 

• Indien jy nie fasiliteite het om die data elektronies te kan stuur nie, kan jy dit druk en faks of per gewone 

pos stuur. Om die dekkings en KI data te druk, kliek op Vertoon Drukstuk > Druk. 

• Om te kontroleer watter dekkings reeds gestuur is, gaan na Verslae > Administrasie > Log van 
Lêers en Verslae Gestuur. 

 

23. Dragtigheidsondersoeke: 
• Voordat jy dragtigheidsondersoek uitslae aanteken, maak seker dat die betrokke dekkings (verwys 

paragraaf 21) en/of embrio inplantings (Bylaag D) reeds aangeteken is in BenguFarm BEEF. 

• Om ’n lys te skep om die dragtigheidsondersoek uitslae op aan te teken, gaan na Verslae > 

Dekkings, Dragtighede & Kalwings > Verse en Koeie vir Dragtigheidsondersoek (aantekenlys). 

• Om dragtigheidsondersoek uitslae aan te teken (of verander/verwyder), gaan na Reproduksie > 
Dragtigheidsondersoeke. Gebruik die Hulp funksie indien nodig. 

• Om ’n verslag te skep van dekkings en dragtighede, gaan na Verslae > Dekkings, Dragtighede & 

Kalwings > Dekkings en Dragtighede. Let wel: Indien die opsie Bestaande Dekkings gekies word, sal 

slegs dek- en dragtigheidsrekords waarvan die verse en koeie nog nie gekalf het nie, gelys word. Indien 
slegs die opsie Dragtig en/of Nie Dragtig (m.a.w. Bestaande Dekkings nie gekies nie) gekies word, sal 

dek- en dragtigheidsrekords van alle betrokke verse en koeie gelys word, ongeag of hulle al gekalf het 
of nog nie gekalf het nie. Sien Bylaag F vir verwagte kalfdatum berekening. Wenk: Kliek Vertoon 

Werkblad om diere aan groepe (bv. dragtig / nie-dragtig groepe) te koppel.  

• Om ’n verslag te skep wat ’n opsomming gee van dekkings en dragtighede per bul en/of 

seisoen, gaan na Verslae > Dekkings, Dragtighede & Kalwings > Dekopsomming per Bul en/of Seisoen. 

• Om die laaste dekking se dragtigheidsdata van ’n dier op die hoofskerm op te kyk, gaan op 
die Dier Uitleg na die Laaste Dekking opkykskerm of op die Kudde Uitleg na die Dragtigheid afdeling. 

Op die Kudde Uitleg word verwagte kalfdatums van koeie wat meer as 14 dae gelede reeds moes gekalf 
het, op ‘n rooi agtergrond vertoon. Om alle dekkings- en dragtigheidsdata van ’n dier op die hoofskerm 

op te kyk, gaan op die Dier Uitleg na die Dek- en Dragtigheidsgeskiedenis opkykskerm. 
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24. Kalwings/kalwers gebore (insluitende aborsies, doodgebore kalwers, ens.): 

• Om ’n verslag te skep van verse en koeie wat naby kalwing is, gaan na Verslae > Dekkings, 

Dragtighede & Kalwings > Verse en Koeie Naby Kalwing (aantekenlys). Sien Bylaag F vir verwagte 
kalfdatum berekening. 

• Voordat jy kalwings aanteken, maak seker dat die betrokke dekkings/embrio inplantings en 

dragtigheidsondersoek uitslae (indien van toepassing) reeds aangeteken is in BenguFarm BEEF (verwys 

paragrawe 21 en 23). Let wel: Die aantekening van dekkings is slegs van toepassing waar teelseisoene 
gebruik word. Sien hieronder hoe om die vader te kies waar geen dekkings aangeteken is nie. 

• Om kalwings (en kalwers) aan te teken (of verander/verwyder), gaan na Reproduksie > Kalwings. 

o Kies die betrokke koei/vers, kies die kalfdatum, kies die vader en voltooi en/of verander die res 
van die besonderhede, waar van toepassing. Gebruik die Hulp funksie indien nodig. 

o Indien die moeder van ‘n kalf onbekend is, kan die kalwing nie op die Kalwingskerm 

aangeteken word nie. Om só ‘n kalf se geboorte aan te teken, gaan na Diere > Voeg By en 
Verander Diere (Enkel Dier Uitleg), kliek “+Voeg By”, voltooi die nodige geboorte-inligting en 

Stoor. Wanneer die moeder later geïdentifiseer word, gaan terug na hierdie skerm, kies die kalf 
uit die dierlys, kies die moeder in Mooeder veld en Stoor.  

o Let wel: 
▪ Die meeste van die velde sal voltooi word met toepaslike data wat verkry word van die 

Opstellings wat jy in BenguFarm BEEF gedoen het (verwys paragraaf 6). Die kalf se geslag, 

geboortegewig en die koei se gewig by kalwing (indien geweeg) moet jy self invul. 
▪ Indien daar ’n dekking(s) vir die betrokke koei aangeteken was wat ’n kalwing op 

die kalfdatum tot gevolg kan hê (volgens die normale dragtigheidsperiode soos opgestel in 
BenguFarm), sal die mees waarskynlike betrokke bul (op grond van die verwagte kalfdatum) 

se nommer outomaties vertoon word as die vader van die kalf. Indien daar twee dekkings 

(bv. KI en natuurlik) gelys word as die moontlike dekkings, is die vader nie seker 
nie omdat die kalfdatum binne die minimum- en maksimum dragtigheidsperiode vir meer as 

een dekking val. BenguFarm sal gevolglik Nuwe Dekking vertoon by Vader (Dekking). Indien 
die lysie van dekkings oopgemaak word, sal bestaande dekkings vir die koei vertoon word. 

Kies Nuwe Dekking. By Dekdata (blou gedeelte van die kalwingskerm), kies ?MULTISIRE? In 
die Bul veld en kies die betrokke moontlike bulle by Addisionele Bulle. Hierdie is tegnies die 

korrekte aantekening van die kalwing en dit sal ook help om te onthou om die korrekte vader 

met DNA te laat bevestig. 
▪ Indien daar “Nuwe Dekking” in die Bul (Dekking) veld verskyn nadat die kalfdatum 

ingevul is, beteken dit dat daar nie ’n dekking op rekord is vir die koei wat ’n kalwing op 
daardie kalfdatum tot gevolg kan hê nie. In hierdie geval moet die bul by die Dekdata aan 

die regterkant van skerm gekies word, in welke geval ’n verstek dekking rekord geskep sal 

word. 
▪ Indien dekkings nie aangeteken is nie (omdat geen dekseisoene gebruik word nie), die 

betrokke diere gekoppel is aan kampe en kamp verskuiwings geskiedenis beskikbaar is, kan 
jy die moontlike vader van 'n kalf bepaal vanaf die kamp verskuiwing geskiedenis. 

Op die Dekdata area van die Kalwing skerm, kliek op die knoppie “Bulle in Dieselfde Kamp 

as Koei by Dekking” verste regs van die Bul veld. Dit bring 'n venster op wat die bul(le) 
vertoon wat in dieselfde kamp as die koei was op die stadium wat die koei dragtig moes 

geword het. Jy kan hierdie bul (of bulle as muli-bulle) kies as die vader.  
▪ Om ‘n kalf se vader te verander wat by geboorte as onbekend [?ONBEKEND?] OF multi-

bul [?MULTISIRE?] OF foutief aangeteken is later te verander, gaan na die Voeg By en 
Verander Diere (enkel dier uitleg) en kies die betrokke kalf. In die Dekking (nie Vader nie) 

veld, kies die korrekte dekking (bul) of Nuwe Dekking uit die lys. ‘n Dek Besonderhede skerm 

sal dan oopmaak (op ‘n ligblou agtergrond). Kies hier die korrekte bul (vader), kliek Stoor 
en Gaan Uit. 

▪ Die verstek kalfseisoen is die kalfseisoen wat gekies is by die aanteken van die betrokke 
dekking wat die kalwing tot gevolg gehad het (indien daar ’n dekking aangeteken was), of 

andersins is dit die kalfseisoen wat as die Huidige Kalfseisoen gekies is by Opstellings > 

Kalfseisoene. 
▪ Indien die verstek volgnommer van die kalf verander moet word, verander dit in die 

Volgnommer veld. 
▪ Aborsies, doodgebore kalwers asook kalwers wat dood is kort na geboorte moet 

ook aangeteken word om die betrokke koeie se dragtigheidstatus te verander en om  hul se 
reproduksierekords volledig te maak. Kies die toepaslike opsie (bv. Dood gebore) in die veld 

Kalf Status (by geboorte). ’n Fiktiewe nommer kan aan sulke kalwers toegeken word, bv. 
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ABC2000D1 (D vir Dood) of ABC209001 (volgnommer buite die normale reeks) vir die eerste 

doodgebore kalf in 202017.  
▪ Indien ‘n dragtige stoet vers/koei aangekoop is en die dekking van die aangekoopte 

vers/koei met die betrokke bul ingestuur is na Logix deur die verkoper van die vers/koei, sal 

die dekking op rekord wees op Logix en sal die dekking saam met die koei se data kan intrek 
kan word in BenguFarm – sien paragraaf 12. In hierdie geval kan die kalwing direk aanteken 

word in BenguFarm – die vader sal outomaties gekies word via die dekrekord. Indien die 
betrokke dekking NIE op rekord is op Logix nie, moet die koper die dekbesonderhede by die 

verkoper kry. Dan moet die betrokke bul se data eers vanaf Logix aflaai en intrek word (as 
onaktiewe dier) in BenguFarm. Daarna moet die dekking in BenguFarm aanteken word en 

dan kan die kalwing aanteken word. 

▪ Om koeie wat wat tydens dragtigheidsondersoek as dragtig aangeteken is maar 
toe nie gekalf het nie, se dragtigheidstatus reg te stel, gaan na die 

Dragtigheidsondersoeke skerm, kliek op Laai Bestaande Ondersoeke, kies die betrokke 
koeie, verwyder die regmerkie in die Dragtig kolom, verander die Periode na 0 (nul) en Stoor. 
As jy seker is of vermoed dat die koei geresorbeer of geaborteer het, teken dit op die 

Kalwingskerm aan met die toepaslike Geboorte Status. 
▪ Om‘ ’n tweeling aan te teken, maak seker dat jy in die veld # Kalwers (Geboorte Status), 

Tweeling kies. BenguFarm BEEF sal dan aan die bokant van die grys gedeelte van die skerm 
(kalf inligting), outomaties twee knoppies met kalfnommers skep. Kliek op die eerste kalf se 

nommer en voltooi die kalf se besonderhede. Kliek dan op die ander kalf se nommer en doen 
dieselfde. 

▪ Stoettelers met SA Stamboek (Logix) as diensverskaffer: 

• Om te verseker dat geboortes van kalwers wat gebore is uit 'n dekking deur 'n leenbul 

aanvaar gaan word op Logix, moet die eienaar van die bul vir Stamboek laat weet aan 
wie en vir watter tydperk die bul geleen word. 

• Om te verseker dat geboortes van kalwers wat gebore is uit 'n dekking deur 'n bul met 

mede-eienaars aanvaar gaan word op Logix, moet die mede-eienaars van die bul vir 
Stamboek laat weet wie almal mede-eienaars is. 

▪ Om aan te teken dat ’n kalf deur ’n pleegmoeder of hans grootgemaak word, gaan op die 

Kalwing skerm na die veld Pleegmoeder (heel onder links). Dit kan ook aangeteken word 
deur te gaan na Diere > Voeg By en Verander Diere (enkel dier uitleg) > Algemeen > 

Pleegmoeder. In die lys is daar ook ’n HANSHOKKE opsie wat gebruik kan word vir kalwers 
wat hans grootgemaak word. Op die hoofskerm se Dier Uitleg kan op die Nageslag subskerm 

gesien word watter kalwers van ’n koei deur ’n pleegmoeder grootgemaak is. Op die kalf se 
rekord op die Geboorte subskerm kan gesien word watter koei die kalf se pleegmoeder is. 

Op die hoofskerm se Kudde Uitleg kan pleegmoeder opgekyk word in die Geboorte afdeling. 

▪ Om bestaande kalwing/geboortedata te verander, gaan na die Kalwing skerm, kies 
die betrokke koei, kliek op die “N” langs haar nommer en kies die kalwing wat jy wil verander. 

▪ Om ‘n bestaande kalwing/kalf te verwyder, gaan na Diere > Voeg By en Verander 
Diere (Enkel Dier Uitleg). Kies die betrokke kalf en kliek Verwyder. 

▪ Om ‘n mikroskyfienommer (EID) wat op een dier gebruik was aan ‘n nuwe dier 

toe te ken, sien die instruksies in paragraaf 57. 
▪ Indien jy die rassamestelling (bv. 50% Bonsmara, 25% Angus, 25% Nguni) van die kalf 

wil aanteken, kliek op die ikoon “Stel die rassamestelling van hierdie kalf op” (regs van die 
Ras veld). Kliek op die “+”, kies die eerste ras en vul die % in. Kliek weer op die “+”, kies 

die tweede ras en vul die % in, ens. Kliek Aanvaar. Indien die rassamestelling van die ouers 

reeds aangeteken is, kan jy op die “Bereken outomaties vanaf Vader en Moeder” ikoon regs 
bo-aan die skermpie kliek om die rassamestelling van die kalf outomaties te bereken. Nota: 

Wanneer ’n nuwe dierrekord geskep word, word die rassamestelling outomaties voltooi vanaf 
die ras, bv. indien die ras Bonsmara is, sal die rassamestelling 100% Bonsmara wees. Die 

rassamestelling van ’n dier kan ook aangeteken of verander word deur te gaan na Diere > 
Voeg By en Verander Diere (Enkel Dier Uitleg) > Diverse Data > Rassamestelling. Die 

rassamestelling van ’n dier kan gedruk word op die My Verslae. [Verslae > My Verslae > 

Dierdata > Verslag Kolomme (Uitleg) > Algemeen > Rassamestelling]. 

• Om ’n verslag te skep van verse en koeie wat reeds gekalf het/nog nie gekalf het nie, gaan 
na Verslae > Dekkings, Dragtighede & Kalwings > Verse en Koeie Gekalf/Nog nie Gekalf (aantekenlys). 

Sien die notas by Verslag Interpretasie vir watter diere gelys word vir die verskillende senarios. 

• Om ’n verslag te skep wat ’n opsomming gee van dekkings, dragtighede en kalwings per bul 
en/of seisoen, gaan na Verslae > Dekkings, Dragtighede & Kalwings > Dekopsomming per Bul en/of 

Seisoen. 
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• Om ’n verslag te skep van kalwers gebore in ’n sekere tydperk (bv. kalfseisoen of jaar), gaan 
na Verslae > Dekkings, Dragtighede & Kalwings > Geboortes. Wenk: Onthou om ook die onaktiewe 

filter te kies om kalwers wat as aborsies, doodgebore, dood tydens/kort na geboorte aangeteken is in te 
sluit. Dit is belangrik om die korrekte opsomming te kry van die persentasie kalwers wat lewendig gebore, 

doodgebore, ens. is. 

• Om die geboortedata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Geboorte opkykskerm of op die Kudde Uitleg na die Geboorte afdeling.  

• Om die reproduksiedata van ’n koei op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Reproduksie en Nageslagemid. opkykskerm of op die Kudde Uitleg na die Reproduksie afdeling. 

• Die verskillende reproduksie verwerkings in BenguFarm BEEF word verduidelik in Bylaag F. 

 

25. Stuur geboortekennisgewings: (Slegs van toepassing op kuddes wat lid is van SA Stamoek 

se Logix Beef) 
• Nadat die kalwings/geboortes ingelees is in BenguFarm BEEF (Reproduksie > Kalwings), moet die 

kalwings/geboortedata na SA Stamboek (of LNR) gestuur word om die kalwers op te neem in die Logix 
(of Intergis) databasis. [Let wel: Telersgenootskappe hef boetes op geboortekennisgewings wat nie 

betyds ingedien word nie]. 

• Om nuwe geboortes elektronies te stuur na SA Stamboek (of Intergis) (of dit te druk indien jy 
dit nie elektronies kan stuur nie), gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR > 

Geboortekennisgewings. Kliek op Lys Geboortes Nog Nie Gestuur Nie.  

• Om geboortes wat reeds gestuur was weer te stuur (bv. nadat sekere korreksies aan die 
geboortedata aangebring is in BenguFarm), gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR > 

Geboortekennisgewings. Verwyder die regmerkie by Sluit Diere met Rekenaarnommers Uit opsie links 

bo-aan die skerm. Kliek op Kies Diere en kies die betrokke kalf. Onder Opsies, merk Dier Opdatering (O) 
in plaas van Geboortekennisgewing (G). Gebruik die Hulp funksie indien nodig. 

• Kontroleer of die Opsies korrek is vir al die betrokke diere. Kontroleer ook of daar enige 

Foute/Ontbrekende Data of Waarskuwings is. Deur die rekenaar se wyser oor die toepaslike 
kolomopskrif te beweeg, sal dit die besonderhede van die fout/ontbrekende data of waarskuwing wys. 

Indien daar foute en/of ontbrekende data is, sal BenguFarm BEEF jou NIE toelaat om die betrokke 

geboortekennisgewings te stuur nie. Die Waarskuwings is net om jou bewus te maak van moontlike 
foute of probleme, maar jy kan die betrokke geboortes stuur ten spyte van die waarskuwings. Om ’n 

verslag met die detail van foute en/of ontbrekende data te druk, kliek op Druk Foutverslag. Om foute 
en/of ontbrekende data reg te stel, kliek langs die dier op die drie kolletjies in die “i” kolom om die Voeg 

By en Verander Diere skerm oop te maak. 

• Indien jy seker is dat alle data korrek en volledig is, kliek op Skep Elektroniese Lêer om ’n elektroniese 

lêer van die gekose kalwers se geboortekennisgewings te skep en te stuur. Indien die Gebruik Logix 
Direk Lêer Oplaai Funksionaliteit (sien Opstellings > Kuddes > Diensverskaffers) of die Gebruik SMTP 

Direkte E-pos opsie (sien Opstellings > Kuddes > E-pos) gekies is, sal die elektroniese lêer direk (m.a.w. 
nie d.m.v. jou e-pos program nie) gestuur word na Logix. Indien data suksesvol gestuur is, sal ’n 

boodskap “Data suksesvol deur Logix ontvang” vertoon word. Indien nie, sal BenguFarm BEEF die 
elektroniese lêer outomaties aan ’n e-pos boodskap heg en in jou verstek e-pos program (bv. Outlook) 

se “Outbox” plaas. Die e-pos sal dan gestuur word wanneer jy aan lyn is. 

• Indien BenguFarm BEEF vir een of ander rede nie die elektroniese lêer outomaties kan stuur nie, sal ’n 

boodskap verskyn om jou hiervan te waarsku. Let op waar jy die lêer stoor wat aan die e-pos geheg 
moet word (bv. C:\BenguFarm\Beef\Exports\Kudde of C:\Program Files\BenguelaSoft\BenguFarm\ 

Electronic\Send). Volg die instuksies op die waarskuwingboodskap skerm vir hulp om self ’n nuwe e-pos 
boodskap met jou e-pos program (bv. Outlook) te skep, die betrokke lêer aan die e-pos te heg en dit te 

stuur na edata@studbook.co.za (Stamboek). Nota: Onthou waar jy die lêer gestoor het om aan te heg 

aan die e-pos. [Vir hulp om probleme met die versending van data op te los, kontak jou BenguFarm 
agent]. 

• Sodra die data ontvang is, stuur Logix outomaties ’n e-pos boodskap na jou terug as bevestiging van 

ontvangs. Indien jy nie so ’n e-pos ontvang nie, kontak asseblief SA Stamboek by telefoonnommer 051 
410 0900 of stuur ‘n e-pos na help@logix.co.za. 

• Indien jy nie fasiliteite het om die data elektronies te kan stuur nie, kan jy dit druk en faks of per gewone 

pos stuur. Om die geboortekennisgewings te druk, kliek op Vertoon Drukstuk > Druk. 

• Om te kontroleer watter geboortekennisgewings reeds gestuur is, gaan na Verslae > 
Administrasie > Log van Lêers en Verslae Gestuur. Let wel: Sodra die elektroniese lêer geskep is, log 

BenguFarm die betrokke lêer as gestuur. Indien die data nie direk of via jou e-pos gestuur kon word 

nie, sal dit dus steeds as gestuur gelog wees, aangesien die lêer wel geskep is. Die beste bewys dat die 
geboortekennisgewings ontvang is deur Logix, is die ontvangserkenning e-pos wat jy behoort te ontvang 

het vanaf Logix.    
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26. Intrek van rekenaarnommers: (Slegs van toepassing op kuddes wat lid is van SA Stamoek 

se Logix Beef) 
• Sodra die betrokke geboortekennisgewings opgeneem en verwerk is op Logix (of Intergis), stuur Logix 

weer outomaties ’n e-pos boodskap na jou as bevestiging van opname/verwerking. Aangeheg aan hierdie 

e-pos is ‘n elektroniese lêer (BIRTHS_...) wat jy benodig om die rekenaarnommers in te trek in 
BenguFarm BEEF. 

• Nota: Indien jy om een of ander rede nie die e-pos ontvang het nie, kan jy die betrokke elektroniese 

lêer bekom deur na die Logix webwerf (www.logix.org.za) te gaan en aan die linkerkant van die skerm 
te kliek op Boodskappe. Die elektroniese lêers wat na jou gestuur is, word daar gestoor volgens die 

datum van opname/verwerking.  

• Om ontbrekende rekenaarnommers in te trek in BenguFarm BEEF, is daar twee opsies: 

o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 
diensverskaffer): 

▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Logix Direk > Trek Ontbrekende 
Rekenaarnommers In. ’n Opsie om die PEN (pending) diere se afdeling te opdateer is ook 

beskikbaar. 

o Opsie 2: 
▪ Stoor die elektroniese lêer wat jy van Logix ontvang het op ’n gepaste plek op jou rekenaar 

(bv. C:\BenguFarm\Beef\Imports\... – sien Opstellings > Kuddes > Verstek Gidse vir Lêers). 
Dit kan in Outlook gedoen word deur te kliek op File > Save Attachment of andersins deur 

regs te kliek op die lêer en Save Target As te kies. Let op waar jy die lêer stoor. [Let wel: 
Moet NIE hierdie lêer in Excel oopmaak en stoor in xls of csv formaat NIE, aangesien dit sal 

veroorsaak dat jy dit nie sal kan intrek in BenguFarm BEEF nie en/of dat die datums foutief 

ingetrek word]. 
▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Trek In > Stamboek/LNR > 

Dierrekenaarnommers. Soek die betrokke elektroniese lêer (BIRTHS...) en kliek op Trek In. 
Gebruik die Hulp funksie indien nodig. Let wel: BenguFarm BEEF gebruik die dier se KKM, 

Jaar, Volgnommer, Geslag en Ras om die betrokke dier in die BIRTHS... lêer te koppel aan die 

dier in die BenguFarm BEEF databasis. Diere met “ONBEKEND” in die “Betrokke Dier in  
BenguFarm BEEF” kolom se rekenaarnommer sal NIE ingetrek word nie. Om ’n onbekende 

dier per hand te koppel aan die regte dier in BenguFarm BEEF, kliek op die “ONBEKEND” en 
kies die betrokke dier uit die lys. 

• Om ’n verslag te skep van diere sonder rekenaarnommers, gaan na Verslae > Administrasie > 

Diere sonder Rekenaarnommers.  
 

27. Ouerskapbepalings en ander DNA dienste: (nie van toepassing op kommersiële kuddes 

nie) 
• Ouerskappe moet bepaal word deur middel van DNA analises in onder andere die volgende gevalle indien 

jy die kalwers wil registreer: 

o Indien meerbul parings gedoen word. (Maak seker by jou telersgenootskap wat die vereistes is 

vir registrasie van kalwers uit meerbulparings); 
o Indien KI binne 28 dae na laaste KI datum opgevolg is deur natuurlike paring of ’n ander bul; 

o Alle kalwers gebore uit embrio oorplasings. 

• Om ’n DNA diensaanvraagvorm te druk wat saam met die betrokke diere se biologiese monsters 
na die DNA laboratorium gestuur moet word, gaan in BenguFarm BEEF na Data Stuur/Trek In > Stuur 

> DNA Profieleringdienste Vorms en kies die betrokke laboratorium wat jy gebruik. Gebruik die Hulp 

funksie indien nodig. 
Let wel: 

o Maak seker dat die rekenaarnommers van die diere wat DNA geanaliseer moet word in 
BenguFarm aangeteken is voordat die DNA diensaanvraagvorm geskep word. 

o Indien jy wil rekord hou van watter diere se DNA wanneer gestuur is vir ontleding, merk regs 
onderaan die skerm “Ja, hou rekord van onderstaande DNA monsters gestuur”. 

o Om seker te maak die kliënt se besonderhede word volledig voltooi op die diensaanvraagvorm, 

maak seker alle tersaaklike velde (Eienaar, Plaasnaam, Maak Fakture uit Aan, BTW No en 
Posadres) is voltooi by Opstellings > Kuddes > Algemeen. 

• Om etikette te druk vir die merk van die koeverte waarin biologiese monsters (bv. sterthare) 

van diere geplaas word vir instuur na ‘n biobank (bv. by SA Stamboek) of ‘n DNA laboratorium, gaan 
na Data Stuur/Trek In > Stuur > DNA Profieleringdienste Vorms > Druk Biologiese Monster Etikette. 

• Om ’n verslag te skep van DNA monsters wat gestuur is vir ontleding, gaan na Verslae > 

Administrasie > Log van DNA Monsters Gestuur. Indien ’n dier se DNA Nommer nie op die verslag 
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verskyn nie, dui dit aan dat die betrokke dier se uitslae nog nie ontvang is nie en/of nog nie in BenguFarm 

ingetrek/aangeteken is nie. 

• Om DNA geverifieerde ouerskappe en die meegaande DNA verwysingsnommers in te trek 
wanneer die DNA verslag deur SA Stamboek vanaf die DNA laboratorium ontvang en op Logix gelaai is, 

gaan na Data Stuur/Trek In > Logix Direk > Trek DNA Ouerskappe In. Let wel: Hierdie funksie sal 

outomaties ook die betrokke diere se ouers en die afdeling van PEN (pending) diere in BenguFarm BEEF 
opdateer volgens die ouerskap uitslae. Waar van toepassing, sal dit ook outomaties die ouer(s) sertifiseer 

as korrek. Gesertifiseerde ouers sal met die DNA ikoon aangetoon word op die hoofskerm in die 
Stamboom opkykskerm, die Stamboom verslag en in die My Verslae. 

• Alternatiewelik kan jy, wanneer jy die DNA verslag ontvang het van die DNA laboratorium, die betrokke 

diere se DNA nommers en korrekte ouerskappe per hand aanteken deur te gaan na Diere > Verander 
Diere (Tabel Uitleg). Gebruik die Hulp funksie indien nodig. 

• Om die DNA nommer van ‘n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Algemeen opkykskerm en rol af tot by DNA nommer of gaan op die Dier Uitleg na die Identifikasie 

afdeling. 

• Om ouerskappe te sertifiseer op grond van DNA ouerskap uitslae, gaan na Diere > DNA 
Geverifieerde Ouerskappe. Let wel: Die DNA nommers moet ingevul wees voordat die sertifisering veld 

gekliek kan word. Jy moet ook die sertifiseringsverklaring aan die onderkant van die skerm kliek voordat 
die data gestoor kan word. Gesertifiseerde ouers sal met die DNA ikoon aangetoon word op die 

hoofskerm in die Stamboom opkykskerm, die Stamboom verslag en in die My Verslae. 

• Op die Voeg by en Verander Diere skerm [Diere > Voeg by en Verander Diere] word die ouers op 

dieselfde manier as gesertifiseer aangedui. As die ouers hier verander word, verval die sertifisering en 
moet die sertifisering vir die nuut gekose ouers weer op die sertifiseringskerm ingevoer word. 

• Om ‘n verslag te skep wat aandui watter diere se ouers gesertifiseer is in BenguFarm, gaan 

na Verslae > My Verslae > Dierdata. Kliek op Kies Diere (Kriteria) om die diere te kies. Kliek dan op 
Verslag Kolomme (Uitleg). Onder die Algemeem afdeling, kies Vader DNA Geverifieer en Moeder DNA 

Geverifieer. Kliek Besigtig Verslag om te sien hoe die verslag gaan lyk. 

• Wenk: Stoor die dier se DNA sertifikaat as ‘n dokument in BenguFarm – sien paragraaf 72. 

• Om genomiese resultate in te trek of aan te teken (of verander/verwyder), sien paragraaf 53. 
 

28. Inentings, doserings, dip en aanvullings: 

• Om entstowwe, doseer-/dipmiddels en aanvullings voorraad aan te teken, sien paragraaf 64. 

• Om 'n lys van diere in 'n spesifieke kamp te kry wat nie geënt is nie, gaan na Verslae > Siektes, 

Voorkoming en Behandeling > Inentings, Doserings, Dip en Aanvullings. Kies aan die linkerkant die 
kritreria van die inentings wat gedoen is, bv. tussen twee datums. Aan die regterkant kies die betrokke 

kamp. Merk dan die opsie "Nie Ingeent, Dosering of Aanvulling Ontvang nie". 

• Om ’n lys te skep waarop inentings, doserings, dip en aanvullings aangeteken kan word, 

gaan na Verslae > Siektes, Voorkoming en Behandeling > Inentings, Doserings, Dip, Aanvullings en 
Prosedures (aantekenlys). By Kies Items om te Druk, kies die inentings/doserings/dip/aanvullings wat jy 

wil aanteken en voeg dit met die pyltjie wat regs wys by tot die Items wat Gedruk sal Word. Wenk: Om 
die dosis (soos opgestel by Gesondheid > Entstowwe, Doseer-/Dipmiddels en Aanvullings Voorraad) te 

druk, merk die opsie Druk Ent/Doseermiddel Dosis. 

• Om inentings, doserings, dip en aanvullings aan te teken (of verander/verwyder), gaan na 
Gesondheid > Inentings, Doserings, Dip en Aanvullings. Gebruik die Hulp funksie indien nodig. 

• Wenk: Inligting soos verstek dosis, ontrekkingsperiode en vervaldatum van entstowwe, doseer-

/dipmiddels en aanvullings kan aangeteken word op die voorraad register [Gesondheid > Entstowwe, 

Doseer-/Dipmiddels en Aanvullings Voorraad]. Wanneer Inentings, Doserings, Dip, Aanvullings 
aangeteken word, sal die koste per dier outomaties bereken word vanaf die Enstowwe, Doseermiddels 

en Aanvullings Voorraad, mits die besending nommer ingevul word. Indien 'n besendingnommer nie 
ingevul word nie, sal die laaste aankope se eenheidsprys (totale prys / # eenhede) gebruik word. 

• Om ’n verslag te skep van inentings, doserings, dip en aanvullings gedoen, gaan na Verslae > 

Siektes, Voorkoming en Behandeling > Inentings, Doserings, Dip en Aanvullings. Wenk: Kliek Vertoon 

Werkblad om diere aan groepe (bv. geënt / nie geënt groepe) te koppel. 

• Om die inentingsdata, ens. van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na 
die Inentings, Doserings en Siekte Toetse opkykskerm. Om dit op die Kudde Uitleg te vertoon, gaan op 

die hoofskerm se Kudde Uitleg na Vertoon Opsies > kliek op die Stel My Kolomme om te Vertoon Op 
(ikoon heel bo). 

• Wenk: Dit word aanbeveel om, waar nodig, die verstek lys van entstowwe, doseer-/dipmiddels en 

aanvullings uit te brei met die spesifieke middels wat jy gebruik. Dit kan gedoen word deur te gaan na 
Opstellings > Entstowwe, Doseer-/Dipmiddels en Aanvullings. Entstowwe, doseer-/dipmiddels en 
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aanvullings in die verstek lys wat nie van toepassing is op jou kudde nie, kan afgeskakel word deur die 

regmerkies in die In Gebruik en Toestel (bv. APR500 / APR600) kolomme te verwyder. 
 

29. Gewigte: 
• Om ’n lys te skep waarop diere se gewigte aangeteken kan word tydens weging, gaan na 

Verslae > Gewigte, Matesetings, Prestasietoetsing & Teelwaardes > Weeglys (aantekenlys). Wenke: 
o Indien koeie geweeg word tydens speen van hul kalwers, merk by Druk Opsies beide 

Skep Kolom vir Moedergewig en Sorteer Moeders Apart opsies. ‘n Ekstra kolom waar 
die koeie in numeriese volgorde gesorteer is sal bygevoeg word op die weeglys. Deur hierdie 

kolom te gebruik, kan die koeie maklik en vinnig op die weeglys gevind word. (Indien die 

koeinommers nie apart gesorteer is nie, is dit moeilik om ‘n koei se nommer op die weeglys te 
kry, want ‘n koei en haar kalf kom nie noodwendig saam in die drukgang nie). Jy kan dus op die 

weeglys sien wie is ‘n kalf se moeder, maar jy vul die koeie se gewigte in waar die koeie gesorteer 
is, m.a.w. in die Koei IDno veld. ‘n Betrokke kalf se ma se gewig gaan dus nie in dieselfde lyn 

staan as die kalf nie. Wanneer die gewigte vanaf die weeglys in BenguFarm ingelees word, teken 
eers al die kalfgewigte aan. Kliek dan op die kolomopskrif “Moeder”. Die rekords op die skerm 

sal nou in dieselfde volgorde gesorteeer wees as in die Koei IDno veld op die weeglys. Die 

koeigewigte kan nou vining en maklik in volgorde ingelees word. 
o Om die huidige gewig te vergelyk met die vorige gewig, kies Laaste Gewig en Laaste 

Weegdatum by Sluit Kolomme In.   

• BenguFarm maak voorsiening vir die intrek van gewigte van enige elektroniese skaal wat die funksie het 
om die aangetekende gewigte en diere se ID-nommers op die skaal te kan stoor en ’n elektroniese lêer 

van die gewigte en diere-ID-nommers te kan skep. Raadpleeg asseblief jou skaalvervaardiger of agent 

indien jy nie seker is of jou spesifieke skaalmodel hierdie kenmerke het nie. 

• Om gewigte vanaf ’n skaal in te trek in BenguFarm BEEF, moet jy by die skaal ’n lêer (in csv formaat) 
skep met die betrokke diere se nommers en gewigte. Om hierdie gewigte in te trek, gaan  na Data 

Stuur/Trek In > Trek In > Gewigte vanaf Skaal. Gebruik die Hulp funksie indien nodig. 
Wenk: Om die verstek skaal lêer formaat te kies vir jou spesifieke skaal, gaan na Opstellings > Kuddes 

> Ander > Verstek Elektroniese Skaal Lêer Formaat. 

• Sekere skale maak voorsiening daarvoor om dierdata (bv. nommer, geboortedatum en geslag) te kan 
intrek in die skaalsagteware. Om so ’n lêer met dierdata in BenguFarm te skep vir intrek in die 

skaalsagteware, gaan na Data Stuur/Trek In > Stuur > Dierdata na Skaal. 

• Om data in te trek of data te stuur na ’n Tru-Test XR5000 skaal, gaan na Data Stuur/Trek In > 

Tru-Test XR5000 Integrasie. Gebruik die Hulp funksie vir stap-vir-stap instruksies. Sien ook instruksies 
in paragraaf 10. Let wel: Die XR5000 se drywers en sagteware moet vooraf op die rekenaar geïnstalleer 

wees. 

• Twee tipes gewigte kan in BenguFarm BEEF aangeteken word: 
 

Gewigte vir prestasietoetsing: 
• Sekere gewigte (voorspeen, speen, 12-maande en 18-maande gewigte) kan in BenguFarm verwerk word 

om aangepaste gewigte, GDOs (Gemiddelde groei per Dag van Ouderdom) en prestasie-indekse te 
verkry. Hierdie prestasie-indeks berekenings is bedoel vir seleksie doeleindes, aangesien dit gekorrigeer 

is vir die ouderdom van die dier, die ouderdom van die moeder, ens. – sien Bylaag F. LET WEL: Die 
verwerking van gewigte vir prestasie-indekse is van toepassing op beide stoet en 

kommersiële kuddes. Die berekenings in BenguFarm is dieselfde as dié wat deur SA Stamboek op 

Logix gedoen word. Die BenguFarm-berekende data word afsonderlik gestoor van die Logix-berekende 
data wat, vir stoetkuddes, ingetrek kan word. Wanneer vertoon word op die hoofskerm se Kudde Uitleg 

en in verslae, word voorkeur gegee aan Logix-berekende indekse en word dit in vet (“bold”) vertoon. 
BenguFarm berekende indekse word gewoon vertoon. 

• Diere moet aan die volgende vereistes voldoen om in dieselfde prestasietoets ingesluit te word: 

o Die ouderdomsverskil tussen die oudste en jongste dier mag nie meer as 100 dae wees nie. 
o Alle diere se ouderdom op weegdatum moet binne die grense wees vir die betrokke toetstipe: 

▪ Voorspeen (A11): 51 - 150 dae 

▪ Speen (A22): 151 - 270 dae 
▪ 12-maande (B12): 271 - 450 dae 

▪ 18-maande (B22): 451 - 634 dae 
▪ Sentrale Groeitoetse (C12, C22, C32): 179-278 dae by begin van toets 

▪ Op-die-Plaas Groeitoetse (D11, D21): 172-455 dae by begin van toets 
o Indien die diere nie almal op dieselfde dag geweeg is nie, mag die eerste en laaste weegdatums 

nie meer as 14 dae uit mekaar wees nie.  
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o Die diere moet op weegdatum nog aktief in die betrokke kudde (op BenguFarm en Logix, waar 

van toepassing) wees, met ander woorde nie gekanselleer of oorgedra nie. 

• Wanneer kalwers se geboortedata op die Kalwingskerm aangeteken word, sal BenguFarm, indien die 
veld Voeg By Tot Prestasietoetsgroep gemerk is, outomaties die kalwers aan ’n 

prestasietoetsgroep binne die betrokke kalfseisoen koppel volgens die minimum- en maksimum 

toelaatbare ouderdomsgrense asook die maksimum toelaatbare ouderdomsverskil (soos opgestel by 
Opstellings > Kuddes > Prestasietoetsing > Maksimum Toelaatbare Ouderdomsverskil...). Alle kalwers 

gebore in die eerste 100 dae van die seisoen sal aan die eerste prestasietoetsgroep (bv. Groep 2020S-
0) gekoppel word en, indien die kalfseisoen langer is as 100 dae, die res aan die volgende 

prestasietoetsgroep (bv. 2020S-1). Die doel met prestasietoetsgroepe is dat dit gebruik kan word om ’n 
groep diere te kies vir evaluasie in ’n prestasietoets. Verwys Bylaag F vir 'n verduideliking van die 

belangrikheid van kontemporêre groepe wanneer diere gekies word vir insluiting in 'n prestasietoets. 

• Indien verse vroeër gedek word, sal die volle kalfseisoen (eerstekalfkoeie plus die res van die koeie) 

waarskynlik langer as 100 dae wees en gaan die kalwers outomaties in twee prestasietoetsgroepe 
ingedeel word soos hierbo verduidelik. Indien verkies word dat die eerstekalfkoeie se kalwers in een 

prestasietoetsgroep ingedeel word en die res van die koeie se kalwers in ’n tweede groep, kan die 
kalwers se prestasietoetsgroep indelings verander word – sien volgende item. 

• Indien nodig, kan die prestasietoetsgroep indelings verander word. Gaan na Prestasietoetsing > 

Prestasietoetsgroep Indelings. Gebruik die Hulp funksie indien nodig. 

• Indien kalwers aan ’n prestasietoetsgroep gekoppel is op die Kalwingskerm en die Kalwing skerm 

toegemaak word, verskyn 'n “Herbreken Outomatiese Dagboekinskrywings” skermpie. Indien “Bereken” 
gekliek word, sal BenguFarm die datums bereken wanneer die betrokke groep kalwers geweeg 

moet word vir die onderskeie prestasietoetsgewigte. Wanneer die betrokke groep kalwers 
geweeg moet word vir ’n sekere prestasietoetsgewig (bv. Speengewig), sal ‘n herinneraar in die dagboek 

vertoon [Ander Data > Dagboek en Bestuurskalender]. 

• Indien die prestasietoets weegdatums vir een of ander rede nie bereken is nie nie, kan dit vir ’n betrokke 
kalfseisoen of groep kalwers bereken word deur te gaan na Prestasietoetsing > Bereken Geldige 

Weeg-/Toetsdatums. Gebruik die Hulp funksie indien nodig. 

• Om gewigte vir prestasietoets doeleindes aan te teken (of verander/verwyder) of in te trek en 

te verwerk, gaan na Prestasietoetsing > Gewigte vir Prestasietoetsing. Gewigte wat nie gekoppel is 
aan 'n toets nie (algemene gewigte) wat reeds op BenguFarm is (bv. ingetrek vanaf die skaal), word 

outomaties in die toets vertoon mits die weegdatum ooreenstem. Gebruik die Hulp funksie indien nodig. 

• Om ’n verslag te skep van diere se prestasietoetsresultate (gekorrigeerde gewigte, indekse, 
ens.), gaan na Verslae > Gewigte, Mates, Prestasietoetsing & Teelwaardes > Prestasietoetsresultate. 

Sien Bylaag F vir die interpretasie en gebruik van verwerkte prestasietoetsdata. Let wel: Indien die 

amptelike prestasietoetsdata reeds ingetrek is (sien paragraaf 31), sal die amptelike data op die verslag 
vertoon word in vet druk. 

• Om die gewigte van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die Gewigte 

opkykskerm of op die Kudde Uitleg na die Gewigte afdeling. 

• Om die prestasietoetsresultate van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg 
na die Prestasietoetsresultate opkykskerm of op die Kudde Uitleg na die Gewig Indekse afdeling. Let 

wel: Vetgedrukte prestasie-indekse op die hoofskerm > Kudde Uitleg asook op sekere verslae, bv. die 
Inspeksielys en Veilingskatalogus, is indekse wat vanaf Logix ingetrek is. Indekse wat nie vetgedruk is 

nie, is in BenguFarm bereken, met ander woorde die Logix-berekende indekse is nie beskikbaar nie of 

dit is nog nie ingetrek in BenguFarm nie. 

• Wenke:  
o Vir ’n artikel met riglyne oor bestuur- en prestasietoetspraktyke vir akkurate teelwaardes, kontak 

Mnr. Leslie Bergh by leslie@benguelasoft.co.za of 082 801 2026. 
o Die verskillende reproduksie- en prestasiedata verwerkings in BenguFarm BEEF word 

verduidelik in Bylaag F.  

 

Algemene- en voerkraal gewigte: 
• Om algemene gewigte (byvoorbeeld maandelikse gewigte), wat nie noodwendig vir 

prestasietoetsdoeleindes gebruik gaan word nie, aan te teken (of verander/verwyder), gaan na 
Prestasietoetsing > Gewigte, Mates en Punte nie aan ‘n Toets gekoppel nie > Gewigte. Gebruik die Hulp 

funksie indien nodig. 

• Om alle data waarvan in ’n voerkraal rekord gehou word op een skerm aan te teken (of 

verander/verwyder), gaan na Toevoegings > Voerkraal Bestuurder. Gebruik die Hulp funksie vir stap-
vir-stap instruksies. 

• Om die gewigte van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die Gewigte 

opkykskerm of op die Kudde Uitleg na die Gewigte afdeling.  
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• Om ’n verslag te skep van diere se gewigte en toenames, kliek op Gewigte en Toenames links 
onderaan die Gewigte, Mates en Punte nie aan ‘n Toets gekoppel nie skerm OF gaan na Verslae > 

Gewigte, Metings, Prestasietoetsing & Teelwaardes > Gewigte en Toenames. Wenke: 
o Indien die opsie Druk slegs Eerste en Laaste Gewigte in Tydperk gekies word, is ’n opsie Vertoon 

Werksblad beskikbaar wat gebruik kan word om diere aan ’n groep te koppel, bv. diere wat 

swaar genoeg is vir bemarking. 
o Kliek Vertoon Werkblad om diere aan groepe (bv. gewiggroepe) te koppel. 

 

30. Stuur prestasietoetsdata (gewigte): (Slegs van toepassing op kuddes wat lid is van SA 

Stamoek se Logix Beef) 
• Nadat die toets geskep en die gewigte aangeteken/opgeneem is in BenguFarm BEEF [Prestasietoetsing 

> Gewigte vir Prestasietoetsing], moet hierdie data na Stamboek/LNR gestuur word om die diere se 
prestasietoetsdata op te neem in die Logix databasis. 

• Om prestasietoetsdata in elektroniese (csv) formaat te stuur na Stamboek (of dit te druk 

indien jy dit nie elektronies kan stuur nie), gaan na Prestasietoetsing > Gewigte vir Prestasietoetsing. 
Kies die betrokke toets en kliek op die Laai Geselekteerde Toets ikoon. Alternatiewelik gaan na Data 

Stuur/Trek In > Stuur > Stamboek/LNR > Prestasietoetsdata. Kies die betrokke toets uit die lys van 

Beskikbare Toetse. Gebruik die Hulp funksie indien nodig. 

• Kontroleer of daar enige foute is – sien die kolomme aan die linkerkant van die skerm. Om die 
beskrywing van ’n fout te vertoon, beweeg die rekenaar se wyser oor die kolomopskrif. BenguFarm BEEF 

sal jou NIE toelaat om prestasietoetsdata te stuur indien daar foute en/of onbrekende data is nie. 

• Indien jy seker is dat alle data korrek en volledig is, kliek op Skep en Stuur Elektroniese Lêer van 
Data aan Diensverskaffer / Skep Elektroniese Lêer (ikoon met rooi en blou pyltjies onderaan die 

skerm) om ’n elektroniese lêer van die gekose prestasietoets te skep en te stuur. Indien die Gebruik 
Logix Direk Lêer Oplaai Funksionaliteit (sien Opstellings > Kuddes > Diensverskaffers) of die Gebruik 

SMTP Direkte E-pos opsie (sien Opstellings > Kuddes > E-pos) gekies is, sal die elektroniese lêer direk 

(m.a.w. nie d.m.v. jou e-pos program nie) gestuur word na Logix. Indien data suksesvol gestuur is, sal 
’n boodskap “Data suksesvol deur Logix ontvang” vertoon word. Indien nie, sal BenguFarm BEEF die 

elektroniese lêer outomaties aan ’n e-pos boodskap heg en in jou verstek e-pos program (bv. Outlook) 
se “Outbox” plaas. Die e-pos sal dan gestuur word wanneer jy aan lyn is. 

• Indien BenguFarm BEEF vir een of ander rede nie die elektroniese lêer outomaties kan stuur nie, sal ’n 

boodskap verskyn om jou hiervan te waarsku. Let op waar jy die lêer stoor wat aan die e-pos geheg 

moet word (bv. C:\BenguFarm\Beef\Exports\Kudde of C:\Program Files\BenguelaSoft\BenguFarm\ 

• Electronic\Send). Volg die instruksies op die boodskap skerm vir hulp om self ’n nuwe e-pos boodskap 
met jou e-pos program (bv. Outlook) te skep, die betrokke lêer aan die e-pos te heg en dit te stuur na 

edata@studbook.co.za (Stamboek) of intergis@arc.agric.za (LNR), afhangende wie jou diensverskaffer 
is. Nota: Onthou waar jy die lêer gestoor het om aan te heg aan die e-pos. [Vir hulp om probleme met 

die versending van data op te los, kontak jou BenguFarm agent]. 

• Sodra die data ontvang is, stuur Logix outomaties ’n e-pos boodskap na jou terug as bevestiging van 
ontvangs. Indien jy nie so ’n e-pos ontvang nie, kontak asseblief SA Stamboek by telefoon nommer 051 

410 0900 of stuur ‘n e-pos na help@logix.co.za. 

• Indien jy nie fasiliteite het om die data elektronies te kan stuur nie, kan jy dit druk en faks of per gewone 

pos stuur. Om prestasietoetsdata te druk, kliek op Vertoon Drukstuk > Druk. 

• Om te kontroleer watter prestasietoetse reeds gestuur is, gaan na Verslae > Administrasie > 
Log van Lêers en Verslae Gestuur. 

 

31. Intrek van amptelike prestasietoetsdata: (Slegs van toepassing op kuddes wat lid is 

 van SA Stamboek se Logix Beef) 
• Sodra die betrokke prestasietoetsdata opgeneem en verwerk is op Logix, stuur Logix weer outomaties 

’n e-pos boodskap na jou as bevestiging van opname/verwerking. Aangeheg aan hierdie e-pos boodskap 
is ‘n elektroniese lêer (BEEF_TEST_...) wat jy benodig om die amptelike prestasietoetsdata in te trek in 

BenguFarm BEEF. 

• Nota: Indien jy om een of ander rede nie die e-pos ontvang het nie, kan jy die betrokke elektroniese 
lêer bekom deur na die Logix webwerf (www.logix.org.za) te gaan en aan die linkerkant van die skerm 

te kliek op Boodskappe. Die elektroniese lêers wat na jou gestuur is, word daar gestoor volgens die 

datum van opname/verwerking. Andersins kan jy in Logix gaan na Dienste > Data Onttrekking > 
Vleisbees > Bees Prestasie Data.  

• Om amptelike prestasietoetsdata in te trek in BenguFarm BEEF, is daar twee opsies: 

o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as diensverskaffer): 
▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Logix Direk > Trek Amptelike 

Prestasietoetsdata In.  
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o Opsie 2: 

▪ Stoor die elektroniese lêer wat jy van Logix ontvang het op ’n gepaste plek op jou rekenaar (bv. 
C:\BenguFarm\Beef\Imports\Kudde). Dit kan in Outlook gedoen word deur te kliek op File > 

Save Attachment of andersins deur regs te kliek op die lêer en Save Target As te kies. Let op 

waar jy die lêer stoor. [Let wel: Moet NIE hierdie lêer in Excel oopmaak en stoor in xls of csv 
formaat NIE, aangesien dit sal veroorsaak dat jy dit nie sal kan intrek in BenguFarm BEEF nie 

en/of dat die datums foutief ingetrek word]. 
▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Trek In > Stamboek/LNR > Amptelike 

Prestasietoetsdata. Soek die betrokke elektroniese lêer (BEEF_TEST_...) en kliek op Trek In. 

• Let wel: Die prestasietoetsindekse wat jy in BenguFarm BEEF verwerk het, word NIE oorskryf nie – dit 
word apart gestoor van die amptelike indekse. By Opstellings > Kuddes > Ander kan jy stel of jy beide 

die amptelike en nie-amptelike prestasietoetsdata wil sien op die hoofskerm se Dier Uitleg > 

Prestasietoetsdata vertoon skerm. Kies (merk) dit, indien nie reeds gedoen nie. Op die hoofskerm se 
Kudde Uitleg > Gewig Indekse word BenguFarm verwerkte indekse in gewone en amptelike indekse in 

vet (“bold”) vertoon. 

• Wenk: Om ’n verslag te skep van diere sonder amptelike prestasietoetsresultate, gaan na 
Verslae > Administrasie > Diere sonder Amptelike Prestasietoetsresultate. 

 

32. Intrek van teelwaardes (met kudde- en rasgemiddeldes): (Slegs van toepassing op 

stoetkuddes wat lid is van SA Stamboek se Logix Beef) 
• Wenk: Vir ’n artikel oor hoe om teelwaardes te verstaan en gebruik, kontak Mnr. Leslie Bergh by 

leslie@benguelasoft.co.za of 082 801 2026. 

• Indien jy lid is van Stamboek, moet jy verseker dat jou BenguFarm BEEF databasis opgedateer word 
met jou diere se nuutste teelwaardes elke keer wanneer ’n nuwe BLUP ontleding vir jou betrokke ras 

gedoen is. Om te kyk watter ontledingsdatum se teelwaardes jy in BenguFarm het, kies een van jou 

koeie en kyk op die Dier Uitleg van die hoofskerm bo-aan die Teelwaardes opkykskerm by Datum. 

• Wenk: By Opstellings > Kuddes > Herinneraars > Herinner om Nuutste Teelwaardes af te Laai, kan 
gestel word dat BenguFarm jou met sekere tussenposes herinner om nuwe teelwaardes in te trek.  

• Om jou diere se nuutste teelwaardes asook jou kudde- en die ras se nuwe gemiddelde 

teelwaardes in te trek in BenguFarm BEEF, is daar twee opsies: 
o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 

diensverskaffer): 

▪ Gaan in BenguFarm BEEF na Data Stuur / Trek In > Logix Direk > Trek Teelwaardes In. 
BenguFarm sal jou nou inlog op Logix, die nuutste teelwaardes vir die diere in die betrokke 

kudde soek, ’n lêer skep en dit in BenguFarm BEEF ingetrek sonder dat enige verdere aksie 
nodig is. Die nuutste teelwaardes (uitgesluit die kudde- en rasgemiddeldes) en teelwaarde 

indekse word ingetrek.  
▪ Indien jy ‘n “time-out” boodskap van Logix kry, volg die instruksies op die skerm of Opsie 2 

hieronder om die nuutste teelwaardes af te laai en in te trek. 

o Opsie 2: 
▪ Gaan in Logix na Teelwaardes > Teelwaardes met EBV Indekse. 

▪ U het nou die keuse om die data af te laai via een van twee formate, naamlik ’n csv of zip 
formaat lêer. Die zip formaat lêer is kleiner en sal dus vinniger aflaai. Kliek regs op die 

lêerformaat van jou keuse en kies Save Target As. Beide die csv en zip formate kan direk 

ingetrek word. 
▪ Stoor die betrokke elektroniese lêer (BEEFBLUP_...) op ’n gepaste plek op jou rekenaar (bv. 

C:\BenguFarm\Beef\Imports\Kudde). Dit kan gedoen word deur regs te kliek op die lêer en 
Save Target As te kies. Let asseblief op waar jy die lêer stoor. 

▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Trek In > Stamboek/LNR > Teelwaardes, 
soek die betrokke elektroniese lêer (BEEFBLUP_...), kies die kudde en kliek op Trek In. Gebruik 

die Hulp funksie indien nodig. Die nuutste teelwaardes, kudde- en rasgemiddeldes en 

teelwaarde indekse word ingetrek. 

• Om ’n verslag van teelwaardes te skep, gaan na Verslae > Gewigte, Mates, Prestasietoetsing & 
Teelwaardes > Teelwaardes. Die verslag het ’n opsie om teelwaarde-indekse in plaas van teelwaardes 

te druk. 

• Om ’n stamboom verslag (met teelwaardes) te skep, gaan na Verslae > Dier, Stamboom en 
Nageslag > Stamboom. 

• Om die teelwaardes van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Teelwaardes- of die Teelwaardes Grafiek opkykskerm of op die Kudde Uitleg na die Teelwaardes 

afdeling. 
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33. Seleksie en Inspeksie/keuring: 
Seleksie: 
• Om ’n verslag te skep van diere se prestasietoetsresultate (gekorrigeerde gewigte, indekse, 

ens.), gaan na Verslae > Gewigte, Mates, Prestasietoetsing & Teelwaardes > Prestasietoetsresultate. 

• Om ’n verslag te skep van koeie wat swak presteer ten opsigte van self-gekose reproduksie 
en -dragtigheid minimum standaarde, gaan na Verslae > Inspeksies en Seleksies > Reproduksie 

en Dragtigheid Seleksie. Waardes wat nie voldoen aan die minimum kriteria nie, word in die verslag in 
vet gedruk en omraam. 

• Om ’n verslag te skep van diere wat swak presteer volgens self-gekose reproduksie-, 

produksie-, retensie- en teelwaardes minimum standaarde, gaan na Verslae > Inspeksies en 
Seleksies > Teelkuddeseleksie. Waardes wat nie voldoen aan die minimum kriteria nie, word in die 

verslag in vet gedruk en omraam. Sien Bylaag F vir die interpretasie en gebruik van berekende waardes 

in BenguFarm. Let op dat retensie- en teelwaardes slegs beskikbaar is vir geregistreerde diere. 

• Om ’n nageslagopsomming van ’n koei of bul te skep, gaan na Verslae > Dier, Stamboom en 
Nageslag > Nageslagopsomming. 

• Om sekere data van diere te verlig “highlight” (bv. koeie met ’n gemiddelde tussenkalfperiode van 

meer as 400 dae) op die hoofskerm se Kudde Uitleg asook om rangwaardes op te stel vir die gekose 
kriteria (die totale rangwaarde sal vertoon word onder die Algemeen afdeling in die Rang kolom), kliek 

op Vertoon Opsies onderaan die hoofskerm se Kudde Uitleg en kliek dan bo-aan die Vertoon Opsies 

skerm op die Stel Kuddeuitleg Verligting Op knoppie (knoppie met klein blokkies met verskillende kleure). 
Gebruik die Hulp funksie indien nodig. Sien paragraaf 5 vir hoe om ’n verslag te skep met gekose 

kolomme van die hoofskerm se Kudde Uitleg. 
 

Inspeksie/keuring: (nie van toepassing op kommersiële kuddes nie) 
• Om ’n lys van diere wat geïnspekteer/gekeur gaan word te skep waarop die inspeksiedata 

aangeteken kan word, gaan na Verslae > Inspeksies & Seleksies > Inspeksielyste (aantekenlys). Alle 

amptelike prestasietoetsindekse, teelwaardes, ensovoorts wat op rekord is op BenguFarm BEEF, sal op 

die inspeksielys gedruk word vir gebruik deur die keurder. Let wel: Vetgedrukte prestasie-indekse is 
indekse wat vanaf Logix ingetrek is. Indekse wat nie vetgedruk is nie, is in BenguFarm bereken. 

• Let wel: Inspeksielyste moet deur die keurder onderteken word en dit sal deur hom gestuur word na 

jou telersgenootskap of SA Stamboek vir opname op Logix. Inspeksielyste mag dus nie direk deur jou 
as teler ingestuur word nie. 

 

34. Intrek van inspeksiedata: (nie van toepassing op kommersiële kuddes nie) 
• Sodra die betrokke inspeksiedata opgeneem en verwerk is op Logix, stuur Logix  outomaties ’n e-pos 

boodskap na jou as bevestiging van opname/verwerking. Aangeheg aan hierdie e-pos is ‘n elektroniese 

lêer (INSPECTIONS_...) wat jy benodig om die inspeksiedata in te trek in BenguFarm BEEF.  

• Nota: Indien jy om een of ander rede nie die e-pos ontvang het nie, kan jy die betrokke elektroniese 
lêer bekom deur na die Logix webwerf (www.logix.org.za) te gaan en aan die linkerkant van die skerm 

te kliek op Boodskappe. Die elektroniese lêers wat na jou gestuur is, word daar gestoor volgens die 

datum van opname/verwerking.  

• Om die inspeksiedata in BenguFarm BEEF in te trek, is daar twee opsies: 
o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 

diensverskaffer):  
▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Logix Direk > Trek Inspeksie Data In. 

Let wel:  

o Hierdie funksie sal die volgende data intrek: Inspeksie datum, visuele punt (indien van 
toepassing), goed/afgekeur, afkeurrede(s), afdeling en subafdeling (indien van 

toepassing).  
o Indien die opsie Verander Status van Aktiewe Afgekeurde Diere na Onaktief onder-

aan die skerm gemerk is, word die afgekeurde diere wat nog aktief in BenguFarm is, 
se status onaktief gemaak. 

o Opsie 2: 

▪ Stoor die elektroniese lêer wat jy van Logix ontvang het op ’n gepaste plek op jou rekenaar 
(bv. C:\BenguFarm\Beef\Imports\Kudde). Dit kan in Outlook gedoen word deur te kliek op 

File > Save Attachment of andersins deur regs te kliek op die lêer en Save Target As te kies. 
Let op waar jy die lêer stoor. [Let wel: Moet NIE hierdie lêer in Excel oopmaak en stoor in 

xls of csv formaat NIE, aangesien dit sal veroorsaak dat jy dit nie sal kan intrek in BenguFarm 

BEEF nie en/of dat die datums foutief ingetrek word]. 
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▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Trek In > Stamboek/LNR > Inspeksies. 

Soek die betrokke elektroniese lêer (INSPECTIONS_...) en kliek op Trek In. Gebruik die Hulp 
funksie indien nodig. 

• Alternatiewelik kan die inspeksiedata aangeteken (of verander/verwyder) word deur te gaan na Ander 

Data > Inspeksies. Gebruik die Hulp funksie indien nodig. 

• Om afgekeurde diere te skuif na ’n ander (bv. kommersiële) kudde, sien paragraaf 37. 

• Om die inspeksiedata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Algemeen opkykskerm en rol af tot by die inspeksiedata velde of gaan op die Kudde Uitleg na die 

Keuring afdeling. 

• Om ’n verslag te skep van diere wat gekeur is, gaan op die hoofskerm se Kudde Uitleg na die 

Keuring afdeling, kies die betrokke diere wat gekeur (of goedgekeur) is en kliek Vertoon in My Verslae. 
Kliek Verslag Kolomme (Uitleg), kliek langs die Algemeen afdeling op die “+”, gaan die Inspeksie 

subafdeling en kies die betrokke velde wat jy wil insluit in die verslag. 
 

35. Verkope, vrektes en uitskotte: 
• Om ’n verslag te skep met die belangrikste inligting van ’n dier(e) op een verslag, gaan na 

Verslae > Dier, Stamboom en Nageslag > Dieropsomming. Hierdie verslag kan gebruik word vir om na 
voornemende kopers te stuur vir bemarkingsdoeleindes. 

• Om ’n veilingskatologus te skep (wat ook gebruik kan word vir uit-die-hand verkope), gaan Verslae 

> Aankope, Veilings, Verkope, Vrektes en Uitskotte > Veilingskatalogus. 

• Om ’n Veeverwydering Sertifikaat te druk, gaan na Verslae > Aankope, Veilings, Verkope, Vrektes 
en Uitskotte > Veeverwydering Sertifikaat. 

• Wanneer diere verkoop word, vrek, gesteel is of vir ander redes uit die kudde is, moet dit in BenguFarm 

BEEF aangeteken word om sodoende jou kuddelys op datum te hou. Let wel: Moet NIE diere wat die 

kudde verlaat het (onaktiewe diere) se dierrekords verwyder uit BenguFarm-BEEF nie, aangesien hulle 
op een of ander manier verbind mag wees aan ander diere in die databasis. Indien ‘n dier verwyder 

word is die verwante dier(e) se stamboom of nageslag nie meer volledig nie. 

• Om ’n lys te skep waarop diere se gewigte aangeteken kan word tydens verkoop, gaan na 
Verslae > Gewigte, Mates, Prestasietoetsing & Teelwaardes > Weeglys (aantekenlys). 

• Om ’n lys te skep waarop diere se verkoop-/dooddata aangeteken kan word, gaan na Verslae 

> Dierlyste en Getalle > Kuddelys. Heel regs is kolomme om die datum en rede waarom diere uit die 

kudde is op aan te teken. 

• Om die verkoopinligting (aan wie verkoop, verkoopdatum, rede vir verkoop, gewig, prys, ensovoorts) 
van verkoopde diere of die uit-kudde data van diere wat vir ander redes (byvoobeeld gevrek, 

gesteel, ensovoorts) uit die kudde is aan te teken (of verander/verwyder), gaan na Ander Data > 
Verkope, Vrektes en Uitskotte. Gebruik die Hulp funksie indien nodig. 

• Let wel:  

o Wanneer diere die kudde verlaat het (verkoop, dood, gesteel), word hulle NIE outomaties uit 
die kamp en/of groep(e) uitgehaal nie. Indien jy wel die diere uit die kamp en/of groep(e) wil 

haal waarin hul was toe hulle die kudde verlaat het, kan dit gedoen word, maar dit is nie nodig 

nie, aangesien jy normaalweg net met die aktiewe diere in ’n kamp of groep werk. 
o Indien ’n teelbul verkoop of dood is, onthou om die Teel/KI Bul merk te verwyder by die bul se 

rekord. [Diere > Voeg By en Verwyder Diere > Agemeen > Teel/KI Bul]. 

• Indien die koper ook ‘n BenguFarm gebruiker is, kan jy vir die koper die betrokke diere se 
data elektronies stuur wat hy dan in sy BenguFarm kan intrek. Om hierdie elektroniese lêer met 

die data van die verkoopte diere te skep, gaan na Data Stuur/Trek In > Stuur > BenguFarm 

Dieroordraglêer. Let wel: Die volgende data word nie ingesluit in die Dieroordraglêer nie: 
o Kampe en Groepe 

o Inentings, Doserings, Siekte Toetse, Siektes en Behandelings 
o Prosedures 

o Aankope en Verkope 
o Fotos en Dokumente. 

• Indien diere met ‘n elektroniese nommer (EID skyfie) gemerk is, kan die EID verwyder word wanneer 

die dier verkoop word of doodgaan en weer gebruik word vir ‘n ander dier. Indien verkope en vrektes 

direk in BenguFarm of op die APR500 / APR600 EID leser of op die BenguFarm MOBILE toepassing 
aangeteken word, word die betrokke EID nommers outomaties verwyder wanneer die betrokke data 

ingetrek word. Voordat EIDs hergebruik word, is dit krities belangrik dat die Vee Uit en Dateer 
Leser Data Op stap gedoen word by Data Stuur/Trek In > Trek In > RFID Experts APR500/600 Leser 

om te verseker die EID word met hergebruik aan die nuwe dier se rekord gekoppel. Om 

mikroskyfienommers (EIDs) te verwyder/ontkoppel van diere wat verkoop of dood (d.w.s. 
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onaktief) is, sien paragraaf 56. Om die EID nommer van een dier aan ‘n nuwe dier toe te ken, 

sien paragraaf 57. 

• Om ’n verslag te skep van diere wat wat verkoop is of vir ander redes uit die kudde is, gaan 
na Verslae > Aankope, Veilings, Verkope, Vrektes en Uitskotte >  Verkope, Vrektes en Uitskotte. 

• Om ’n verslag te skep van die diere wat gedurende ’n sekere tydperk  tot die kudde toegevoeg 

is (kalwers gebore, diere aangekoop, geskuif vanaf ’n ander kudde) en die kudde verlaat het 
(verkoop, dood, geskuif na ’n ander kudde, ens.), gaan na Verslae > Dier Lyste en Getalle > Diergetalle 

Rekonsiliasie. Vir hierdie verslag om die korrekte getalle te weerspieël en alle betrokke waardes te 

vertoon, is dit nodig dat: 
o Die Diergetalle en –Waardes gereeld bereken en gestoor word: 

o Alle toepaslike data soos diere gebore, aangekoop, geskuif vanaf ’n ander kudde, verkoop, dood 
en geskuif na ’n ander kudde aangeteken word met, waar van toepassing, die aankoooprys, 

verkoopprys en verlies waarde moet aangeteken wees. 

• Om die verkoopdata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Algemeen opkykskerm en rol af tot by die verkoopdata velde of gaan op die Kudde Uitleg na die Verkope 
en Vrektes afdeling. Wenk: Onthou om die Onaktief filter aan te skakel om die dier te sien in die lys 

van diere. 

• Om ’n dier wat verkeerdelik as verkoop of dood aangeteken is, weer te herstel, gaan na Diere 
> Voeg By en Verander Diere (Enkel Dier Uitleg). Skakel die Onaktiewe filter aan en kies die betrokke 

dier. Op die Algemene Data skerm, verander die Status na Aktief. Op die Diverse Data skerm, verwyder 

die Gekanselleer rekord en Stoor. Op dieselfde skerm, kliek op Verander Gedetaileerde Oordrag / 
Kansellasie Rekord. Die Verkope, Vrektes en Uitskotte skerm sal nou oopmaak en die betrokke dier se 

rekord sal outomaties gelaai word. Kies die rekord en kliek Verwyder en Stoor. Wenk: Indien dit ’n 
registreerde dier is, onthou om by jou diensverskaffer (bv. SA Stamboek) aan te vra dat die dier 

heringestel word. 

• Wenk: Om ’n verslag te skep van alle aktiwiteite aangeteken in BenguFarm gedurende ’n 
gekose tydperk, gaan na Verslae > Administrasie > Log van Aktiwiteite Aangeteken.  

 

36. Stuur oordragte en kansellasies: (Slegs van toepassing op kuddes wat lid is van SA 

Stamboek se Logix Beef) 
• Nadat die verkope en/of vrektes in BenguFarm BEEF aangeteken is (Ander Data > Verkope, Vrektes en 

Uitskotte), moet hierdie data na SA Stamboek gestuur word om die diere oor te dra op die nuwe eienaar 

se naam en/of hulle af te haal van jou kudde se inventaris op Logix. Let wel: Om ‘n oordag na Logix te 
stuur, moet die koper gekies word uit die BenguFarm Kontakte lys en moet die kontak, behalwe vir die 

Besigheid naam, ook die Stamboek lidnommer OF ‘n adres in hê om te verseker dat die dier na die 
korrekte nuwe eienaar oorgedra word. 

• Om oordrag- en/of kansellasiekennisgewings elektronies te stuur na SA Stamboek/LNR (of 

dit te druk indien jy dit nie elektronies kan stuur nie) direk van die Verkope, Vrektes en Uitskotte skerm, 
kliek links onderaan die skerm op Skep en Stuur Elektroniese Lêer van Data aan Diensverskaffer ikoon. 

Indien die rekords nie reeds op die skerm is nie, kliek eers op Laai Bestaande Rekords en kies die rekords 

wat gestuur moet word. Alternatiewelik gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR > 
Oordragte en Kansellasies. Kliek op Lys Oordragte en Kansellasies Wat Nog Nie Gestuur Is Nie. Indien 

jy reeds die betrokke oordragte en/of kansellasies gestuur het of dit gedruk het en dit vir watter rede 
ook al weer wil stuur, kliek op Kies Diere. Gebruik die Hulp funksie indien nodig. 

• Kontroleer of die Opsies korrek is vir al die betrokke diere. Kontroleer ook of daar enige Foute is. Om 

die beskrywing van ‘n fout te vertoon, gaan met die rekenaar se wyser oor die kolomopskrif. Indien wel, 

maak ’n nota van die betrokke dier(e) en die probleem. Om dit reg te stel, kliek op die drie kolletjies in 
die “$” kolom. Let wel: Indien diere verkoop is en en die Verkoop (Oordrag) veld gemerk is, moet die 

koper se adres en/of Stamboek lidnommer (bv. 0678678BON) ingevul word op die koper se kontak. Om 
dit in te vul of verander, kliek op die drie kolletjies in die Kontakte kolom. 

• Indien jy seker is dat alle data korrek en volledig is, kliek op Skep en Stuur Elektroniese Lêer van 

Data aan Diensverskaffer / Skep Elektroniese Lêer (ikoon met rooi en blou pyltjies onderaan die 
skerm) om ’n elektroniese lêer(s) van die gekose oordragte en/of kansellasies te skep en te stuur. Indien 

die Gebruik Logix Direk Lêer Oplaai Funksionaliteit (sien Opstellings > Kuddes > Diensverskaffers) of die 

Gebruik SMTP Direkte E-pos opsie (sien Opstellings > Kuddes > E-pos) gekies is, sal die elektroniese 
lêer direk (m.a.w. nie d.m.v. jou e-pos program nie) gestuur word na Logix. Indien data suksesvol 

gestuur is, sal ’n boodskap “Data suksesvol deur Logix ontvang” vertoon word. Indien nie, sal BenguFarm 
BEEF die elektroniese lêer outomaties aan ’n e-pos boodskap heg en in jou verstek e-pos program (bv. 

Outlook) se “Outbox” plaas. Die e-pos sal dan gestuur word wanneer jy aan lyn is. 

• Indien BenguFarm BEEF vir een of ander rede nie die elektroniese lêer outomaties kan stuur nie, sal ’n 

boodskap verskyn om jou hiervan te waarsku. Let op waar jy die lêer stoor wat aan die e-pos geheg 
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moet word (bv. C:\BenguFarm\Beef\Exports\Kudde of C:\Program Files\BenguelaSoft\BenguFarm\ 

Electronic\Send). Volg die instuksies op die waarskuwingboodskap skerm vir hulp om self ’n nuwe e-pos 
boodskap met jou e-pos program (bv. Outlook) te skep, die betrokke lêer(s) aan die e-pos te heg en dit 

te stuur na edata@studbook.co.za (Stamboek) of intergis@arc.agric.za (LNR), afhangende wie jou 

diensverskaffer is. Nota: Onthou waar jy die lêer gestoor het om aan te heg aan die e-pos. [Vir hulp 
om probleme met die versending van data op te los, kontak jou BenguFarm agent]. LET WEL: 

Oordragte en kansellasies word in twee aparte lêers gestoor. Onthou om albei te stuur. 

• Sodra die data ontvang is, stuur Logix outomaties ’n e-pos boodskap na jou terug as bevestiging van 
ontvangs. Indien jy nie so ’n e-pos ontvang nie, kontak asseblief SA Stamboek by telefoonnommer 051 

410 0900 of stuur ‘n e-pos na help@logix.co.za. 

• Indien jy nie fasiliteite het om die data elektronies te kan stuur nie, kan jy dit druk en faks of per gewone 
pos stuur. Om die kansellasies te druk, kliek op Vertoon Kansellasies Drukstuk > Druk. Om oordragte te 

druk, kliek op Vertoon Oordragte Drukstuk > Druk. 

• Om te kontroleer watter kansellasies en oordragte reeds gestuur is, gaan na Verslae > 

Administrasie > Log van Lêers en Verslae Gestuur. 
 

37. Verskuif diere na ’n ander kudde: 
• Om ’n nuwe kudde te skep, sien paragraaf 7. 

• Hoe jy die diere in BenguFarm van een kudde na ‘n ander kudde (byvoorbeeld van ‘n stoet- na ‘n 
kommersiële kudde) skuif, hang daarvan af of die twee kuddes op een databasis of op verskillende 

databasisse is. Wenk: Om te kyk of die onderskeie kuddes op dieselfde databasis is, gaan na Lêer 

> Verander Aktiewe Kudde Na > Lys Alle en Selekteer.  

• Indien die twee kuddes op dieselfde databasis is, kan jy die diere bloot skuif van die een 
kudde na die ander. Gaan in die kudde waaruit jy die diere wil skuif na Ander Data > Verskuif Diere 

na Ander Kudde. Merk die betrokke diere in die “K” kolom en kies dan bo-aan die skerm die kudde 
waarheen die diere geskuif moet word, vul die datum in, kies die rede en Stoor. Gebruik die Hulp 

funksie indien nodig. Let wel: Onthou om, waar van toepassing, die betrokke diere se afdeling (bv. 

SP na Comm), kamp en/of bestuursgroep te verander. Wenk: Indien ’n geregistreerde dier 
gekanselleer en na die kommersiële kudde geskuif moet word, teken eers die kansellasie aan 

by Ander Data > Verkope, Vrektes en Uitskotte, maar moet nie die status verander na (die verstek) 
Onaktief nie, m.a.w. hou die status Aktief. Stuur die kansellasie na die diensverskaffer (bv. 

Stamboek). Skuif dan die (aktiewe) dier na die kommersiële kudde. 

• Om ’n verslag te skep van diere se verskuiwings tussen kuddes op dieselfde databasis, 
gaan na Verslae > Kampe en Kuddes > Kudde Verskuiwings. 

• Om die kuddeverskuiwings data van ‘n dier op die hoofskerm op te kyk, gaan op die Dier 

Uitleg na die Algemeen opkykskerm en rol af tot by die Kudde inligting. 

• Om ’n verslag te skep van die diere wat gedurende ’n sekere tydperk tot die kudde 

toegevoeg is (diere gebore, aangekoop, geskuif vanaf ’n ander kudde) en die kudde verlaat het 
(verkoop, dood, geskuif na ’n ander kudde), gaan na Verslae > Dier Lyste en Getalle > Diergetalle 

Rekonsiliasie. Vir hierdie verslag om die korrekte getalle te weerspieël en alle betrokke waardes te 
vertoon, is dit nodig dat: 

o Die Diergetalle en –Waardes gereeld bereken en gestoor word: 

o Alle toepaslike data soos diere gebore, aangekoop, geskuif vanaf ’n ander kudde, verkoop, 
dood en geskuif na ’n ander kudde aangeteken word met, waar van toepassing, die 

aankoooprys, verkoopprys en verlies. 

• Indien die twee kuddes op ‘n aparte databasisse is, moet jy die diere oordra d.m.v. ‘n 
Dieroordraglêer. Gaan in die kudde waaruit jy die diere wil skuif na Data Stuur/Trek In > Stuur > 

BenguFarm Dieroordraglêer, kies die betrokke diere, kies die oordrag opsies en skep die 
Dieroordraglêer. Let op waar die lêer gestoor word. Om die Dieroordraglêer in die ander kudde (op 

’n ander databasis) in te trek, gaan in die kudde waarheen jy die diere wil skuif na Data Stuur/Trek 

In > Trek In > Databasis > BenguFarm Dieroordraglêer. Soek die lêer waar dit gestoor is en kliek 
op Trek In. Gebruik die Hulp funksie indien nodig. 

 
Wenk: Om diere tussen kampe of ander groepe te skuif, gaan na Ander data > Verskuif Diere na ‘n 

ander Kamp of Groep. Gebruik die Hulp funksie indien nodig. 

 

38. Vergelyk BenguFarm BEEF kuddelys met Logix/Intergis kuddelys: (Slegs van 

toepassing op kuddes wat lid is van SA Stamoek se Logix Beef) 
• Om te kontroleer of jou BenguFarm BEEF kuddelys ooreenstem met jou Logix/Intergis 

kuddelys (indien van toepassing en indien jy geregistreer is as Logix Gebruiker), gaan as volg te werk: 
[Gebruik die Hulp funksie indien nodig]. 
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o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 

diensverskaffer): 
▪ Gaan in BenguFarm BEEF na Data Stuur/Trek In > Logix Direk > Vergelyk BenguFarm BEEF 

en Logix Kuddes Lyste.  

▪ Verskille tussen die twee BenguFarm BEEF en Logix kuddelyste (aktiewe diere) word as volg 
aangedui: 

• By elke veld word die BenguFarm BEEF data in die eerste kolom vertoon, gevolg deur die 

Logix data in die volgende kolom. 

• Diere op ‘n rooi agtergrond is (steeds) aktief in die BenguFarm BEEF databasis, maar: 
o Die dier kan nie gevind word op die Logix databasis nie. Die rede kan byvoorbeeld 

wees dat die dier se geboorte in BenguFarm aangeteken is maar die 
geboortekennisgewing is nie na Stamboek gestuur nie of wel gestuur is maar vir een 

of ander rede nie aanvaar is nie. Dit kan ook wees dat die dier se nommer foutief is 

op BenguFarm BEEF; en/of 
o Die dier is wel op Logix, maar jy is nie die eienaar van die dier nie. Die rede kan 

byvoorbeeld wees dat ’n oordrag reeds vir die betrokke dier ingestuur is Stamboek 
toe, maar dit is nog nie in BenguFarm BEEF aangeteken (op die Verkope, Vrektes en 

Uitskotte skerm) nie, of daar is nagelaat om die dier se status te verander na 

“Onaktief”; en/of 
o Die dier is wel op Logix, maar die dier is gekanselleer of dood. Die rede kan 

byvoorbeeld wees dat ‘n kansellasie vir die betrokke dier reeds ingestuur is Stamboek 
toe, maar dit is nog nie in BenguFarm BEEF aangeteken (op die Verkope, Vrektes en 

Uitskotte skerm) nie, of daar is nagelaat om die dier se status in BenguFarm BEEF 
te verander na “Onaktief”. Dit kan ook wees dat die dier outomaties op Logix 

gekanselleer is, bv. omdat dit nie meer voldoen aan die minimum rasstandaarde nie, 

maar in BenguFarm is die dier nog aktief. 
o Indien ‘n dier se geboorte in BenguFarm aangeteken is maar die 

geboortekennisgewing is nie na Stamboek gestuur nie, kies die betrokke dier(e) en 
stuur die geboortekennisgewing(s) na Stamboek deur op Stuur 

Geboortekennisgewings onderaan die skerm te kliek. 

• Diere op ’n bruin agtergrond is op beide die Logix databasis asook die BenguFarm BEEF 

databasis, maar die dier se status op BenguFarm BEEF is “Onaktief”, terwyl dit op Logix 
aktief is, met ander woorde jy is die eienaar van dier en die dier is nie gekanselleer of 

dood nie. (Sien die rekenaarnommer heel regs om die dier te identifiseer. Ignoreer die 
BenguFarm BEEF geboortedatum – dit is ’n fiktiewe datum). Die rede kan byvoorbeeld 

wees dat die betrokke dier reeds in BenguFarm BEEF as gekanselleer of oorgedra 
aangeteken is, maar die kansellasie of oordrag nie ingestuur is Stamboek toe nie. Indien 

die dier nog in die kudde is, verander net die dier se status in BenguFarm BEEF na aktief. 

Indien die dier nie meer in die kudde is nie en dit is reeds so aangeteken op die Verkope, 
Vrektes en Uitskotte skerm (daar sal ’n kolletjie in die $ kolom wees), kies die betrokke 

dier(e) en stuur die dier se kansellasie of oordrag na Stamboek deur op Stuur 
Oordragte/Kansellasies onderaan die skerm te kliek. Indien die dier nie meer in die kudde 

is nie en dit is nog nie aangeteken op die Verkope, Vrektes en Uitskotte skerm nie (nie ’n 

kolletjie in die $ kolom nie), kies die betrokke dier(e) en skep ’n kansellasie of oordrag 
rekord deur op die Skep Oordragte/Kansellasies onderaan die skerm te kliek. Stuur dan 

die kansellasie of oordrag na Stamboek deur op Stuur Oordragte/Kansellasies onderaan 
die skerm te kliek. 

• Diere op ’n oranje agtergrond kon glad nie in die BenguFarm BEEF databasis gevind 

word nie, maar is (steeds) aktief op die Logix databasis. Die rede kan byvoorbeeld wees 

dat dit ’n aangekoopte dier is wat op Logix reeds oorgedra is, maar dat die dier se data 
nie in BenguFarm ingetrek is nie. Dit mag ook wees dat die dier se rekenaarnommer nie 

in BenguFarm BEEF is nie en gevolglik nie gevind kan word nie. Dit mag ook wees dat 
die dier wel nie in BenguFarm BEEF is nie, byvoorbeeld waar die kalwing nie op 

BenguFarm BEEF aangeteken is nie, maar direk op Logix of via ‘n papier dokument 
ingestuur is. Indien dit ’n aangekoopte dier is wat op Logix reeds oorgedra is, maar dat 

dier se data is nog nie in BenguFarm ingetrek is nie, kies die betrokke dier(e) en trek die 

dier(e) se Logix data in deur op Trek Diere In onderaan die skerm te kliek. 

• Diere op ’n wit agtergrond is aktief in beide die BenguFarm en Logix kuddelyste, maar 
inligting in die velde op ’n rooi agtergrond verskil (bv. aantal kalwers). As ’n koei se aantal 

kalwers in BenguFarm BEEF byvoorbeeld een meer is as op Logix, kan die rede moontlik 
wees dat die laaste kalf van die koei reeds aangeteken is in BenguFarm BEEF, maar die 

betrokke kalf se geboortekennisgewing nog nie ingestuur is Stamboek toe nie. Indien 
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laasgenoemde die rede is, stuur die betrokke kalwers se geboortekennisgewings na 

Stamboek. Let wel: Waar die aantal nageslag by ‘n bul verskil, is dit nie noodwendig ’n 
probleem nie. Dit mag bloot ’n geval wees dat die betrokke bul ook nageslag in ‘n ander 

kudde(s) op Logix het. 

o Wenk: Om die kuddelys verskille te druk met die agtergrondkleure, doen ‘n “Print Screen” (PrtSc 
op jou rekenaar se sleutelbord) en plak (“paste”) dit na ’n Word dokument. 

o Veranderings aan ‘n dier se status, geslag, geboortedatum, ras, afdeling en onderafdeling kan direk 
op die vergelykende lys in die ooreenstemmende BenguFarm kolomme gemaak word. Nadat die 

veranderings gedoen is, kliek Stoor. 
 

o Opsie 2: (enigste opsie vir kuddes met LNR as diensverskaffer) 

▪ Gaan na die Logix webwerf (www.logix.org.za) > Verslae > Inventaris > Vleisbeeste > 
Inventarislys. 

▪ Laai die csv of die zip formaat lêer af. (Die zip formaat lêer is kleiner en sal dus vinniger 
aflaai). Kliek regs op die lêer formaat van jou keuse en kies Save Target As. [Let wel: Moet 

NIE hierdie lêer in Excel oopmaak en stoor in xls of csv formaat NIE, aangesien dit sal 

veroorsaak dat jy dit nie sal kan intrek in BenguFarm BEEF nie en/of dat die datums foutief 
ingetrek word]. 

▪ Stoor die gekose lêer op ’n gepaste plek op jou rekenaar (Bv. C:\BenguFarm\Beef\Imports\).  
▪ Gaan in BenguFarm BEEF na Verslae > Dier Lyste en Getalle > Vergelyk BenguFarm BEEF en 

Logix Per-Capita Lyste. 
▪ Kliek regs bo-aan die skerm op Soek en Vergelyk met Logix csv of zip Per-Kapita Lêer. 

▪ Soek en kies die csv of .zip formaat inventarislêer (INVBEEF...) waar jy dit gestoor het.  

▪ Sien Opsie 1 hierbo vir verduideliking van enige verskille tussen die twee kuddelyste. 
 

39. Opgradeer die program: 
• Dit is belangrik om altyd jou BenguFarm program te opdateer na die nuutste weergawe (die weergawe 

datum verskyn bo-aan die hoofskerm, bv. "BenguFarm (TM) [BEEF] v21 Apr 2022). Wanneer daar ’n 
nuwe weergawe beskikbaar is, word gebruikers per e-pos in kennis gestel dat ’n nuwe opgradering 

beskikbaar is op die BenguFarm webwerf www.bengufarm.co.za. 

• Daar is drie wyses wat gebruik kan word om jou BenguFarm program via die internet te 
opgradeer na die nuutste weergawe: 

o As jy aan-lyn is en die outomatiese opgradering opsie (Opstellings > Kuddes > Herinneraars > 
Kyk Outomaties vir Nuutste BenguFarm Opgradering) gekies is, sal BenguFarm jou herinner 

wanneer 'n nuwe opgradering beskikbaar is. Volg die instruksies om die program te opgradeer. 

o Om bogenoemde proses self te begin, gaan in BenguFarm na Lêer > Opgradeer vanaf Web en 
volg die instruksies.  

o Maak jou BenguFarm toe, gaan na die BenguFarm webwerf www.bengufarm.co.za > 
Downloads > Updates, laai die opgradering lêer af en installeer. Die instruksies hoe om dit te 

doen, is op die  webblad.  

• Let wel: 

o Windows mag ‘n sekuriteitswaarskuwing gee en vra of die lêer geinstalleer (run) moet 
word of nie. Kies "More Info" en/of "Run" / "Run Anyway" om die opgradering te installeer. 

o Indien jou rekenaar nie toelaat dat jy die opgradering lêer aflaai nie, de-aktiveer jou 
rekenaar se anti-virus program tydelik en probeer weer. (Sommige anti-virus 

programme, bv. Avast, Avira, Kaspersky, McFee en Norton, se verstek opstellings is baie 
aggressief en mag die BenguFarm opgradering lêer (.exe formaat) as ‘n risiko sien en dit blok 

met die gevolg dat jy nie sal kan voortgaan met die BenguFarm installasie nie). 

• Wanneer die opgradering proses voltooi is, maak BenguFarm oop en kyk of die nuutste weergawe datum 

bo-aan die hoofskerm staan, byvoorbeeld "BenguFarm (TM) [BEEF] v21 Apr 2022. 

• Wenk: Om te sien wat bygevoeg en verander is in BenguFarm, gaan na www.bengufarm.co.za > 
Downloads > Newsletter. Kies die nuutste nuusbrief en gaan na die Wat is Nuut afdeling. 

 

40. Hernu die program se registrasie: 
Jou BenguFarm program sal jou jaarliks ongeveer ’n maand voordat die program se registrasie gaan verval, 

waarsku. BenguelaSoft BK stuur ongeveer ’n maand voordat jou BenguFarm BEEF se lisensie verval aan jou 
’n faktuur per e-pos vir die verskuldigde lisensiefooi. Indien jy om een of ander rede nie ’n faktuur ontvang 

het nie, skakel asseblief Naomi Havenga by 082 696 8306 of stuur ’n epos na accounts@benguelasoft.co.za. 
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Om jou BenguFarm te herregistreer, volg die volgende instruksies: 

• Sodra jy die lisensiefooi betaal het, stuur asseblief die bewys van betaling aan Tim Pauw by 

accounts@benguelasoft.co.za. 

• Vir die outomatiese herregistrasie funksie in BenguFarm om te werk, moet die volgende in plek wees: 
o Jou rekenaar moet aanlyn wees op die internet wanneer jy BenguFarm oopmaak; 

o Jou BenguFarm BEEF module se lisensiefooi moet opbetaald wees; 
o Die lisensiefooi betaling moet reeds aangeteken wees op die BenguFarm kliëntedatabasis (laat 

asseblief vyf werksdae na betaling toe hiervoor); en 

o Jou BenguFarm rekeningnommer (BPU....) moet aangeteken wees in jou BenguFarm. (Indien jou 
rekening nommer aangeteken is, sal dit langs jou rekening naam bo-aan die hoofskerm verskyn). 

o Die betrokke BenguFarm databasis se Rekenaar Identifikasie Kode (bo-aan die registrasieskerm) 
moet reeds op die BenguFarm kliëntedatabasis geregistreer wees. 

• Indien bogenoemde alles in plek is en jou BenguFarm se registrasie reeds verval het of binnekort gaan 

verval, sal jou BenguFarm, wanneer jy dit oopmaak, aan die BenguFarm kliëntedatabasis op die Internet 

koppel en outomaties jou BenguFarm registrasie hernu. ’n Boodskap “Herregistrasie suksesvol. U het 
toegang tot [datum]” sal op die skerm verskyn. In sulke gevalle is dit is dus nie nodig om die nuwe 

registrasiekodes met die hand op die registrasieskerm in te vul nie. 

• Ongeag die outomatiese herregistrasie opsie, sal BenguelaSoft in elk geval binne vyf werksdae vanaf 
datum van ontvangs van betaling vir jou ’n e-pos stuur met die registrasie- en toegangskodes vir die 

Rekenaar Identifikasie Kodes (RIKs) wat ons vir jou op rekord het (verwys onderstaande nota). Indien 

die outomatiese herregistrasie onsuksesvol was, gaan na Opsies > Registrasie en tik op die 
registrasieskerm dié registrasie- en toegangskode in wat ooreenstem met die betrokke RIK en kliek op 

Registreer/Herregistreer. 

• Indien die outomatiese herregistrasie onsuksesvol was, en die RIK nie in die e-pos ingesluit 
is nie, kontak vir Naomi Havenga by 082 696 8306 of stuur ’n epos na accounts@benguelasoft.co.za 

terwyl jy op die registrasieskerm is en verskaf aan haar jou BenguFarm rekeningnaam, rekeningnommer 
(wat begin met BPU) en die RIK waarvoor jy ’n nuwe registrasiekode benodig. Sy sal dan vir jou ’n 

registrasiekode en toegangskode gee wat jy op die registrasieskerm moet invul. Kliek dan op 

Registreer/Herregistreer. 
Let wel:  

o Maak asseblief seker dat ons jou korrekte e-pos, selfoonnommer en ander kontakbesonderhede op 
rekord het. Indien jy aan-lyn is op die Internet, kan jy jou rekeningbesonderhede kontroleer en, 

indien nodig, verander deur in BenguFarm te gaan na Opsies > Besigtig/Opdateer my 

Rekeningbesonderhede. Andersins, kontak asseblief Naomi Havenga. 
o Elke databasis in BenguFarm het 'n ander RIK. Die RIKs van elke rekenaar waarop BenguFarm 

geïnstalleer is, is ook verskillend. Jy moet dus die RIKs van al die databasisse op al die rekenaars 
waarop BenguFarm geïnstalleer is verskaf en vir elk ‘n registrasiekode en toegangskode kry. Om die 

RIKs van die ander databasisse te kry, verander die aktiewe kudde na die betrokke databasis (Lêer 
> Verander Aktiewe Kudde na) en gaan dan weer na "Opsies > Registrasie" . Doen dieselfde vir elke 

rekenaar waarop BenguFarm geïnstalleer is. 
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DEEL C – ADDISIONELE EN GEVORDERDE FUNKSIES: 
 

Lêer 
41. Herbereken opsommende data: 

• Om opsommende data te herbereken, gaan na Lêer > Ondersteuning > Herbereken Opsommende Data. 

 

42. Herbereken verwagte Kalfdatums: 
• Verwagte kalfdatums moet herbereken word indien die Jongste Ouderdom by 1ste Dekking, Rusperiode 

van Kalwing tot Dekking of Minimum-, Normale- of Maksimum Periode Dragtig opstellings [Opstellings 

> Kuddes > Dekking, Dragtigheid en Kalwing] vir die betrokke kudde verander is. 

• Om verwagte kalfdatums te herbereken, gaan na Lêer > Ondersteuning > Herbereken Verwagte 
Kalfdatums. 

 

43. Herbereken outomatiese dagboekinskrywings: 
• Om outomatiese dagboekinskrywings te herbereken, gaan na Lêer > Ondersteuning > Herbereken 

Outomatiese Dagboekinskrywing. 

 

44. Herbereken inteelpersentasies: 
• Om inteelpersentasies te herbereken, gaan na Lêer > Ondersteuning > Herbereken Inteelpersentasies. 

 

45. Soek duplikaat diere: 

• BenguFarm sal normaalweg nie toelaat dat duplikaat dierrekords (diere met dieselfde IDno) geskep word 
nie, maar wanneer 'n dierrekord eers met die hand geskep is óf ingetrek is deur middel van een of ander 

lêer en dan ook ingetrek word vanaf ‘n ander lêer is dit in sekere omstandighede moontlik dat duplikaat 
rekords wel kan ontstaan. ’n Voorbeeld is wanneer data eers vanaf ‘n ander sagteware pakket, soos 

Stoetmeester, ingetrek is in BenguFarm en daarna ook vanaf ‘n Logix lêer ingetrek is. Vir diere wat in 
Stoetmeester nie rekenaarnommers gehad het nie óf waar die rekenaarnommer foutief was, sal duplikaat 
rekords dan geskep word. 

• Om diere met dieselfde visuele- of elektroniese ID (EID) nommer of rekenaarnommer te 

soek, gaan na Lêer > Ondersteuning > Soek Duplikaat Diere. Let wel: Diere met duplikaat nommers 
word oor alle kuddes in die betrokke databasis gesoek. 

• Indien daar diere in dieselfde kudde is met dieselfde ID nommer, kan dit lei tot verskeie probleme. Indien 

daar werklik twee diere is met dieselfde ID nommer (bv. een aangekoop en een self geteel), voeg ’n 
letter by agteraan die nommer om die diere se nommers uniek te maak , bv. 190022A. 

• Om ’n verslag te skep van duplikaat diere, kliek op Vertoon Verslag. 
• Duplikaat dierrekords kan per hand regmaak word deur eerstens vas te stel watter data 

(algemene dierdata, stamboomdata, nageslagdata, gewigte, ens.) verskil tussen die twee betrokke 

diere, tweedens dan een van die twee diere se data volledig te maak en dan derdens die ander dier te 
verwyder ("delete"). Dit is egter 'n lang en moeisame proses, veral as daar baie sulke duplikaat diere is. 
Daar is egter 'n administratieewe funksie in BenguFarm [Lêer > Ondersteuning > Administratiewe 
Funksies] wat hierdie samevoeging (“merge”) proses programmaties doen. Om by die Administratiewe 

Funksies in te kom, benodig 'n wagwoord. Kontak jou BenguFarm agent vir hulp om deur middel van 

hierdie administratiewe funksie duplikaat dierrekords  in BenguFarm saam te voeg en die ander rekord 

te verwyder. 
 

46. Verander ID nommers en/of -name: 
• Let wel: Dit word sterk aanbeveel dat ‘n rugsteun gemaak word van die betrokke databasis voordat 

hierdie funksie gebruik word. 

• Gaan na Opstellings > Kuddes > ID Metodes en Nommering en maak seker die Verstek ID Formaat is 
korrek opgestel. 

• Gaan na Diere > Verander Diere (tabel uitleg). By Kies Velde om te Vertoon, kies die velde KKM, Jaar, 

Volgnommer en, indien van toepassing, Voorvoegsel (Kuddenaam). Maak seker hierdie velde is, waar 
van toepassing, ingevul en korrek by ALLE aktiewe diere in die betrokke kudde, aangesien hierdie drie 

velde gebruik sal word om die IDnrs te herskep volgens die Verstek ID Formaat opstelling. Indien enige 

iets bygevoeg of verander is, kliek Stoor. 

• Om diere se ID nommers en/of -name te verander in BenguFarm BEEF, gaan na Lêer > Ondersteuning 
> Verander ID Nommers en/of Name en kies die toepaslike opsie.  
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47. Administratiewe funksies: 
• BenguFarm beskik oor verskeie administratiewe funksies om data reg te stel of te verander (bv. om 

duplikaat diere te vind en te verwyder nadat Stoetmeester en Logix/Intergis data ingetrek is), bulle (soos 
KI bulle) se nageslag wat in ander kuddes gebore is te verwyder ten einde onnodige diere in die databasis 

te vewyder en die databasis kleiner te maak, ens.). Gaan na Lêer > Ondersteuning > Administratiewe 

Funksies. Jou BenguFarm agent sal jou na hierdie funksies verwys wanneer nodig en aan jou die 
wagwoord verskaf om toegang te kry tot hierdie funksies. Let wel: Dit word sterk aanbeveel dat ‘n 

rugsteun gemaak word van die betrokke databasis voordat enige administratiewe funksie gebruik word. 
 

48. Foutopsporing en probleemoplossing: 
• Indien jy 'n foutboodskap (bv. "An unhandeled exception has occured...") in BenguFarm BEEF kry, sal 

die volgende stappe dit in die meeste gevalle oplos: 
o Gaan na Lêer > Ondersteuning > Toets Datastrukture en DBNul waardes. 

o Gaan na Lêer > Ondersteuning > Kompakteer en Herstel Databasis. 
o Gaan na Lêer > Ondersteuning > Herbereken Opsommende Data. 

o Gaan na Opstellings > Kuddes > Algemeen en maak seker dat alle toepaslike opstellings voltooi 

is en korrek is. 
o Maak BenguFarm toe en weer oop. 

• Indien bogenoemde stappe nie die probleem oplos nie, gaan in BenguFarm na Lêer > Opgradeer vanaf 

Web OF maak BenguFarm toe en gaan met jou Internet leser na www.bengufarm.co.za > Downloads > 
Updates. Laai die nuutste opgradering af, installeer dit en maak BenguFarm weer oop. 

• Indien dit steeds nie die probleem oplos nie, kontak jou BenguFarm BEEF agent vir hulp. 

 

Diere 
49. Notas: 

• Om ‘n algemene nota (bv. “Halfsuster van duurste bul op Nasionale Veiling 2012”) by ’n dier aan te 

teken (of verander/verwyder), gaan na Diere > Voeg by & Verander Diere (Enkel Dier Uitleg) > Diverse 
Data > Notas. Notas kan ook op die Dier Uitleg van die hoofskerm op die Notas opkykskerm 

aangeteken word. Dit is die enigste opkykskerm waar data ingevoer en gestoor kan word. (Kliek op 

die "stiffy" skyf ikoon om die nuwe nota te stoor). 

• Notas kan slegs ingesluit word in My Verslae deur te gaan na Verslae > My Verslae > Dierdata. Kliek op 
Verslag Kolomme (Uitleg) en kies dan Algemeen > Notas. 

 

50. Voorkoms opmerkings: 
• Om voorkoms opmerkings (bv. Wollerige haarkleed) by ’n dier aan te teken (of 

verander/verwyder), gaan na Diere > Voeg by & Verander Diere (Enkel Dier Uitleg) > Algemeen. Soek 

die opmerking(s) onder die betrokke afdeling en merk dit (byvoorbeeld onder die afdeling Vel en 
Haarkleed > Kroes/Wollerige Somer Haarkleed). Voorkoms Opmerkings kan ook op die Dier Uitleg 

van die hoofskerm se Notas opkykskerm onder die Voorkoms Opmerkings hofie aangeteken 
en gestoor word. 

• Voorkoms Opmerkings kan slegs insluit word in die My Dierdata Verslae deur te gaan na Verslae > My 

Verslae > Dierdata. Kliek op Verslag Kolomme (Uitleg) en kies dan Algemeen > Voorkoms Opmerkings. 

 

51. Familielyne: 
• Die doel met die aanteken van familielyne is om aan te dui dat ‘n dier geteel is uit ‘n spesifieke 

familie. Rekord kan gehou word van óf moederlyne óf vaderlyne. 

• Om op stel of die program rekord moet hou van moederlyne óf vaderlyne, gaan na Opstellings 

> Kuddes > Dekkings, Dragtighede en Kalwing en kies Teel Moederlyne óf Teel Vaderlyne en, indien 

van toepassing, Forseer Geselekteerde Lyn. Indien Teel Moederlyne gekies is, sal ‘n kalf die familielyn 

van die moeder kry. Indien die moeder nie ‘n familielyn het nie, kry die kalf die familielyn van die vader. 

Vaderlyne net andersom. Indien Forseer Geselekteerde Lyn gekies is en byvoorbeeld Teel Moederlyn 

opgestel is en die moeder het nie ‘n familielyn nie, sal die vader se familielyn NIE gebruik word NIE. 

• Die familielyn kan aangeteken word vir ‘n dier op die Kalwingskerm, Voeg by en Verander Diere 
skerm asook die Verander Diere skerm. 

• Op die kalwing skerm sal ‘n kalf outomaties gekoppel word aan die moeder se familielyn, mits 

die moeder se familielyn aangeteken is, of aan die vader se familielyn, mits die vader se familielyn 
aangeteken is. 

• Om ‘n dier se familielyn op die hoofskerm op te kyk, gaan op die Dier Uitleg na Geboorte > 

Familielyn en op die Kudde Uitleg na die Geboorte afdeling. 
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• Diere van ’n spesifieke familielyn kan gekies word deur middel van die Kies Diere skerm > Kies 
Diere per Groep(e) / Filter(s) > Familielyn.  

• Die familielyn kan slegs ingesluit word in die Dieropsomming verslag en die My Verslae deur 

te gaan na Verslae > My Verslae > Dierdata. Kliek op Verslag Kolomme (Uitleg) en kies dan Geboorte > 
Familielyn. 

 

52. DNA geverifiëerde ouerskappe: 
Sien paragraaf 27 hoe om diere se DNA geverifiëerde ouerskappe in BenguFarm te gesertifiseer. 

 

53. Genomiese resultate 
• Om jou diere se genomiese resultate in te trek in BenguFarm BEEF, : 

o Opsie 1 – Logix Direk (aanbevole opsie vir kuddes met SA Stamboek as 

diensverskaffer): 
▪ Gaan in BenguFarm BEEF na Data Stuur / Trek In > Logix Direk > Trek Genomiese Resultate 

In. BenguFarm sal jou nou inlog op Logix, die nuutste genomiese resultate vir die diere in die 
betrokke kudde soek, ’n lêer skep en dit in BenguFarm BEEF ingetrek sonder dat enige verdere 

aksie nodig is..  

▪ Indien jy ‘n “time-out” boodskap van Logix kry, volg die instruksies op die skerm of Opsie 2 
hieronder om die nuutste teelwaardes af te laai en in te trek. 

o Opsie 2: Alternatiewelik kan jy, wanneer jy die genomiese resultate verslag ontvang het van die 
DNA laboratorium, die betrokke diere se genomiese resultate aanteken (of verander/verwyder) by 
Diere > Genomiese Resultate. 

• Om ‘n dier se genomiese resultate op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 
Genomiese Resultate opkykskerm. Om die resultate te druk, kliek op die drukker ikoon regs bo-aan die 

Genomiese Resultate opkykskerm. Wenk: Om hierdie opkykskerm te vertoon, gaan na Vertoon > Kies 
Hoofskerm Dier Uitleg Opkykskerms > Genomiese Resultate. 

• Om ’n verslag te skep van genomiese resultate, gaan na Verslae > My Verslae > Vertoon Kolomme 

(Uitleg) > Genomiese Toetsing.  
 

54. Data navigeerder: 
• Die Data Navigeerder skerm is baie handig om verskeie tipes data van die hele kudde (verstek opsie) of 

’n geselekteerde groep diere saam te vertoon op een skerm. Veranderings aan data en verwydering van 
rekords kan ook op die betrokke data skerm aangebring word via die Data Navigeerder skerm. Wenk: 

Die Data Navigeerder skerm kan ook gebruik word om diere te selekteer en sorteer en om vinnig ’n 
verslag te skep. Dit is ’n baie handige skerm om te gebruik. Gaan na Diere > Data Navigeerder. Gebruik 

die Hulp funksie indien nodig. 

 

55. Soek dier: 
• Om ’n dier te soek op ’n ander nommer (bv. mikroskyfie/elektroniese nommer, rekenaarnommer, 

DNA nommer, ens.) in BenguFarm BEEF, gaan na Diere > Soek Dier. Hierdie funksie is veral handig om 

te sien wat die oorplaatjie nommer was wanneer ’n dier se visuele oorplaatjie verloor het.  
 

56. Verwyder mikroskyfienommers (EIDs) van onaktiewe diere: 
• Om mikroskyfienommers (EIDs) te verwyder/ontkoppel van diere wat verkoop of dood 

(d.w.s. onaktief) is in BenguFarm BEEF, gaan na Diere > Verwyder Mikroskyfienommers (EIDs) van 

Onaktiewe Diere. Let wel: Voordat jy hierdie funksie uitvoer, maak eers verseker dat die status van 

die diere wat verkoop/dood is, onaktief is. 

 

57. Ken ‘n mikroskyfie nommer (EID) aan ‘n ander dier toe: 
• Om die nommer van ‘n mikroskyfie (EID) wat op een dier was aan ‘n nuwe dier toe te ken 

in BenguFarm BEEF, gaan na Diere > Ken Mikroskyfie (EID) aan Ander Dier Toe. 

• Kies die betrokke dier en tik die mikroskyfie nommer (EID) in wat aan die dier toegeken moet word. Die 
dier wat tans hierdie mikroskyfienommer (EID) het, sal onder gelys word en die mikroskyfie nommer 

(EID)  sal outomaties uitgevee word by daardie dier, m.a.w. nadat die betrokke mikroskyfie nommer by 

die nuwe dier ingevul en gestoor is, sal die mikroskyfie nommer (EID) veld by die vorige dier wat dit 
gehad het, blanko wees. Indien nodig, kan hier 'n ander mikroskyfie nommer (EID) vir hierdie dier 

ingelees word, maar dis egter onwaarskynlik, aangesien 'n hertoekenning van ‘n mikroskyfie gewoonlik 
gebeur waar die dier wat tans die skyfie het, geslag of verkoop word. 

• Let wel: 
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o BenguFarm hou NIE rekord van die vorige dier(e) wat ‘n spesifieke mikroskyfie nommer (EID) 

gehad het nie. Indien jy wel sodanige rekord wil hou, stel ons voor dat jy die mikroskyfie nommer 
(EID) by die vorige dier los, maar ‘n karakter byvoeg om dit ‘n unieke nommer te maak, bv. die 

eerste dier wat die mikroskyfie nommer 123456789 gehad het is 123456789-A, die 2de dier wat 

hierdie mikroskyfie nommer gehad het 123456789-B, ens. Dier wat wat tans die mikroskyfie 
nommer het, is natuurlik net 123456789. 

o Indien slegs van elektroniese identifikasie (EIDs) gebruik gemaak word, sien Opstellings > 
Kuddes > Skep IDno (Visueel) vanaf EID (Mikroskyfie Nommer) waar geen IDno Gespesifiseer 

is nie. 
 

58. Verander telers, eienaars en/of standplase: 
• Om een of verskeie diere se telers, eienaars en/of standplase te verander in BenguFarm BEEF, gaan na 

Diere > Verander Telers, Eienaars en/of Standplase. Gebruik die Hulp funksie indien nodig. 
 

Reproduksie 
59. BenguFarm GENETICS telingsbestuur module: 

• Stoettelers kan met die opsionele GENETICS module met behulp van teelwaardes en stambome die 
beste parings te bepaal volgens teeldoelwitte wat hulle self kan opstel vir hul eie kuddes. Vir meer 

inligting, kontak Mnr. Leslie Bergh by leslie@benguelasoft.co.za of 082 801 2026 of besoek 
www.bengufarm.co.za > Products > Genetics. Vir ‘n GENETICS module handleiding, gaan na 

www.bengufarm.co.za > Downloads > Manuals. 

 

60. Semen voorraad: 
• Om die semen van KI bulle aan te teken (of verander/verwyder) in die Semen Voorraaad 

register (opsioneel), gaan na Reproduksie > Semenvoorraad. Gebruik die Hulp funksie indien nodig. 

• Wanneer KI rekords aangeteken word, word die semen voorraad outomaties opgedateer, mits Gevries 

gekies is by Semen Tipe op die KI skerm. Indien Vars gekies word, sal daardie KI rekords geen invloed 
hê op die semen voorraad nie. 

• Om ’n verslag te skep van semen voorraad, gaan na Verslae > Dekkings, Dragtighede en Kalwings 

> Semen Voorraad. 
 

61. Embriospoelings, -inplantings en embriovoorraad: 
• Sien Bylaag D. 

 

Gesondheid 
62. Toetse vir siektes: 

• Om ’n lys te skep waarop toetse vir siektes aangeteken kan word, gaan na Verslae > Siektes, 

Beserings en Behandelings > Siektetoetse (aantekenlys). [Nog nie beskikbaar nie]  

• Om die uitslae van toetse vir siektes aan te teken (of verander/verwyder), gaan na Gesondheid 
> Siekte Toetse. 

• Om ‘n verslag van die uitslae van toetse vir siektes te skep, gaan na Verslae > Siektes, Beserings 

en Behandelings > Siekte Toetse. Wenk: Kliek Vertoon Werkblad om diere aan groepe (bv. Getoets / 
nie getoets groepe) te koppel. 

• Om ‘n dier se uitslae van toetse vir siektes op die hoofskerm op te kyk, gaan op die Dier Uitleg 

na die Inentings, Doserings en Siekte Toetse > Siekte Toetse opkykskerm. Om toetse vir siektes op die 
Kudde Uitleg te vertoon, gaan op die hoofskerm se Kudde Uitleg na Vertoon Opsies > kliek op die Stel 

My Kolomme om te Vertoon Op (ikoon heel bo). [Nog nie beskikbaar nie] 

 

63. Siektes, beserings en behandelings: 
• Om medisyne voorraad aan te teken, sien paragraaf 65. 

• Om siektes, beserings en behandelings aan te teken (of verander/verwyder), gaan na Gesondheid 

> Siektes, Beserings en Behandelings. Gebruik die Hulp funksie indien nodig. Wanneer Behandelings 
aangeteken word, sal die koste per dier outomaties bereken word vanaf die Medisyne Voorraad, mits 

die besending nommer ingevul word. Indien 'n besendingnommer nie ingevul word nie, sal die laaste 

aankope se eenheidsprys (totale prys / # eenhede) gebruik word. 

• Wenk: Inligting soos verstek dosis, ontrekkingsperiode en vervaldatum van medisyne kan 
aangeteken word op die voorraad register [Gesondheid > Medisyne Voorraad]. 

• Om ’n verslag te skep van siektes, beserings en behandelings, gaan na Verslae > Siektes – 

Voorkoming en Behandeling > Siektes, Beserings en Behandelings. 

http://www.bengufarm.co.za/
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• Om die siektes, beserings en behandelings van ’n dier op die hoofskerm op te kyk, gaan op 
die Dier Uitleg na die Siektes en Behandelings opkykskerm. 

• Wenk: Dit word aanbeveel om, waar nodig, die verstek lys van medisynes uit te brei met die spesifieke 

middels wat jy gebruik. Dit kan gedoen word deur te gaan na Opstellings > Medisynes. Medisynes in die 
verstek lys wat nie van toepassing is op jou kudde nie, kan afgeskakel word deur die regmerkie s in die 

In Gebruik en Toestel (bv. APR500 / APR600) kolomme te verwyder. Dieselfde geld ook vir die Siektes, 
Besering en Parasiete opstelling. 

 

64. Entstowwe, doseer-/dipmiddels en aanvullings voorraad: 
• Om entstowwe, doseer-/dipmiddels en aanvullings (soos multiminerale- of multivitamiene) 

voorraad aan te teken (of verander/verwyder) (opsioneel), gaan na Gesondheid > Entstowwe, 

Doseer-/Dipmiddels en Aanvullings Voorraad. Gebruik die Hulp funksie indien nodig. 

• Wanneer inentings, doserings, dip en aanvullings rekords aangeteken word, word die entstowwe, 

doseer-/dipmiddels en aanvullings voorraad outomaties opgedateer. 

• Op die Dagboek en Bestuurskalender skerm onder die Voorraad naby Verval kategorie sal ‘n waarskuwing 
verskyn indien die betrokke besending entstof naby die vervaldatum is. 

 

65. Medisyne voorraad: 
• Om medisyne voorraad aan te teken (of verander/verwyder) (opsioneel), gaan na Gesondheid > 

Medisyne Voorraad. Gebruik die Hulp funksie indien nodig. 

• Wanneer behandelings rekords aangeteken word, word die medisyne voorraad outomaties opgedateer. 

• Op die Dagboek en Bestuurskalender skerm onder die Voorraad naby Verval kategorie sal ‘n waarskuwing 

verskyn indien die betrokke besending medisyne naby die vervaldatum is. 
 

Prestasietoetsing 
66. Mates en Punte: 

• Om ’n lys te skep waarop mates of punte van verskeie eienskappe aangeteken kan word, 
gaan na Verslae > Gewigte, Mates, Prestasietoetsing en Teelwaardes > Mates en Punte (aantekenlys). 

• Om mates of punte (bv. Kondisie Punt of Algemene Voorkoms Punt) van eienkappe aan te teken 

(of verander/verwyder), gaan na Prestasietoetsing > Gewigte, Mates en Punte nie aan ‘n Toets gekoppel 
nie > Mates en Punte. Let wel: Slegs mates of punte met numeriese waardes kan hier aangeteken 

word. Om eienskappe met alfa waardes aan teken, sien paragraaf 89. 

• Om addisionele eienskappe op te stel, gaan na Opstellings > Eienskappe.  

• Om ‘n verslag van mates of punte te skep, gaan na Verslae > Gewigte, Mates, Prestasietoetsing 
en Teelwaardes > Mates en Punte Verslag. 

• Om ‘n dier se mates of punte op die hoofskerm op te kyk, gaan op die Dier Uitleg na die Mates 

en Punte opkykskerm. Om mates en punte op die Kudde Uitleg te vertoon, gaan op die hoofskerm se 

Kudde Uitleg na Vertoon Opsies > kliek op die Stel My Kolomme om te Vertoon Op (ikoon heel bo). 
 

67. Doen aansoek vir bul groeitoetse (Slegs van toepassing op kuddes wat lid is van 

 SA Stamboek se Logix Beef) 
Indien jy bulle wil toets in ’n Sentrale Groeitoets (Fase C) en/of Op-die-Plaas Groeitoets (Fase D), kan jy die 

nodige aansoekvorms asook ‘n lys van die betrokke bulle en hul besonderhede in BenguFarm BEEF voltooi 
en stuur na die LNR of Stamboek. Gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR > Fase C/D 

Prestasietoets Aansoekvorm. Let wel dat jy hierdie vorm kan druk of in elektroniese formaat kan stoor en 
stuur na jou betrokke Stamboek tegniese adviseur of LNR streekskantoor of bultoetssentrum 

(let wel, NIE na Logix nie).  

 

68. Pelviese mates: 
• Om pelviese mates aan te teken (of verander/verwyder), gaan na Prestasietoetsing > Pelviese Mates. 

• Om ’n verslag te skep van pelviese mates en verwerkings (gekorrigeerde pelvisopening, indekse, 

ens.), gaan na Verslae > Gewigte, Mates, Prestasietoetsing & Teelwaardes > Prestasietoetsresultate > Pelvis 

Mates. Sien Bylaag F vir die interpretasie en gebruik van verwerkte pelvismates. 
 

69. Liggaamsmates, funksionele voorkoms, ultrasoniese mates, bosluistellings en 
voerinnames: 
• Liggaamsmates, funksionele voorkoms punte, ultrasoniese mates van sekere karkaseienskappe, 

bosluistellings en voerinnames word normaalweg slegs aangeteken by amptelike groeitoetse van bulle. 

In sulke gevalle sal die data deur die betrokke diensverskaffer (bv. SA Stamboek of die LNR) onder wie 
se toesig die toets uitgevoer word, aangeteken word.  
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• Om hierdie tipe data aan te teken in BenguFarm BEEF, gaan na Prestasietoetsing en kies Liggaamsmates 
of Funksionele Voorkoms of Ultrasoniese Mates of Bosluistellings of Voerinnames. 

 

70. Bereken benaderde voerkoste in op-die-plaas groeitoetse (Fase D): 
• Om benaderde voerkoste (volgens diergewig) per bul te bereken vir diere in ‘n plaas groeitoets 

(Fase D), gaan na Prestasietoetsing > Gewigte vir Prestasietoetsing. Kies die betrokke toets en kliek 

Spesifiseer Voerkoste. Vul die datum, koste/kg voer en persentasie van diergewig gevoer in en kliek 
Stoor. Let op: Die betrokke diergewigte moet reeds ingevoer moet wees om die voerkoste te bereken.  

• Om ‘n voerkoste verslag te druk, gaan na Verslae > Gewigte, Metings, Prestasietoetsing & 

Teelwaardes > Prestasietoetsresultate. Wanneer die skerm oopmaak, kies die toets links-bo aan die 

skerm en kliek links-onder op Voerkostes. 
 

71. Melkdata:  

• Om melkproduksie- en melkontedingsdata aan te teken (of verander/verwyder), gaan na 
Prestasietoetsing > Melkdata. 

• Om ‘n verslag van melkdata te skep, gaan na Verslae > Gewigte, Mates, Prestasietoetsing en 

Teelwaardes > Melk Produksie Opsomming. Wenk: Kliek Vertoon Werkblad om diere aan groepe (bv. 
produksiegroepe) te koppel. 

• Om ‘n melk laktasies verslag te skep, gaan na Verslae > My Verslae > Melk Laktasies. 

 

Ander data 
72. Fotos en dokumente: 

• Om dier fotos en dokumente (bv. aankoopfaktuur, DNA sertifikaat, vrugbaarheid/ 

dragtigheidsertifikaat, verkoopfaktuur) op te neem (of verander/verwyder), gaan na Ander Data > 

Fotos en Dokumente. Gebruik die Hulp funksie indien nodig.  
Let wel: Fotos in BMP, GIF, JPEG PNG en TIFF formaat en dokumente in enige formaat kan ingetrek 

word. ‘n Video kan ook as ’n dokument ingetrek en vertoon word. 

• Om ‘n dier se fotos op die hoofskerm op te kyk, gaan op die Dier Uitleg na die Fotos opkykskerm. 

• Om ‘n dier se dokumente (insluitende videos) op die hoofskerm op te kyk, gaan op die Dier 
Uitleg na die Dokumente opkykskerm, kies die betrokke dokument en kliek op Vertoon Dokument.  

• Om ‘n dier se foto op die Stamboom verslag te druk, gaan na Verslae > Dier, Stamboom en 

Nageslag > Stamboom en kies die opsie Druk Foto van Dier bo-aan die skerm. 
• Om ‘n dier, sy stamboom en nageslag se fotos op een skerm te vertoon, gaan op die hoofskerm 

na die Dier Uitleg > Fotos opkykskerm en kliek onder die dier se foto op die Stamboom en Nageslag 

Foto Blaaier knoppie. 

• Wenk: Om ‘n foto van ‘n dier na Logix te stuur, sien paragraaf 87. 
 

73. Dagboek en bestuurskalender: 
• BenguFarm BEEF het ’n interne dagboek wat geïntegreer is met die bestuurskalender funksie.  

• Om jou eie bestuurskalender op te stel, gaan na Opstellings > Bestuurskalender Opstellings. 

Gebruik die Hulp funksie indien nodig. 

• Om die bestuurstake en ander dagboekinsrywings te sien, gaan na Ander Data > Dagboek en 
Bestuurskalender. Gebruik die Hulp funksie indien nodig.  

• By Opstellings > Kuddes > Herinneraars kan jy stel dat die dagboek en geïntegreerde bestuurskander 

vertoon wanneer BenguFarm BEEF oopgemaak word (by verstek is dit aangeskakel) en kan die tydperk 
gestel word (verstek is 7 dae) wat items in die dagboek vertoon moet word.  

• Let wel: Wanneer kalwers se geboortedata op die Kalwingskerm aangeteken word, die veld “Voeg By 

Tot Prestasietoetsgroep” gemerk is, en die Kalwing skerm toegemaak word, verskyn 'n “Herbreken 

Outomatiese Dagboekinskrywings” skermpie. Indien “Bereken” gekliek word, sal BenguFarm die datums 
bereken wanneer die betrokke groep kalwers geweeg moet word vir die onderskeie 

prestasietoetsgewigte. Wanneer die betrokke groep kalwers geweeg moet word vir ’n sekere 
prestasietoetsgewig (bv. Speengewig), sal ‘n herinneraar in die dagboek vertoon. 

 

74. Prosedures: 

• Die Prosedures skerm is bedoel om aktiwiteite of prosedures soos kalwers gespeen, onthoring, kastreer, 
hoewe gesny, biopsies geneem, sementoetse, skedewas, toetse vir siektes, diere gemerk, ensovoorts 

aan te teken. 

• Om ’n lys te skep waarop prosedures  aangeteken kan word, gaan na Verslae > Siektes – 
Voorkoming en Behandeling > Inentings, Doserings, Aanvullings en Prosedures (aantekenlys). By Kies 
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Items om te Druk, kies die prosedures wat jy wil aanteken en voeg dit met die pyltjie wat regs wys by 

tot die Items wat Gedruk sal Word. 

• Om prosedures aan te teken (of verander/verwyder), gaan na Ander Data > Prosedures. Gebruik die 
Hulp funksie indien nodig. 

• Om ’n verslag te skep van prosedures, gaan na Verslae > Ander Verslae > Prosedures. 

• Om die prosedures van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Prosedures opkykskerm. Om dit op die Kudde Uitleg te vertoon, gaan op die hoofskerm se Kudde Uitleg 

na Vertoon Opsies > kliek op die Stel My Kolomme om te Vertoon Op (ikoon heel bo). 

• Wenk: Dit word aanbeveel om, waar nodig, die verstek lys van prosedures uit te brei. Dit kan gedoen 

word deur te gaan na Opstellings > Prosedures. 

 

75. Algemene Kudde Uitgawes 
• Sien paragraaf 86, afdeling Uitgawes aanteken in BenguFarm, vir die aantekening van uitgawes per dier 

of per kamp.  

• Om algemene kudde uitgawes (bv. arbeid, diesel, SA Stamboek fooie, telersgenootskap fooie, ens.) 

vir die betrokke kudde aan te teken (of verander/verwyder), gaan na Ander Data > Algemene Kudde 
Uitgawes. Gebruik die Hulp funksie indien nodig. 

• Om ’n verslag te skep van algemene kudde uitgawes vir die betrokke kudde, gaan na Verslae 

> Kudde Ontleding > Algemene Kudde Uitgawes. 
• Om ’n verslag te skep wat ’n opsomming gee van alle inkomstes en uitgawes aangeteken 

vir die betrokke kudde, gaan na Verslae > Kudde Ontleding > Kudde Inkomste en Uitgawes 

Opsomming. 
 

76. Reënval: 
• Om historiese reënval data vanaf Excel in te trek, sien Bylaag B. 

• Om reënval aan te teken (of verander/verwyder) (per lokaliteit), gaan na Ander Data > Reënval. 

Gebruik die Hulp funksie indien nodig. 

• Op dieselfde skerm kan ’n verslag (met verskeie opsies) geskep word van reënval. 

 

77. Diverse voorrade: 
• Om diverse voorrade (lekke, kragvoer, hooi, ens.) aan te teken (of verander/verwyder), gaan na 

Ander Data > Diverse Voorraad. Gebruik die Hulp funksie indien nodig. 
 

78. Kamp aktiwiteite: 
• Om aktiwiteite wat aan ’n spesifieke kamp gekoppel word (bv. voer of lek uitgesit, brand, ontbos, 

voerplek geskuif, heining onderhoud, drinkplek skoongemaak) aan te teken (of verander/verwyder), 

gaan na Ander Data > Kamp Aktiwiteite. Let wel: Kamp aktiwiteite word nie gekoppel aan die diere in 

die betrokke kamp op daardie tydstip nie. 

• Voorraad items soos konsentraat voer, lek en hooi aangeteken by Diverse Voorraad (sien hierbo), 
word outomaties opgedateer indien die uitsit daarvan in kampe aangeteken word by Kamp 

Aktiwiteite, mits die toepaslike Voorraad Item gekies word en die hoeveelheid aangedui word. 

• Om ’n verslag te skep van kamp aktiwiteite, gaan na Verslae > Kampe > Kamp Aktiwiteite. 

• Om ’n verslag te skep van voergebruik per kamp, gaan na Verslae > Gewigte, Mates, 
Prestasietoetsing en Teelwaardes > Voer Gebruik. Hierdie verslag bied 'n opsomming van voergebruik 

soos aangeteken by Kampaktiwiteite asook voerstasies waar diere se individuele voerinname aangeteken 
word. 

 

79. Diere gesien: 
• Om diere wat gesien is (“animal sightings”) op ’n spesifieke datum en kamp en/of GPS 

koördinate aan te teken (of verander/verwyder), gaan na Ander Data > Diere Gesien. 

• Om ’n verslag te skep van diere wat gesien is, gaan na Verslae > Dier Lyste en Getalle > Diere 

Gesien. Wenk: Met die Diere Gesien vs Kamp opsie, word al die diere wat gesien is gelys en langsaan 

elke dier in watter kamp die dier tans in BenguFarm is. Met die Kampe vs Diere Gesien opsie, word al 

die diere wat in BenguFarm in sekere kamp(e) is gelys en langaan in watter kamp en wanneer die dier 

laas gesien is. 
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80. Versekering: 
• Om versekering data van diere aan te teken (of verander/verwyder), gaan na Ander Data > 

Versekering. 

• Om ’n verslag te skep van versekering inligting, gaan na Verslae > Ander Verslae > Versekering. 
 

81. Verskuif diere na ‘n ander plek: 
• Om (tydelike) verskuiwings van diere vanaf die plaas na ’n ander plek (standplaas), bv. ’n 

bultoetssentrum, aan te teken (of verander/verwyder), gaan na Ander Data > Verskuif Diere na ’n 

Ander Plek. Gebruik die Hulp funksie indien nodig. 

• Let wel: Om diere tussen kuddes (bv. stoet na kommersieel) te skuif, gaan na Ander data > 

Skuif Diere na Ander Kudde. Om diere tussen kampe of ander groepe te skuif, gaan na Ander Data 
> Verskuif Diere na ‘n ander Kamp of Groep.  

 

82. Toekennings: 
• Om toekennings van diere (bv. Elite Koei) aan te teken (of verander/verwyder), gaan na Ander 

Data > Toekennings. 

• Toekennings kan op die volgende verslae vertoon word: 

o Teelkudde Seleksie [Verslae > Inspeksies en Seleksies > Teelkudde Seleksie]  
o My Verslae [Verslae > My Verslae > Dierdata > Kolomme > Toekennings]  

• Om die toekennings van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg na die 

Algemeen opkykskerm en rol af tot by die toekenning velde. 
 

83. Inspeksie Puntings: (Slegs van toepassing op sekere rasse) 
• Sekere telersgenootskappe (bv. Drakensberger) teken punte van ’n reeks eienskappe aan by inspeksie 

van diere. Om sulke puntings aan te teken (of verander/verwyder), gaan na Ander Data > Inspeksie 
Puntings. 

• Om die inspeksie puntingdata van ’n dier op die hoofskerm op te kyk, gaan op die Dier Uitleg 

na die Algemeen opkykskerm en rol af tot by die Punting velde. 

• Om ’n verslag te skep van sulke inspeksie puntings, gaan na Verslae > Inspeksies en Seleksies > 
Puntings Verslag. 

• Let wel: Om jou eie punte van sekere eienskappe (bv. Algemene Voorkoms Punt of Kondisie Punt) aan 

te teken in BenguFarm BEEF, sien paragraaf 66. 

 

84. Wagyu Karkas Data: (Slegs beskikbaar indien ras opgestel is as Wagyu) 
• Om karkas data van diere aan te teken (of verander/verwyder), gaan na Ander Data > Wagyu 

Karkas Data. 
 

Verslae 
85. My dierdata verslae: 

• Die My Dierdata Verslae funksie is baie kragtig om jou eie pasgemaakte (“customised”) 
verslae op te stel en te stoor vir latere gebruik. Gaan na Verslae > My Verslae > Dierdata. 

• Kliek bo-aan die skerm op Kies Diere (Kriteria) en dan onderaan op Kies Diere met Kies Diere Skerm 

OF stel kriteria op om diere te kies deur op die “+” regs onder-aan die skerm te kliek. Gebruik die HULP 

funksie indien nodig. 

• Kliek bo-aan die skerm op Verslag Kolomme (Uitleg) en kies onder die betrokke afdeling die velde 
wat jy wil insluit in die verslag. 

• Kliek bo-aan die skerm op Besigtig Verslag om te sien hoe die verslag gaan lyk. Indien jy die diere op 

‘n spesifieke veld wil sorteer, kliek op die betrokke kolom se opskrif.  

• Kliek onderaan die skerm op Vertoon Verslag. Kies Druk of Eksporteer. 

• Om die kriteria en/of die uitleg te stoor vir latere gebruik, kliek onderaan die skerm op Stoor Kriteria 
en Uitleg.  

• Om gestoorde kriteria en/of uitlegte te laai, kliek onderaan die skerm op Laai Kriteria en Uitleg. 

• Wenke: 

o Op die Verslag Kolomme skerm kan leë kolomme ook gekies word om byvoorbeeld opmerkings 

of notas aan te teken. 

o Op die My Verslae > Verslag Kolomme (Uitleg) in die kolom Opskrif van Kolom op Verslag, kan 

die verstek kolomopskrifte verander word met eie gekose opskrifte. Die nuut gekose 

kolomopskrifte kan gestoor word met die “stiffy” ikoon regs onderaan die skerm. 
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o Die gestoorde kriteria kan op die hoofskerm se groepfilter asook op die Kies Diere skerm gebruik 

word om diere te kies wat aan die kriteria voldoen. 

o Die My Dierdata Verslae kan gebruik word om jou eie uileg op te stel vir sekere verslae, bv. 

Diere per Kamp of Groep, Kuddelys, Stamboom of Nageslag Opsomming. 

o Onthou om ‘n rugsteun te maak van jou eie verslae se uitlegde. [Lêer > Rugsteun en Herstel > 

Rugsteun my Gestoorde Verslaguitlegde]. 

o Die My Dierdata Verslae het ‘n sekere beperkings in terme van die kolomme wat beskikbaar is 

om in te sluit in ‘n verslag. ‘n Ander opsie is om op die hoofskerm se Kudde Uitleg ‘n verslag te 

skep met die verlangde kolomme. Om dit te doen, sien paragraaf 5. 

 

86. Kudde ontleding: 
Gemiddeldes en tendense: 
• Die doel met die Gemiddeldes en Tendense verslag is om die gemiddeldde meting/berekende waarde  

van ‘n geselekteerde eienskap(pe) vir die betrokke kudde grafies te vergelyk vir ’n sekere tydperk, bv. 

om die gemiddelde speengewig van kalwers te vertoon per die jaar van geboorte vir ’n sekere tydperk. 

Let wel: By verstek word slegs aktiewe en onaktiewe diere met die betrokke kudde se kuddekenmerk 
ingesluit. Hierdie funksie kan ook gebruik word om vaders se nageslag gemiddeldes te vergelyk. 

• Om 'n Gemiddeldes en Tendense verslag te skep, gaan na Verslae > Kudde Ontleding > 

Gemiddeldes en Tendense. Gebruik die Hulp funksie indien nodig. 
 

Kudde Produksie: 
• Die doel met die Kudde Produksie Opsomming verslag is om die totale en gemiddelde produksie van die 

betrokke kudde vir ’n spesifieke tydperk (bv. vir ’n sekere jaar) te bereken vir ’n aantal parameters, bv. 
totale en gemiddelde speengewig en dit te vergelyk met ’n langtermyn tydperk. 

• Om 'n Kudde Produksie Opsomming verslag te skep, gaan na Verslae > Kudde Ontleding > Kudde 

Produksie Opsomming. 
 

Uitgawes aanteken in BenguFarm: 
• Dit word aanbeveel dat kostes en pryse sonder BTW aangeteken word. 

• Voorraad aankope: Die totale uitgawe vir die aankoop van voorraad kan op die volgende skerms 

aangeteken word: 
o Gesondheid > Enstowwe, Doseermiddels en Aanvullings Voorraad. 

o Gesondheid > Medisynes Voorraad. 
o Ander Data > Diverse Voorraad (bv. lek, voer, konsentrate). 

o Reproduksie > Semen Voorraad. 

• Uitgawe per dier: Sekere uitgawes kan in BenguFarm per dier aangteken word. Die volgende uitgawes 
kan per dier op die volgende skerms aanteken word:  

o Reproduksie > Sinchronisasie. 

o Reproduksie > Dekkings > Kunsmatige Inseminasies/Laparoskopieë. Let wel: Die strooitjie 
koste per dier ge-KI word outomaties bereken vanaf die Semen Voorraad, mits die Semen Tipe 

as Gevries gekies word op die KI skerm en die aankoop prys aangeteken is op die Semen 
Voorraad skerm. 

o Reproduksie > Dragtigheidsondersoeke. 

o Reproduksie > Embrio Inplantings. Let wel: Die koste per dier word nie outomaties bereken 
vanaf die Embrio Voorraad nie. 

o Gesondheid > Inentings, Doserings en Aanvullings. Let wel: Die koste per dier word outomaties 
bereken vanaf die Enstowwe, Doseermiddels en Aanvullings Voorraad, mits die besending 

nommer ingevul word. Indien 'n besendingnommer nie ingevul word nie, sal die laaste aankope 
se eenheidsprys (totale prys / # eenhede) gebruik word. 

o Gesondheid > Siekte Toetse. 

o Gesondheid > Siektes, Beserings en Behandelings. Let wel: Voorsiening word gemaak vir die 
aanteken van beide veearts en/of medisyne uitgawes. Die medisyne koste per dier word 
outomaties bereken vanaf die Medisyne Voorraad, mits die besending nommer ingevul word. 
Indien 'n besendingnommer nie ingevul word nie, sal die laaste aankope se eenheidsprys (totale 

prys / # eenhede) gebruik word. 

o Ander Data > Prosedures. Uitgawes vir prosedures (bv. vrugbaarheidstoetse, DNA analises, 
oorplaatjies, ens.) wat per dier gedoen word kan hier aangeteken word. 

o Ander data > Aankope. Koste by aankoop wat nie by die koopprys ingesluit is nie (bv. 
vervoerkoste) kan in die Koste per Dier-veld aangeteken word. 
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o Ander data > Verkope, Vrektes en Uitskotte. Koste by verkope wat nie by die verkoopprys 

ingesluit is nie, kan in die Koste per Dier-veld aangeteken word. 

• Uitgawe per Kamp: Sekere uitgawes (bv. lek uitgesit, voer uitgesit, kamp ontbos, voorbrande gemaak, 
heinings opgerig, ens.) kan nie per dier aangteken word nie, maar dit kan wel per kamp aangeteken 

word. In ag genome die aantal diere in die kamp, kan ‘n gemiddelde koste per dier wel bereken word. 

Hierdie tipe uitgawes per kamp kan op die Kamp Aktiwiteite skerm [Ander Data > Kamp Aktiwiteite] 
aanteken word: Let wel: Indien die betrokke item, bv. winterlek, aangeteken is by Diverse Voorraad en 

die betrokke voorraad item gekies word op die Kamp Aktiwiteite skerm, sal die uitgawe outomaties 
bereken word. Andersins kan die uitgawe aangeteken word op die Kamp Aktiwiteite skerm. 

• Uitgawe per Kudde: Sekere uitgawes (bv. arbeid, brandstof, telersgenootskap fooie, ens.) kan nie per 

dier of per kamp aangteken word nie, maar dit kan wel aangeteken word as algemene uitgawes vir die 
betrokke kudde. Hierdie tipe uitgawes per kudde kan op die Algemene Kudde Uitgawes skerm [Ander 

Data > Algemene Kudde Uitgawes] aanteken word. Wenk: Indien jy meer as een kudde op dieselfde 

databasis het, kan, waar van toepassing, algemene uitgawes in die ALL kudde aangeteken word. 
Uitgawes wat per dier aangeteken kan word (bv. vrugbaarheid ondersoeke, dragtigheid ondersoeke, 

DNA analises) maar wat nie per dier aangeteken is nie, kan hier as ‘n totale uitgawe vir die betrokke 
kudde aangeteken word. 

 

Kudde Inkomste en Uitgawes Opsomming: 
• Die doel met die Kudde Inkomste en Uitgawes Opsomming verslag is om die inkomste en uitgawes vir 

die betrokke kudde per item vir ’n spesifieke tydperk (bv. vir ’n finansiële jaar) te bereken. 

• Om 'n Kudde Inkomste en Uitgawes Opsomming verslag te skep, gaan na Verslae > Kudde 

Ontleding > Kudde Inkomste en Uitgawes Opsomming. Let wel: Voorrade aangekope (sien hierbo) sal 
nie as uitgawe verskyn op hierdie verslag nie. Dit sal slegs as uitgawe verskyn indien die gebruik daarvan 

aangeteken is per dier, kamp of kudde. 

 

Data Stuur/Trek In: 
87. Stuur dierfotos na Logix (Slegs van toepassing op kuddes wat lid is van SA Stamboek se 

Logix Beef) 
• Telers van rasse wat SA Stamboek as diensverskaffer gebruik, kan fotos van diere direk vanuit 

BenguFarm na Logix stuur. Hierdie foto word dan op die betrokke dier se profiel op Logix gelaai en is 

beskikbaar vir, onder andere, voornemende kopers. 

• Om ‘n foto van ‘n dier direk vanuit BenguFarm na Logix te stuur, gaan na Data Stuur/Trek In > 
Stuur > Stamboek/LNR > Dier Fotos. Gebruik die Hulp funksie indien nodig. Die verstek foto van die 

gekose dier(e) sal gestuur word. Indien geen foto as ‘n verstek foto gemerk is in BenguFarm nie, sal ‘n 
foto lukraak gekies word uit die beskikbare fotos van die betrokke dier. 

 

88. Stuur Fase C / D Prestasietoets Aansoek na diensverskaffer 
• Sien paragraaf 67. 

 

89. Voerinnames intrek vanaf voerstelsel: 
• Om voerinnames vanaf ’n voerstelsel in te trek in BenguFarm BEEF, moet jy by die voerstelsel ’n lêer (in 

CSV formaat) skep met die betrokke diere se nommers en voerinnames.  

• Om die CSV lêer met voerinnames in te trek, gaan na Data Stuur/Trek In > Trek In > Voerinnames 
vanaf Voerstelsel. Kliek regs bo-aan die skerm en kies die CSV lêer wat ingetrek moet word. Kies die 

intrek opsies van toepassing en kliek Trek In. 

• Indien die betrokke voerstelsel se lêeruitleg nog nie voorheen opgestel en gestoor is ’n uitleg nie, moet 
dit eers gedoen word. Om die betrokke voerstelsel se lêeruitleg op te stel, kliek by Kies 

Elektroniese Formaat op die Voeg By en Verander Elektroniese Lêerformate (rooi notaboekie ikoon). Om 

’n nuwe formaat op te stel, kliek op Nuwe en voltooi die besonderhede. By Kolomme in Elektroniese 
Lêer, spesifiseer watter data in watter kolom in die CSV lêer voorkom. Dit word gedoen deur op die “+” 

regs onder op die skerm te kliek. Kliek nou onder die kolomopskrif “Data in hierdie Kolom” en kies die 
data wat in kolom nr 1 (of kolom A) voorkom. Herhaal vir al die kolomme wat jy wil intrek. Indien ’n 

spesifieke kolom se data nie ingetrek moet word nie, kies die opsie “Data Nie van Toepassing”. Stoor. 
Kontak jou BenguFarm agent vir hulp, indien nodig. 

• Om ’n verslag te skep van voerverbruik, gaan na Verslae > Gewigte, Mates, Prestasietoetsing en 

Teelwaardes > Voerverbruik.  
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Opstellings: 
90.  My diervelde: 

• Indien jy data wil aanteken waarvoor daar nie elders voorsiening gemaak is nie (bv. Oogpigment 

Persentasie), kan jy jou eie velde hiervoor opstel. Om dit te doen, gaan na Opstellings > My Diervelde. 

• Om data in hierdie velde aan te teken, gaan na Diere > Verander Diere (Tabel Uitleg) OF gaan na Diere 
> Voeg by & Verander Diere (Enkel Dier Uitleg) > My Velde. 

• Om data aangeteken in hierdie velde op te kyk op die hoofskerm, gaan op die Dier Uitleg na die My 

Velde opkykskerm. Om dit op die Kudde Uitleg te vertoon, gaan op die hoofskerm se Kudde Uitleg na 

Vertoon Opsies, merk die betrokke veld(e) onder die My Kolomme afdeling en kliek op Stoor Opsies as 

Kudde Verstek. Maak BenguFarm toe en weer oop, gaan op die hoofskerm se Kudde Uitleg na die My 

Kolomme afdeling. 

• My Dierdata velde kan slegs op die My Dierdata Verslae ingesluit word deur te gaan na Verslae > My 

Verslae > Dierdata. Kliek op Verslag Kolomme (Uitleg) en kies dan My Velde. 
 

Opsies: 
91. Besigtig/opdateer my rekeningbesonderhede: 

• Om jou BenguFarm rekeningbesonderhede aanlyn op te kyk en/of sekere inligting te 

opdateer, gaan na Opsies > Besigtig/Opdateer my Rekeningbesonderhede.  

• Hierdie skerm kan ook gebruik word om die nuutste lisensiefaktuur aan te vra indien jy dit nie ontvang 

het nie of verlê het.  

• Let wel: Hierdie funksie sal slegs werk indien die rekenaar aanlyn is, die BenguFarm rekeningnommer 

(BPU….) aangeteken is in BenguFarm en die rekeningnommer en die betrokke databasis se Rekenaar 
Identifikasie Kode op die BenguFarm admin stelsel aangeteken is. Indien jou rekenaar nie toelaat dat jy 

konnekteer nie, de-aktiveer jou rekenaar se anti-virus program tydelik en probeer weer. 
 

92. Aksie sleutels 
• Die doel met aksiesleutels is om vinnig sekere info wat gereeld gebruik word, bv. jou kudde se 

kuddekenmerkletters, in te voeg wanneer ’n dier opgesoek word op ID nommer. Gestel jou kudde se 

kuddekenmerkletters is ABC. Jy kan dan hierdie letters as ’n aksiesleutel opstel. 

• Om ’n aksiesleutel op te stel, kliek op die “+” regs onderaan die Definieer Aksie Sleutels skerm, vul 
die betrokke letters (bv. ABC) in in die Waarde om te Vertoon kolom, kies ’n F-sleutel (bv. F2) in die 

Sleutel kolom en Stoor. 

• Wanneer ’n dier se nommer ingetik moet word, druk die Function (Fn) en die betrokke F-sleutel (bv. F2) 
gelyktydig op die sleutelbord. In die voorbeeld hierbo, sal die ABC dan ingetik wees. 

 

93. Maak databasis leeg:  
Hierdie funksie word slegs in uitsonderlike gevalle gebruik om ’n databasis leeg te maak. Jou BenguFarm 

agent sal jou na hierdie funksie verwys wanneer nodig en aan jou die wagwoorde verskaf om toegang te 
kry tot hierdie funksie. Let wel: Dit word sterk aanbeveel dat ‘n rugsteun gemaak word van die betrokke 

databasis voordat hierdie funksie gebruik word. 

 

Toevoegings 
94. Voerkraal bestuurder: 

Hierdie is 'n een-venster funksie waar Bestuursperiode groepe geskep kan word, diere in ’n spesifieke kraal 

aan gekoppel kan word aan en, indien nodig, geskuif kan word tussen krale. Kraalaktiwiteite, insluitende 

hoeveelhede voer wat uitgesit word, kan aangeteken word. Individuele diererekords kan aangeteken word 
vir aankoop inligting, inentings, gesondheid inskrywings, gewigte en verkoop/slagdata. Per-dier berekeninge 

word gedoen vir gewigstoename, laaste twee GDTs, koste, inkomste en netto wins. Bestuursperiode groep 
opsommings word verskaf vir totale voerhoeveelhede, gemiddelde voeromsetverhouding, gemiddelde GDT, 

totale koste, inkomste en netto wins. Gebruik die Help funksie indien nodig. 
 

95. Veearts Netwerk: 
Veearts Netwerk is 'n netwerk van veeartse wat fokus op die instandhouding en verbetering van 

lewendehawe gesondheid, produksie en welsyn in Suid-Afrika. Alle deelnemende lede besit en bedryf 
onafhanklike veeartsenykundige praktyke wat lewendehawe gesondheidsdiensdienste verskaf, maar hierdie 

veeartse spandeer die grootste deel van die dag om rond te gaan om siek diere te help en te red. Daar is 
nooit genoeg tyd om die lewendehawe eienaar te voorsien van inligting oor siekte voorkomende planne en 

koste-effektiewe vee-middels nie. Veearts Netwerk is gestig om ondersteuning te bied aan die netwerk van 

deelnemende landelike veeartsenykundige praktyke en hul lewendehawe kliënte. Dit word gedoen deur die 
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ontwikkeling van lewendehawe siekte tendense, die verskaffing van relevante inligting oor lewende hawe 

gesondheid inligting en 'n gestruktureerde rekenaarprogram vir die ontwikkeling van koste-effektiewe planne 
vir die voorkoming van siektes vir elke lewendehawe-kliënt. 

 

Deelnemende veeartse kan 'n gestandaardiseerde bestuursplan(e) aan 'n kliënt toewys of kan, in oorleg met 
die kliënt, 'n persoonlike bestuursplan opstel. Bestuursplanne word aan die begin van elke maand per e-pos 

aan kliënte van deelnemende veeartse gestuur. 
 

Deur middel van die Veearts Netwerk funksie in die BenguFarm BEEF en SHEEP & GOATS modules, kan 
kliënte van deelnemende veeartse die bestuursplanne in BenguFarm integreer as 'n interaktiewe Veearts 

Netwerk Kalender. Hierdie kalender bevat ook prestasietoetsdatums en persoonlike dagboekinskrywings wat 

jy in die standaard BenguFarm kalender geskep het. 'n Gebruiker kan op 'n item in die Veearts Netwerk 
Kalender kliek. Dit sal inligting soos die groep diere wys waarop die aksie van toepassing is, ouderdom, siklus 

stadium, beskrywing van die aksie, hoe gereeld die aksie moet plaasvind en, waar van toepassing, watter 
behandeling of aksie saam met die voorgestelde dosis toegedien moet word. In sommige gevalle is 

addisionele inligting beskikbaar in die vorm van 'n PDF dokument wat afgelaai en  na kyk kan word. Die 

Veearts Netwerk Kalender sal ook die diere lys wat tans van toepassing is op die aksie. Die gebruiker kan 
dan werklyste druk, die diere aan groepe koppel of dit oopmaak in ‘n My Dierdata verslag. Dit behoort 

duidelik te wees dat die Veearts Netwerk Kalender 'n alternatief is vir die ingeboude BenguFarm 
Bestuurskalender. Die twee is nie bedoel om interaktief te werk nie, met die Veearts Netwerk Kalender wat 

meer funksionaliteite en inligting verskaf. Die Veearts Netwerk Kalender sal ook in die komende weergawes 
van die Veearts Netwerk Daily Observation Card (DOC) app wees. Die DOC-program is beskikbaar vir Android 

fone en -tablette van die Google Play-Store. 

 
Jy moet aanteken om die geïntegreerde Veearts Netwerk Kalender te kan gebruik. Om aan te 

teken, gebruik dieselfde gebruikersnaam en wagwoord wat jy op die Veterinary DOC App 
gebruik. Jy kan gratis by die Veearts Netwerk met die DOC App registreer. Soos hierbo genoem, om hierdie 

geïntegreerde funksies te kan gebruik, moet jou veearts 'n persoonlike bestuursplan(e) vir jou kudde(s) 

opstel of een van sy/haar standaardpraktykplanne aan jou toewys. Vir hulp hieroor, kontak asseblief jou 
plaaslike veearts. As jou veearts nie 'n Veearts Netwerk lid is nie, kontak asseblief vir Dr. Danie Odendaal 

(vnet@absamail.co.za) vir hulp. 
 

Hulp 
96. Teamviewer afstand ondersteuning: 

• Die BenguFarm agente gebruik TeamViewer sagteware om aanlyn ondersteuning te lewer direk op jou 
rekenaar.  

• Indien jy nie TeamViewer sagteware op jou rekenaar het nie, kan jy dit aflaai en installeer by 

www.teamviewer.com. Indien jy tydens installasie by tipe gebruik “Personal” kies, is gebruik van die 
program gratis. 

• Indien Teamviewer geïnstalleer is, kan dit, wanneer nodig vir aanlyn ondersteuning, direk vanuit 

BenguFarm oopgemaak word op die hoofskerm by Hulp > Teamviewer Afstand Ondersteuning. 

Om die Teamviewer sagteware te opgradeer na die nuutste weergawe, kliek op Laai Nuutste Teamviewer Af. 
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Bylaag A 
 

Opsomming – Basiese Take om te doen in BenguFarm 
BEEF 

(Kronologiese volgorde) 
 

 

1. Voor die Teelseisoen: 
1.1. Stel die nuwe Kalfseisoen op [Opstellings > Kalfseisoene]. 

1.2. Maak seker dat al die koeie, verse en teelbulle (insluitend KI bulle) op rekord is in BenguFarm BEEF. Indien 
nodig, trek die betrokke diere se Logix data in [Data Stuur/Trek In > Logix Direk > Trek Diere In] of skep 

dier rekords met die hand [Diere > Voeg Diere by Wizard]. Merk die teelbulle as "Teel/KI Bul" [Diere> Voeg 

by en Verander Diere (Enkel Dier Uitleg)]. 
1.3. Druk 'n lys van teelbare verse en koeie [Verslae > Dekkings, Dragtighede en Kalwings > Dekbare Verse en 

Koeie (aantekenlys)]. 
1.4. Bereken die intelingpersentasies van nageslag vir beplande parings [Reproduksie> Inteel Berekening vir 

Beplande Parings], OF 

1.5. Gebruik die GENETICS telingsmodule om die beste parings vir jou spesifieke teeldoelwitte te bepaal 
[Reproduksie > BenguFarm GENETICS Telingsbestuur Module]. 

1.6. As verse en/of koeie gesinchroniseer word, teken die sinchronisasies aan [Reproduksie > Synchronisasie]. 
 

2. Begin van die Teelseisoen: 
2.1. Druk 'n lys, indien nodig, om werklike dekbesonderhede (datum, bul, koei, ens.) aan te teken [Verslae > 

Dekkings, Dragtighede en Kalwings > Dekkings (aantekenlys)]. 

2.2. Teken die dekkings aan op BenguFarm BEEF [Reproduksie > Dekkings > Natuurlike Dekkings of Kunsmatige 
Inseminasies/Laparoskopieë]. 

2.3. Druk 'n verslag van die bestaande dekkings [Verslae > Dekkings, Dragtighede en Kalwings > Bestaande 

Dekkings (Deklyste)]. 
 

3. Einde van die Teelseisoen: 
3.1. STOETTELERS: Stuur die dekkingsdata in elektroniese (csv) formaat na SA Stamboek of die LNR  [Data 

Stuur/Trek In > Stuur > Stamboek/LNR > Dekkings]. 

 

4. Dragtigheidsondersoeke: 
4.1. Druk 'n lys om die dragtigheidsondersoek uitslae op aan te teken [Verslae > Dekkings, Dragtighede en 

Kalwings > Koeie & Verse vir Dragtigheidsondersoek (aantekenlys)]. 

4.2. Teken die dragtigheidsondersoek uitslae aan op BenguFarm BEEF [Reproduksie > Dragtigheidsondersoeke]. 

4.3. Druk 'n verslag van die dekkings en dragtighede [Verslae > Dekkings, Dragtighede en Kalwings > Dekkings 
en Dragtighede]. 

4.4. Druk 'n verslag met 'n opsomming van dekkings en dragtighede per bul en/of seisoen [Verslae > Dekkings, 
Dragtighede en Kalwings > Dekopsomming per Bul en/of Seisoen]. 

 

5. Voor die Kalfseisoen: 
5.1. STOETTELERS: Stel nuwe geboorte kontemporêre groepe op [Opstellings > Geboorte Kontemporêre 

Groepe]. 
5.2 Druk 'n verslag van die verse en koeie naby kalwing [Verslae > Dekkings, Dragtighede en Kalwings > Verse 

en Koeie naby Kalwing (aantekenlys)]. 

 

6. Tydens die Kalfseisoen: 
6.1. Teken die kalwings (en kalwers) aan [Reproduksie > Kalwings]. 

6.2. STOETTELERS: Stuur nuwe geboortes in elektroniese (csv) formaat na SA Stamboek of LNR [Data Stuur/Trek 
In > Stuur > Stamboek/LNR> Geboortekennisgewings]. 

6.3. Trek die lêer (BIRTHS...) met die rekenaarnommers wat van Logix ontvang is, in BenguFarm BEEF in [Data 
Stuur/Trek In > Logix Direk > Trek Ontbrekende Rekenaarnommers In]. 
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7. Einde van die Kalfseisoen: 
7.1. Druk 'n verslag van die verse en koeie wat gekalf of nog nie gekalf het nie [Verslae > Dekkings, Dragtighede 

en Kalwings > Verse en Koeie Gekalf /Nog nie Gekalf (aantekenlys)]. 

7.2. Druk ’n verslag van kalwers gebore in die kalfseisoen [Verslae > Dekkings, Dragtighede & Kalwings > 

Geboortes]. 
7.3 Druk 'n verslag met 'n opsomming van dekkings, dragtighede en kalwings per bul en/of seisoen [Verslae > 

Inspeksies en Seleksies > Dekking Opsomming per Bul en/of Seisoen]. 
7.4. Druk 'n verslag van die koeie wat swak presteer volgens sekere reproduksie- en dragtigheid minimum 

standaarde [Verslae > Dekkings, Dragtighede en Kalwings > Reproduksie en Dragtigheid Seleksie]. 

7.5 Indien dit nie reeds outomaties bereken is deur BenguFarm nie, bereken weegdatums vir prestasietoetsing 
vir kalwers gebore in hierdie kalfseisoen [Prestasietoetsing > Bereken Geldige Weeg/Toetsdatums]. 

 

8. DNA Ouerskap Kontrole (STOETTELERS, wanneer nodig): 
8.1. Druk 'n DNA diensaanvraagvorm wat saam met die betrokke diere se biologiese monsters na die DNA 

laboratorium gestuur moet word [Data Stuur/Trek In > Stuur > DNA Profieleringdienste Vorms en kies die 
betrokke laboratorium wat jy gebruik]. 

8.2. Druk etikette vir die merk van die koeverte waarin biologiese monsters van diere geplaas word vir instuur 
na na ‘n biobank of ‘n DNA laboratorium [Data Stuur/Trek In > Stuur > DNA Profieleringdienste Vorms > 

Druk Biologiese Monster Etikette]. 

8.3  Trek die ouerskapverslag lêer wat van SA Stamboek (via die DNA laboratorium) ontvang is in BenguFarm 
BEEF in vir opname van die DNA nommers en opdatering van die betrokke diere se korrekte ouers volgens 

die ouerskap uitslae [Data Stuur/Trek In > Logix Direk > Trek DNA Ouerskappe], OF 
8.3. Teken die toepaslike diere se DNA nommers in BenguFarm BEEF aan wanneer jy die ouerskapverslag van 

die DNA-laboratorium ontvang. [Diere > Verander Diere (Tabel Uitleg)]. 
 

9. Diere Ent, Doseer, Dip en Aanvullings gee: 
9.1 Druk ‘n lys vir die aantekening van inentings, doserings, dip en aanvullings [Verslae > Siektes, Voorkoming 

en Behandeling > Inentings, Doserings, Dip, Aanvullings en Prosedures (aantekenlys)]. 

9.2 Teken inentings, doserings, dip en aanvullings aan [Gesondheid > Inentings, Doserings, Dip en Aanvullings]. 

9.3 Druk ‘n verslag van inentings, doserings, dip en aanvullings [Verslae > Siektes, Voorkoming en Behandeling 
> Inentings, Doserings, Dip en Aanvullings].  

 

10. Weeg Diere: 
10.1. Druk 'n lys vir die aantekening van diere se gewigte tydens weging [Verslae > Gewigte, Mates, 

Prestasietoetsing en Teelwaardes > Weeglys (aantekenlys)]. 
10.2. Indien van toepassing, trek gewigte van die skaal in BenguFarm BEEF in (waar van toepassing) [Data 

Stuur/Trek In > Trek In > Gewigte van Skaal of Tru-Test XR5000 Integrasie] OF 
10.3. Teken aan en verwerk die gewigte vir prestasietoetsdoeleindes [Prestasietoetsing > Gewigte vir 

Prestasietoetsing]. 
10.4. STOETTELERS: Stuur die prestasietoetsdata in elektroniese (csv) formaat na Stamboek of die LNR [Data 

Stuur/Trek In > Stuur > Stamboek/LNR > Prestasietoetsdata]. 

10.5. STOETTELERS: Trek die lêer (BEEFTEST...) met die amptelike prestasietoetsdata wat ontvang is van Logix 
in BenguFarm BEEF in [Data Stuur/Trek In > Logix Direk > Trek Amptelike Prestasietoetsdata In]. 

10.6. Druk 'n verslag van die diere se verwerkte gewigte (indekse, ens.) [Verslae > Gewigte, Mates, 
Prestasietoetsing en Teelwaardes > Prestasietoetsresultate]. 

10.7. Druk 'n verslag van die diere se gewigte en toenames (vir gereelde weging, bv. in 'n groeitoets of voerkraal) 

[Verslae > Gewigte, Mates, Prestasietoetsing en Teelwaardes > Gewigte en Toenames]. 
 

11. Voor Speen (STOETTELERS, indien van toepassing) 
11.1. Voltooi die nodige Op-die-plaas (Fase D) en/of Sentrale (Fase C) Prestasietoetse aansoekvorms en stuur 

dit na die LNR of Stamboek. [Data Stuur/Trek In > Stuur> LNR/Stamboek > Fase C/D Prestasietoets 

Aansoek]. 
 

12. Wanneer nuwe Teelwaardes (EBVs) beskikbaar is: (slegs STOETTELERS) 
12.1. Trek nuwe teelwaardes in BenguFarm BEEF in met die Logix Direk opsie [Data Stuur/Opneem > Logix 

Direk > Trek Teelwaardes In]. 

 

13. Voor Inspeksie van Diere: (slegs STOETTELERS) 
13.1 Skep ‘n inspeksie verslag van diere wat geïnspekteer moet word. [Verslae > Inspeksies en Seleksies > 

Inspeksie Lys]. 
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14. Na inspeksie van Diere: (slegs STOETTELERS): 
14.1. Trek die lêer (INSPECTIONS...) met die inspeksie data wat ontvang is van Logix in BenguFarm BEEF in 

[Data Stuur/Trek In > Logix Direk > Trek Inspeksies In]. 

 

15. Diere Verkoop, Geslag, Uitgeskot, Gevrek of Verlore geraak: 
15.1. Vir veilings of uit-die-hand-verkope, druk 'n veilingskatalogus [Verslae > Aankope, Veilings,  Verkope, 

Vrektes en Uitskotte > Veilingskatalogus]. 

15.2. Teken die verkope en die uit-kudde data aan van diere wat verkoop is of die kudde verlaat het vir ander 
redes [Ander Data > Verkope, Vrektes en Uitskotte]. 

15.3. Druk 'n verslag van die diere wat verkoop is, of die kudde verlaat het vir ander redes [Verslae > Aankope, 
Veilings,  Verkope, Vrektes en Uitskotte > Verkope, Vrektes en Uitskotte]. 

15.4. STOETTELERS: Stuur die oordrag en/of kansellasie kennisgewings in elektroniese (csv) formaat na SA 
Stamboek of die LNR [Data Stuur/Trek In > Stuur > Stamboek/LNR > Oordragte en Kansellasies]. 
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Bylaag B 
 

Intrek van Data wat in Excel aangeteken is 
 

 

Met hierdie funksie kan sekere dierdata wat in ‘n Excel lêer aangeteken is, ingetrek word in BenguFarm. Hierdie 
funksie is spesifiek vir kuddes wat nie data vanaf ’n ander bron (bv. Logix) kan intrek nie.  

 
Om ’n lys te sien van al die data wat vanaf Excel in BenguFarm ingetrek kan word, sien die tabel aan die einde van 

Bylaag B. 
 

Vir die program om optimaal te funksioneer, moet daar gepoog word op minstens die volgende data in te trek: 

Dier ID Nr, Geslag, Geboortedatum, Ras- of Spesiekode en Statuskode. Indien die presiese geboortedatum van ’n 
dier onbekend is, kies ’n benaderde datum, byvoorbeeld 01-10-2018 vir diere gebore in 2018. 

 

Stappe om data voor te berei en in te trek: 
NB: Maak eerstens seker dat die "List Separator" en “Decimal Symbol” opstellings in Windows korrek is. Gaan 

na Control Panel > Region > Additional Settings > List Separator. Die "List Separator" moet 'n komma "," te wees. 
Indien dit ‘n kommapunt ";" is, verander dit na ‘n komma. Die "Decimal Symbol" moet 'n punt "." wees. Indien dit 

komma “,” is, verander dit na ‘n punt “.”. Kliek Apply en OK. 
1. Voorbereiding van data om dit in te trek: 

1.1. Skep vir elke kudde ‘n aparte Excel lêer.  

1.2. Vir elke dier in die kudde (koeie, verse, kalwers en bulle) waarvan jy data wil intrek in BenguFarm BEEF, 
moet jy sorg dat alle beskikbare data (bv, Dier ID Nr, Geboortedatum, Geslag, Moeder ID Nr, Vader ID 

Nr, ens.) in dieselfde Excel lêer en een blad (“sheet”) is. Indien jy data van vanaf meer as een blad wil 
intrek, maak seker dat die Dier ID No en Geslag presies dieselfde is op al die blaaie om te verhoed dat 

duplikaat dierrekords geskep word met die intrek van die addisionele data in BenguFarm.  

1.3. Behalwe vir die kolomopskrifte, verwyder al die lyne wat nie dierdata bevat nie, bv. leë lyne, opsommings, 
ens. 

1.4. Vir data waar daar meer as een rekord is vir 'n spesifieke tipe data (bv. wegings aangeteken op meer 
as een datum), moet daar vir elke bykomende rekord (bv. weegdatum en gewig) 'n aparte lyn in die Excel 

blad geskep word om al die rekords in te trek. 
1.5. Maak seker dat die datums in die Excel lêer in een van die volgende twee formate gestoor is, nl. 

dd/mm/yyyy of yyyy/mm/dd. Bv 30 Nov 2010 moet gestoor wees as 30/11/2010  of 2010/11/30. Die "/" 

kan enige karakter wees, bv. “-“. Jy kan Excel se “Cell Formatting” funksies gebruik om datums te verander 
wat nie in die korrekte formaat is nie. Dit behoort die datums reg te formateer, afhangende van hoe die 

datums oorspronklik in Excel ingetik is. As 'n datum nie gespesifiseer is nie of nie in die korrekte formaat is 
nie, sal daardie datums geskep/verander word na 01/01/1980 wanneer die data ingetrek word. 

1.6. Vir moeders en vaders om korrek gekoppel te word aan ’n dier, moet die IDnr van die vaders en moeders 

PRESIES ooreenstem met die IDnr waar hulle in die lêer as 'n dier gelys is. (Kleinletters sal outomaties na 
hoofletter omgeskakel word). As ’n moeder of vader nie self as 'n dier gelys is nie, sal 'n dier wel geskep 

word met default waardes. Indien die moeder of vader onbekend is, los bloot die betrokke veld in die Excel 
lêer leeg. 

1.7. Ten einde Ras, Status (A = Akief – Lewendig in die kudde of na = Onaktief - Dood/Verkoop/Nie in kudde) 
en Voorkoms Opmerkings in te trek, moet die Status, Ras, en Opmerking kodes ooreenstem met die 

Rase, Status en Voorkoms Opmerkings kodes in BenguFarm.  

1.8. Ten einde die Kampe te kan intrek, moet die betrokke kampe reeds opgestel wees in BenguFarm 
(Opstellings > Plaas Kampe). In die CSV lêer wat ingetrek moet word, moet die Kamp kodes aangeteken 

wees en dit moet ooreenstem met die Kamp kodes in BenguFarm. 

1.9. Daar mag geen kommas in enige velde wees nie. Alle desimale moet punte wees en in die 

notas veld mag daar nie kommas wees nie. 

1.10. Vervang alle ‘ tekens (indien enige) met ` (links van 1 op sleutelbord). 

1.11. Berekenings (soos ouderdom, tussenkalfperiodes en horinggroei) kan nie ingetrek word nie – dit sal in 

die program bereken word nadat die data ingetrek is, mits die data benodig vir die berekenings beskikbaar 

is. 

1.12. Stoor die Excel (xls of xlsx formaat) lêer in CSV (Comma Delimited) formaat. Om dit te doen, maak 

die betrokke lêer oop in Excel, gaan na File > Save As... en kies by File Type "CSV - Comma Delimited” 

formaat en kliek op “Save”. Indien daar meer as een blad (“sheet”) in die Excel lêer is, moet 
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elkeen apart na ‘n CSV lêer gestoor word en apart ingetrek word, aangesien jy slegs een blad in 

‘n CSV lêer kan stoor. 

1.13. Maak die CSV lêer in Notepad oop (nie Excel) en kontroleer die volgende: 

1.13.1. Maak seker die List Separator is ‘n komma (,), nie ‘n kommapunt (;) nie. Indien nodig, kan die 

List Separator opstelling verander word deur te gaan na Computer > Control Panel > Regional > 

Additional Settings > List separator. 

1.13.2. Maak seker lang nommers (veral DNA nommers) is nie omgeskakel in eksponent formaat wanneer 

die lêer in CSV formaat gestoor word nie. 

1.14. Maak ‘n nota in watter lyn/ry die data in die CSV lêer begin. Kolomopskrifte moet byvoorbeeld nie 

ingetrek word nie. 

 
Voorbeeld van data formaat vir intrek in BenguFarm: 

 

ID No Geslag Geb Datum Ras Status Kamp Moeder Vader Gewig Weegdatum 

130124 M 15-10-2013 BON A K1   235 01-05-2014 

140020 V 01-10-2014 BON A K1   210 03-05-2015 

150001 V 01-10-2015 BON A K1   195 03-05-2016 

150002 V 01-10-2015 BON A K1   215 03-05-2016 

150025 V 01-10-2015 BON A K1   220 03-05-2016 

160011 V 03-09-2016 BON A K1   205 15-05-2017 

160036 M 27-09-2016 BON A K1   233 15-05-2017 

160036        450 20-11-2017 

160123 V 11-11-2016 BON A K1   182 15-05-2017 

170001 V 01-09-2017 BON A K2 140002 130124 210 02-05-2018 

170002 V 03-09-2017 BON A K2  130124 225 02-05-2018 

170003 V 05-09-2017 BON A K2  130124 218 02-05-2018 

 

2. Trek die data in vanaf die CSV formaat lêer in BenguFarm: 
2.1. Gaan in BenguFarm na die spesifieke kudde waarvoor jy data wil intrek. 

2.2. Data moet verkieslik op 'n leë databasis ingetrek word. As jy ’n tweede keer ‘n lêer intrek op dieselfde 

databasis, sal BengFarm BEEF kontroleer of daar reeds diere is met PRESIES dieselfde ID Nr en geslag. 
Maak dus seker dat die Dier ID No en geslag presies dieselfde is om te verhoed dat duplikaat dierrekords 

geskep word. Om verder te verhoed dat duplikaat diere geskep word, verwyder die regmerkie by Skep Diere 
wat nie Bestaan nie onder Intrek Opsies. 

2.3. Gaan na Data StuurTrek In > Trek In > Databasis > Oop Lêerformaat (CSV). 

2.4. Kliek regs bo-aan die skerm op “Soek...” en kies die csv lêer van die spesifieke kudde wat jy wil intrek. 

2.5. Intrek opsies: 

2.5.1. By “Data Begin op Lyn #” kies op watter lyn die data in die csv lêer begin. (Kolomopskrifte 
moet nie ingetrek word nie). 

2.5.2. Kies die toepaslike intrek opsies. Indien onseker, behou die verstek opsies. 

2.6. Spesifiseer watter data in watter kolom in die CSV lêer voorkom. Dit word gedoen deur op die “+” 
regs onder op die skerm te kliek. Kliek nou onder die kolomopskrif “Data in hierdie Kolom Gestoor” en kies 

die data wat in kolom nr 1 (of kolom A) voorkom. Herhaal vir al die kolomme wat jy wil intrek. Indien ’n 
spesifieke kolom se data nie ingetrek moet word nie, kies die opsie “slaan oor – moenie intrek nie”.  

2.7. By “Geslag, Manlik=” in die “Waar/Ja=” kolom (heel regs) vul in wat in die geslag kolom in die csv lêer 

staan by manlike diere, bv. “M”. Slegs die diere met “M” in daardie kolom sal ingetrek word met geslag as 
manlik, die res outomaties as vroulik. 

2.8. Wanneer al die kolomme wat ingetrek moet word gespesifiseer en gekontroleer is, kliek op “Trek In”.  
2.9. Let op dat diere se name verander word na hoofletters wanneer die data ingetrek word. 

2.10. Indien die dierrekords vir een of ander rede nie korrek ingetrek het nie, moet die foutiewe 

rekords eers verwyder word voordat die data weer ingetrek word. Die data kan as volg verwyder word: 

2.10.1. Gaan na Diere > Verander Diere (Tabel formaat).  

2.10.2. Kliek op Laai Nuwe Seleksie van Diere (regs bo-aan die skerm), skakel die Nie-aktiewe filter (regs 

bo-aan die skerm) aan, kies alle diere (gebruik die Hulp funksie indien nodig). 

2.10.3. Kliek Verwyder Rekords (regs onderaan die skerm) en Stoor. 
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Data wat vanaf ‘n CSV lêer ingetrek kan word in BenguFarm 
 

Algemene Dier Data: 
Dier ID nr (visueel) 

Registrasienommer 
Geboortedatum 

Geboortedatum Onseker 

Kalfseisoen (kode) 
Geboorte Status (Enkel, 

Tweeling, Drieling) (kode) 
Vader ID nr 

Vader KKM, Jaar, Volgnr. 
Vader EID (mikroskyfie) nr  

Moeder ID nr 

Moeder KKM, Jaar, Volgnr. 
Moeder EID (mikroskyfie) nr 

Ontvanger Koei ID nr 
Dekkingstipe (kode) 

Ras (kode) 

Sub-ras (kode) 
Afdeling (kode) 

Kleur (kode) 
Geslag 

Kuddemerk 

Jaar (van geboorte) 
Volgnommer 

Dier ID (amptelik) 
Dier Naam 

Familielyn 
Nie vir Registrasie 

Geïnspeketeer 

Inspeksie Datum 
Goedgekeur 

Mikroskyfie Nommer (EID) 
Mikroskyfie Plek Ingeplant 

Mikroskyfie Datum Ingeplant 

DNA Nommer 
Boekwaarde 

Markwaarde 
Skaalnommer 

Naspeurbaarheid Nommer 
Voorkoms Opmerkings 

(kode) 

Notas 
Status (kode) 

Teler 
Eienaar 

Groepe 

Gekastreer 
Kastreer Datum 

Kamp Verskuiwing Data: 
Kamp (kode) 

Datum geskuif 

Rede geskuif (kode) 
Siektes & Behandelings 

Data: 
Datum Siek  

Veearts Naam  
Siekte/Besering (kode) 

Medisyne/Behandeling (kode) 

Opmerking 

Inentings, Doserings en 
Aanvullings Data: 

Datum Geënt 
Veearts Naam 

Geënt Teen (kode) 

Middel (kode) 
Dosis 

Koste 
Opmerking  

Veearts Besoek Data:  
Veearts Besoek Datum  

Veearts Naam  

Dekkings Data: 
Kalfseisoen (kode) 

Dektipe (Nat=1; KI=2; EI=3) 
Bul ID nr 

Bul 2 ID nr 

Multi Bulle 
Datum In 

Dutum Uit 
Dragtigheid Data: (Vroulike diere) 

Ondersoek Datum 

Dragtig (Ja/Nee) 
Periode Dragtig 

Periode Tipe [(W)eke / (M)aande] 
Siklus (kode) 

# Fetusse (1, 2, 3) (kode) 
Gewigte & Eienskappe Data:  

Geboortegewig  

Moeder se gewig by kalwing  
Voorpeen Weegdatum  

Voorspeen Gewig  
Speen Weegdatum  

Speen gewig  

Moeder se gewig by Speen  
12 Maande Weegdatum 

12 Maande Gewig  
18 Maande Weegdatum  

18 Maande Gewig 
Algemene Gewig Weegdatum  

Algemene Gewig  

BREEDPLAN Gewigte Data:  
Breedplan 200 Dae Gewig  

200 Dae Weegdatum  
Breedplan 400 Dae Gewig  

400 Dae Weegdatum  

Breedplan 600 Dae Gewig  
600 Dae Weegdatum 

Aankoop Data: 
Datum aangekoop 

Verkoper 

Prys 
Oorspronklike ID nr 

Datum Aankoms op Plaas 
 

Verkope, Vrektes en Uitskotte 
Data: 

Datum Verkoop/Dood 
Verkoop (Ja/Nee) 

Rede hoekom uit Kudde (kode) 

Verkoop Aan 
Prys 

Karkasgewig 
Uitslag Persentasie 

Karkas Klassifikasie 
Opmerking 

Datum Plaas Verlaat  

Dier Gesien Data:  
Dier Gesien Datum  

Gesien Deur  
Gesien in Kamp (kode) 

Opmerkings  

GPS Lengte 
GPS Breedte 

Liggaamsmates Data:  
Liggaamsmates Datum  

Skouerhoogte  

Heuphoogte  
Koplengte  

Oorlengte  
Skrotum Omvang 

Pelvis Hoogte 
Pelvis Breedte Voor 

Pelvis Breedte Agter 

RTU Mates: 
Metingsdatum 

Kruis Vetdiepte 
Rib Vetdikte 

Oogspieroppervlakte 

Marmering 
Mismonsters & Interne Parasiete 

Data: 
Datum Monster geneem 

Tipe parasiet (kode) 
Parasiet Telling (# Eiers / gram) 

Opmerkings 

Tand Data:  
Tipe Tande (kode) 

Aantal Tande  
Tande Toestand (punt) 

Reënval Data: 

Datum 
Plek 

Hoeveelheid (mm) 
Opmerking 
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Bylaag C 
 

Agrident APR500 / APR600 / AWR300 EID Lesers en  
Tru-Test XR5000 Skaal Data Uitruiling 

 
Die BenguFarm BEEF module kan die Agrident APR500 / APR600 / AWR300 elektroniese ID Lesers (“reader”) [hierna 
genoem EID leser], voorsien deur RFID Experts, integreer. Verskillende tipes data soos registrasie van nuwe diere, 

dekkings, dragtighede, kalwings, gewigte, inentings & doserings, siektes & behandelings, kamp- of bestuursgroep 

verskuiwings, prosedures, diere gesien (“animal sightings”), liniêre puntings (bv. bouvormpunte), RTU metings, 
verkope en sterftes kan op die EID leser aangeteken word. Hierdie inligting kan dan in BenguFarm ingetrek word. 

Toepaslike lys opsies soos kampe, bestuursgroepe, siektes/beserings, medisynes en entstowwe/doseermiddels kan 
ook van BenguFarm na die EID leser gestuur word. 

 

Sien die APR500 / APR600 / AWR300 Hand-reader User Manual - BenguFarm Beef (beskikbaar by RFID 
Experts) vir volledige instruksies om die betrokke EID leser te gebruik. 

 

Voordat die EID leser gebruik word: 
• Die EID leser se drywers en sagteware moet geïnstalleer wees op Windows voordat BenguFarm in staat 

sal wees om met die EID leser te kommunikeer. Hierdie drywers en sagteware word deur RFID Experts verskaf 

saam met die EID leser leser. Indien nodig, kontak asseblief RFID Experts in hierdie verband. 

• Om te kies watter tipes data op die EID leser aangeteken kan word, gaan in BenguFarm na Data 
Stuur/Trek In > Trek In > RFID Experts APR500/600 en AWR300 Lesers > Verander EID Leser Take. Baie 

belangrik: Take moet NIE verander word indien daar data op die EID leser is wat nog nie ingetrek is in 
BenguFarm nie. ‘n Maksimum van nege take kan op ‘n slag op die EID leser opgestel word. Sekere take het 

opsies sodat die gebruiker die opsie kan kies wat sy spesifieke behoeftes pas. Let wel: Die Kansellasies en 

Kampverskuiwings taak het onderafdelings: 
o Kampverskuiwings / Bestuursgroep verskuiwings* 

o Kansellasies: Oordragte (verkope) / Kansellasies (dood, weg). 

• Om bulle te merk as teelbulle, gaan in BenguFarm na Diere > Voeg by en Verander Diere (Enkel Dier Uitleg), 
soek die bul (onthou om die Onktiewe dier filter aan skakel in geval van KI bulle) en merk ("highlight") die bul. 

Maak ’n regmerkie in die veld "Teel/KI Bul" en Stoor. In die “Mating” taak sal slegs bulle wat in BenguFarm 
gemerk is as teelbulle beskikbaar wees. 

• Om lyste wat op die EID leser gebruik gaan word bv. kalfseisoene, kampe, bestuursgroepe op te 

stel, gaan in BenguFarm na Opstellings en kies die betrokke opstelling. 

• Om items in die kieslyste vir siektes/beserings, medisynes en entstowwe & doseermiddels wat nie 

gebruik word nie te verberg en/of addisionele items by te voeg op die EID leser, gaan in BenguFarm 
na Opstellings > Siektes, Beserings en Parasiete/Medisynes/Entstowwe, Doseermiddels en Aanvullings. Om items 

te verwyder, verwyder die regmerkie in die In Gebruik en Toestel kolomme langs die betrokke items. Om items 
by te voeg, kliek op die “+” regs onder en volooi die besonderhede. Kliek Stoor.  

• Om bogenoemde lyste van Bengufarm na die EID leser te stuur, gaan nou in BenguFarm na Data 

Stuur/Trek In > Trek In > RFID Experts APR500/600 en AWR300 Lesers en kliek op Vee Uit en Dateer Leser 

Data. Let wel: Maak seker dat alle data op die EID leser reeds ingetrek is in BenguFarm voordat die Vee Uit en 
Dateer Leser Data Op funksie uitgevoer word. 

 

Voodat die XR5000 skaal gebruik word: 
• Die XR5000 se drywers en sagteware moet vooraf op die rekenaar geïnstalleer wees op Windows voordat 

BenguFarm in staat sal wees om met die XR5000 te kommunikeer. 

• Gaan in BenguFarm na Data Stuur/Trek In > Tru-Test XR5000 Integrasie > Skaalveld Opstellings en maak seker 

die betrokke skaalvelde is korrek opgestel sodat die data wat aangeteken word op die skaal na die korrekte 
ooreenstemmende velde in BenguFarm ingetrek kan word. Gebruik die Hulp funksie vir stap-vir-stap instruksies. 

• Maak seker dat, waar van toepassing, die betrokke velde (bv. Kampe) reeds in BenguFarm opgestel is en dat die 

betrokke item (bv. Ras, Kamp, Kalfseisoen) se kode ingevoer word op die skaal wanneer die dierrekords geskep 
word op die skaal. 
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Aanteken van data op die EID leser (of die XR5000 skaal): 
• Indien die diere nog glad nie in BenguFarm geskep is nie, kan die EID leser OF die Tru-Test XR5000 

skaal gebruik word om dierrekords te skep en in BenguFarm in te trek: 
o Dit is belangrik om die volgende data aan te teken om die dier se rekord met die nodige basiese data te 

skep wanneer die data in BenguFarm ingetrek word: Visuele ID-nr (VID) en / of Elektroniese ID-nr (EID) 

(indien van toepassing), Geslag, Geboortedatum, Raskode en Statuskode. Indien ras- en/of status nie 
aangeteken word nie, sal die ras by verstek geskep word vanaf die betrokke kudde se opstellings en die 

status as aktief. 
o Indien die presiese geboortedatum van ’n dier onbekend is, kies ’n benaderde datum, byvoorbeeld 01-

10-2018 vir diere gebore in 2018.  

o Indien geen VID aangeteken word (bv. waar VIDs nie gebruik word nie) nie en die betrokke 
opstelling [Opstellings > Kuddes > ID Metodes en Nommering > Skep IDno (Visueel) vanaf EID 

(Mikroskyfie Nommer) waar geen IDno gespesifiseer is nie] is gedoen, sal die laaste x aantal syfers van 
die EID outomaties ingevul word as die VID. Indien nie, word die volledige EID as VID gebruik. 

o Om diere op die EID leser te registreer, moet die registrasie taak gebruik word. 
o Om diere op die Tru-Test XR5000 skaal te registreer, is dit belangrik om bogenoemde data aan 

te teken. 

• Indien die diere reeds met VIDs, ens. in BenguFarm geskep is en dan eers word die EID skyfies aan die 

diere aangebring, kan die registrasie taak op die EID leser gekies word, die EID gelees word met die EID leser 
en die VID van die betrokke dier PRESIES soos dit op BenguFarm is op die EID leser ingelees word sonder om 

al die ander velde van die registrasie taak te voltooi. Wanneer die data dan vanaf die EID leser in BenguFarm 
ingetrek word, sal slegs die EIDs in BenguFarm bygevoeg word tot die betrokke diere se bestaande rekords, 

sonder om ander velde te verander. Wenk: Die Tru-Test XR5000 skaal kan as alternatief tot die EID leser 

gebruik word om EIDs in BenguFarm in te trek by bestaande dierrekords. Om dit te kan doen, moet die VID van 
die betrokke dier PRESIES soos dit op BenguFarm is op die XR5000 ingelees word by die betrokke EID. Wanneer 

die betrokke skaalsessie data dan in BenguFarm ingetrek word [Data Stuur/Trek In > Tru-Test XR5000 Integrasie 
> Trek Skaaldata In], merk die opsie Trek Mikroskyfienommer (EID) Veranderings In en kliek Trek In. LET WEL: 

Maak ‘n rugsteun van die BenguFarm databasis vóórdat die EIDs ingetrek word vanaf die EID leser (of die 

XR5000). Sien paragraaf 16 van die handleiding. 
• Aantekening van Kalwings: 

o Op die Kalwing skerm kan die vader van die kalf nie aangeteken word nie. Maak dus seker dat die 

betrokke dekkings/embrio inplantings en dragtigheidsondersoek uitslae (indien van toepassing) reeds 
aangeteken is in BenguFarm BEEF voordat kalwings aanteken word, om te verseker dat met die intrek 

van die data vanaf die EID leser in BenguFarm, die betrokke vader gekoppel word aan elke kalf. Indien 
daar twee dekkings (bv. KI en natuurlik) kwalifiseer as die moontlike dekking, sal BenguFarm by verstek 

die tweede dekking kies as die vader. 

o Aborsies, doodgebore kalwers asook kalwers wat dood is kort na geboorte moet ook 
aangeteken word om die betrokke ooie se dragtigheidstatus te verander en om hul reproduksierekords 

volledig te maak. Op die Kalwing skerm kan die lamstatus by geboorte (bv. lewendig, aborsie, dood 
gebore) ongelukkig nie aangeteken word nie. Ons beveel aan dat die volgende prosedure gevolg word 

vir die aantekening van aborsies en dooie kalwers: 

▪ Neem ‘n EID en merk dit “Dooie Kalf” en hou dit altyd byderhand wanneer kalwings 
aangeteken word. Gebruik hierdie EID vir ALLE dooie kalwers. Wanneer kalwingsdata ingetrek 

word in BenguFarm, kies die opsie “Merk kalwers met EID as onaktief” en vul die “Dooi Kalf” 
EID nommer in die bokkie in. Alle (dooie) kalwers met hierdie EID sal dan met intrek van die 

kalwings outomaties met kalfstatus Dood na Geboorte en status Onakief aangeteken word in 
BenguFarm.  

▪ Gee ’n fiktiewe visuele nommer (VID) vir sulke kalwers, bv. 209001 (volgnommer buite die 

normale reeks) vir die eerste dooie kalf in 2020, 209002 vir die twee een, ens. 

• Om verkope en vrektes op die EID leser aan te teken, gaan na die die “Kansellasies en Kampverskuiwings” 
taak en kies die “Kansellasies > Oordragte” (vir verkope) of die “Kansellasies > Verwyder” (vir vrektes of 

uitskotte) opsie. 
 

Intrek van data vanaf die EID leser in BenguFarm: 
• Verbind die EID leser met die rekenaar met die verskafde USB kabel.  

• Indien meer as een kudde in BenguFarm opgestel is en registrasies ingetrek word, gaan na die betrokke kudde 

in BenguFarm. Let wel: Indien kalwings ingetrek word, sal die kalf ingetrek word in die kudde waarin die koei 
is, behalwe waar die koei onbekend is, in welke geval die kalf ingetrek sal word in die kudde waarin jy is wanneer 

die data ingetrek word. 

• Gaan in BenguFarm na Data Stuur/Trek In > Trek In > RFID Experts APR500/600 en AWR300 Lesers. BenguFarm 
sal outomaties die EID leser opspoor en konnekteer.  
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• Maak seker die intrekopsies is korrek. 

• Kliek op Trek Data van Leser In om te begin met die intrek van die data. BenguFarm sal die data van die leser 
haal en probeer om dit in te trek. As ou data wat voorheen ingetrek is, weer ingetrek word, sal die sagteware 

die gebruiker in kennis stel en die duplikaatdata ignoreer. 

• 'n Log van die intrek aktiwiteit sal op die skerm vertoon word. Gaan deur die lys en kontroleer dat alle rekords 
ingetrek is. Maak ‘n aantekening van foute wat in rooi uitgelig word. In die meeste gevalle is dit waar 'n dier nie 

opgespoor kan word in BenguFarm nie. 'n Dier kan nie opgespoor word indien die EID (mikroskyfie nommer) 
van die dier nie in BenguFarm is nie of indien dit verkeerd is in BenguFarm. Mikroskyfie nommers van diere kan 

in BenguFarm aangeteken word by Diere > Verander Diere (Tabel Uitleg). Sodra ontbrekende mikroskyfie 

nommers aangeteken is, probeer weer om die data van die EID leser in te trek. 

• Nadat die data ingetrek is, kan diere gekies word en aan groepe of kampe gekoppel word deur op Koppel Diere 
aan Groep te kliek. Indien nodig, kan addisionele data van ‘n dier aangevul word om die diere se data meer 

volledig te maak. Sien die Aanteken van addisionele data in BenguFarm paragraaf hieronder. 

• Nota: Wanneer data ingetrek word vanaf die EID leser, word die betrokke data leer ook outomaties gestoor 
(normaalweg by C:/Program Files (x86)/BenguelaSoft/BenguFarm/Electronic/ APR/), vir ingeval dit later (nadat 

die data uitgevee is op die EID leser) benodig word. Hierdie lêers is slegs bedoel vir kontrole doeleindes en moet 
NIE weer op ‘n latere stadium ingetrek word NIE, aangesien dit die BenguFarm databasis korrup kan maak. 

 

Intrek van data vanaf die XR5000 skaal in BenguFarm: 
• Verbind die XR5000 aan die rekenaar met die verskafde USB kabel. 

• Maak seker jy is in die betrokke kudde waarna die diere ingetrek moet word. 

• Gaan na Data Stuur/Trek In > Tru-Test XR5000 Integrasie > Trek Skaaldata In. Gebruik die Hulp funksie vir 

stap-vir-stap instruksies. 

• Kies die betrokke Skaalsessie en kliek op Laai. 

• Om dierrekords wat van diere wat op die XR5000 geregistreer is in BenguFarm te skep, merk die 
Onbekend / Skep Nuwe Dier blokkie regs onderaan die skerm en maak 'n regmerkie in die Skep kolom langs die 

diere wat in BenguFarm geskep moet word. Wenk: Merk die Onbekende / Skep Nuwe Dier Mode en gebruik 

dan die vier knoppies onder links op die skerm om maklik die diere in die Skep kolom te merk. 

• Kliek op Trek In. 
 

Uitvee van data en opdatering van lyste op die EID leser: 
• Nadat die EID leser data ingetrek is in BenguFarm, maak eers seker dat alles korrek en volledig is deur 

die betrokke data te kontroleer op die hoofskerm. Indien alles korrek en volledig is, moet die bestaande data op 

die EID leser uitgevee word. Om dit te doen, kliek op Vee Uit en Dateer Leser Data Op.  

• BAIE BELANGRIK: Voordat EIDs hergebruik word, is dit krities belangrik dat die Vee Uit en Dateer Leser Data 

Op stap gedoen word – sien die paragraaf oor die hergebruik van EIDs hieronder. 

• Tydens die uitvee en opdatering proses sal toepaslike lyste soos teelbulle, kampe, bestuursgroepe, 
siektes/beserings, medisynes en en entstowwe/doseermiddels van BenguFarm na die EID leser gestuur word 

om die betrokke lyste op die EID leser te opdateer.  

• Sodra die uitvee en opdatering proses klaar is, maak die RFID Experts APR500/APR600 en AWR300 Lesers Data 
Uitruiling skerm toe en ontkoppel die EID leser van die rekenaar. 

 

Hergebruik van EIDs: 
• Wanneer ‘n dier verkoop word of doodgaan kan die EID weer gebruik word op ‘n nuwe dier. 

• Indien verkope en vrektes op die  EID leser of op die BenguFarm MOBILE toepassing aangeteken word, word die 
betrokke EID nommers outomaties verwyder wanneer die betrokke data ingetrek word. Indien verkope en vrektes 

direk in BenguFarm aangeteken word en daar is een of meer diere met ‘n EID op rekord, sal ‘n waarskuwing 
verskyn met opsies om die EID(s) te verwyder (aanbeveel) of dit te behou. Kies dat die EID(s) verwyder word. 

• BAIE BELANGRIK: Voordat EIDs hergebruik word: 

o Maak seker dat alle diere waarvan die EIDs verwyder is, onaktief is in BenguFarm. 

o Gaan in BenguFarm na Diere > Verwyder Mikroskyfienommers (EIDs) van Onaktiewe Diere 
om te verseker dat alle betrokke EIDs verwyder is van die onaktiewe diere in BenguFarm. Let wel: 

Voordat jy hierdie funksie uitvoer, maak eers seker dat die status van die diere wat verkoop/dood is, 
onaktief is. 

o Gaan in BenguFarm na Data Stuur/Trek In > Trek In > RFID Experts APR500/600 en 
AWR300 Lesers  en kliek Vee Uit en Dateer Leser Data Op alvorens die EID leser gebruik word 

om registrasies of kalwings met die hergebruikte EIDs aan te teken om te verseker die EID word met 

hergebruik aan die nuwe dier se rekord gekoppel. Indien nagelaat is om vooraf die Vee Uit en Dateer 
Leser Data Op funksie uit te voer om verkoopte en dooie diere te verwyder van die EID leser, sal enige 

nuwe diere wat op die EID leser aangeteken word, onmiddelik weer gekanselleer word. Dit is dus krities 
dat daar geen ou verkope of vrektes (oordragte of kansellasies) rekords op die EID leser oor is nie. 
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o Gaan in BenguFarm na Data Stuur/Trek In > Tru-Test XR5000 Integrasie > Eksporteer 

Diere na Skaal en kliek Verwyder Diere met Onaktiewe EIDs vanaf Skaal alvorens die skaal 
gebruik word om registrasies, gewigte of ander data met die hergebruikte EIDs op die skaal aan te 

teken, om te verseker die EID word met hergebruik aan die nuwe dier se rekord gekoppel. Indien 

nagelaat is om vooraf die Verwyder Diere met Onaktiewe EIDs vanaf Skaal funksie uit te voer om 
verkoopte en dooie diere te verwyder van die XR5000, sal data teenoor die diere wat vroeer die EID 

gehad het, aangeteken word. Die gevolg is dat waar skaaldata daarna ingetrek word, afhangende van 
opstellings, data in BenguFarm gekorrupteer kan word. Gebruik die Hulp funksie vir stap-vir-stap 

instruksies. Let wel: Indien daar meer as een databasis op BenguFarm is, gebruik BenguFarm weergawe 
7 Oktober 2021p en later. Hierdie nuwer weegawes het ’n opsie “Soek in Alle Databasisse” wat by verstek 

aangeskakel is. 

o Indien nagelaat is om EIDs te kanselleer en nuwe kalwings is op die EID leser aangeteken wat nie-
gekanselleerde EIDs aan toegeken is, kan die gevorderde opsies gebruik word om daardie diere met die 

betrokke EIDs onaktief te maak en die EID van die bestaande diere te verwyder. 
 

Aanteken van addisionele data in BenguFarm BEEF: 
Sekere take op die EID leser maak nie voorsiening vir die aantekening van alle data waarvoor BenguFarm BEEF 
voorsiening maak nie. Die Dekkings taak maak byvoorbeeld nie voorsiening om dekkings te koppel aan ‘n sekere 

kalfseisoen nie. Sulke data kan, nadat die data ingetrek is vanaf die EID leser, in BenguFarm bygevoeg word deur 
na die betrokke tipe data se aantekenskerm te gaan (bv. Reproduksie > Natuurlike Dekkings), te kliek op Laai 

Bestaande Rekords en die addisionele/ontbrekende data by te voeg. Om algemene dierdata (bv. Kalfseisoen) by te 

voeg of the verander, gaan na Diere > Verander Diere (Tabel Uitleg). Gebruik die HULP funksie indien nodig. 
 

Data wat nie op die APR500 / APR600 en AWR300 EID lesers aangeteken kan word nie: 
Afhangende van watter taak opsie by sekere take gekies word, kan die volgende data nie op die EID leser 

aangeteken word nie: 

• Registrasie > Nuwe dier / Oorplaatjie verandering): 

o Ras 

o Geboortedatum onseker 

o Kamp, datum geskuif, rede geskuif 

o Vader en Moeder 

o Teelbul 

o Aankoopdatum, prys, by wie gekoop 

• Sinchronisasie: 

o Gedoen deur (persoon) 

o 1ste Inspuiting Datum 

o 2de Inspuiting Datum 

o Uitgehaal Datum 

o Koste per Dier 

o Opmerking 

• Dekkings (Natuurlik / KI) 

o Kalfseisoen* (Met intrek van data vanaf die EID leser, sal die kalfseisoen waarmee die dekdatums 

ooreenstem, outomaties bygevoeg word. Indien geen kalfseisoen gevind word waar die dekdatums 

ooreenstem nie, sal die kalfseisoen wat op BenguFarm as die Huidige Kalfseisoen gekies is, bygevoeg 

word). 

o Semen Tipe (KI) 

o Insemineerder (KI) 

o Koste per Dier (KI) 

o Besending Nr (KI) 

o Opmerking 

• Dragtigheidsondersoek: 

o Metode (bv. Sonar) 

o Gedoen deur (persoon) 

o Koste per Dier 
o Opmerking 

• Kalwing: 

o Kalfseisoen* (Met intrek van data vanaf die EID leser, sal die kalfseisoen wat op BenguFarm as die 

Huidige Kalfseisoen gekies is, outomaties bygevoeg word). 
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o Kamp en Kamp verskuiwing 

o Status by geboorte (bv. lewend, aborsie, doodgebore, dood na geboorte) [Taak 8014 maak 

voorsiening dat kalfstatus by geboorte op die EID leser aangeteken kan word]. 

o Status tans (bv. aktief, onaktief) 

• Weeg: 

o Verander (waar toepaslik) Gewigtipe (bv. Algemene Gewig na Speengewig) 

• Inentings (ook doserings, dip, aanvullings): 

o Geënt/doseer teen (siekte) 

o Besending Nr 

o Koste per Dier 

o Geënt/doseer deur (persoon) 

o Opmerking 

• Siektes en Beserings: 

o Besending Nr 

o Medisyne koste 

o Veearts koste 

o Opmerking 

• Kansellasies en Kampverskuiwings > Kansellasies > Verkoop (oordrag) / Dood (verwyder): 

o Prys (indien verkoop) 

o Rede 

o Amptelike rede (slegs stoet) 

o Verlaat plaas datum 

o Inkomste basis (bv. Per Kg Lewende Gewig) 

o Inkomste per kg 

o Dier Gewig 

o Karkas Gewig 

o Karkas Klassisifikasie 

o Verlies (Randwaarde – indien dood, vermis, gesteel) 

o Opmerking 
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Bylaag D 
 

Embrio Spoelings en -Inplantings 

 
Prosedure om embrio spoelings en -inplantings aan te teken in BenguFarm: 

  

1. Skenker koeie en KI bulle: 

1.1. Maak seker dat die embrioskenker koeie/verse en die KI bulle waarmee hulle geïnsemineer gaan word op 

rekord is in die stoetkudde op BenguFarm. 

1.2. Om te verseker dat die embrioskenker koeie/verse bo-aan die lys van vroulike diere op die Embrio Spoelings 

en Voorraad skerm vertoon word, gaan na die Voeg By en Verander Diere (Enkel Dier Uitleg) skerm, soek 

die toepaslike vroulike dier en verlig (“highlight”) die dier se ID nr. Maak 'n merkmerk in die veld "Ova 

Skenker" en kliek op Stoor. Dit sal ook verseker dat die embrioskenker koeie/verse op die APR500 / APR600 

EID-leser (waar van toepassing) opgelaai word en bo-aan die lys van vroulike diere gelys word. 

 

2. Skep dierrekords vir die (kommersiële) ontvanger koeie: 

2.1. Om embrio inplantings aan te teken, moet daar dierrekords vir die ontvanger koeie in BenguFarm wees. 

Ten einde die proses vir die aantekening van embrio spoelings en inplantings, data versending na Stamboek 

en algemene administrasie te vergemaklik, stel ons voor dat die ontvanger koeie in dieselfde (stoet) kudde 

moet wees as die kudde waarin die skenker koeie is.   

2.2. Indien die ontvangerkoeie nog nie dierrekords in BenguFarm het nie, gaan in die stoetkudde na Diere > 

Voeg Dier by Wizard en skep dierrekords met die beskikbare inligting vir die betrokke ontvanger koeie. 

2.3. Let wel: Indien die ontvanger koeie kommersiële (nie-stoet) koeie is, moet in ag geneem word dat die 

skep van hul dierrekords in die stoetkudde sal beteken dat die aantal diere in die stoetkudde nie korrek sal 

wees nie. Hou dit in gedagte wanneer na die Diergetalle en –Waardes verslag, die Kuddelys verslag en die 

Diere per Kamp of Groep verslae gekyk word. Dit sal ook beteken dat wanneer die Vergelyk BenguFarm en 

Logix Kuddelyste verslag geskep word, die BenguFarm kuddelys noodwendig sal verskil van die Logix 

kuddelys. 

 

3. Teken dekkings (gewoonlik KI) aan vir die skenker koeie: 

3.1. Gaan na Reproduksie > Dekkings > Kunsmatige Inseminasie/Laparoskopieë (of Natuurlike Dekkings) en 

teken die dekkings aan vir die stoet skenker koeie. 

 

4. Teken spoelings aan: 

4.1. Gaan na Reproduksie > Embrio Spoelings en Voorraad. 

4.2. Kies die koei wat gespoel is (links bo-aan die skerm) en kliek Voeg By. Vul die besonderhede van die 

spoeling in en kliek Stoor. Nota: Ons beveel aan dat jy by Groepnommer die skenker koei se ID nommer 

en spoeldatum (bv. AB110025 15-11-2014) invul.  

4.3. Om ‘n verslag van embriospoelings te skep, gaan na: Verslae > Dekkings, Dragtighede en Kalwings > 

Embrio Spoelings. 

 

5. Teken embrio voorraad aan: 

5.1. Gaan na Reproduksie > Embrio Spoelings en Voorraad. 

5.2. Kies die Skenker Koei (links bo-aan die skerm), kies die Groep Nommer, vul die toepaslike velde in die Multi 

Verander / Voeg Nuwe By gedeelte van die skerm in en kliek Voeg Embrios By. 

5.3. Op die skermpie wat in die regkantse boonste hoek oopgemaak het, vul die embrios se besonderhede in 

en kliek Skep. Vul by Agtervoegsel die skenker koei se nommer in. Die embrio nommer sal dan geskep 

word met die die hoeveelste embrio gevolg deur die skenker koei se nommer, bv. 1ABC150020, 

2ABC20150020, ens. Indien nodig, verander die individuele embrios se inligting (bv. die Graad mag verskil 

tussen embrios). Kliek Stoor. 
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6. Teken inplantings aan: 

6.1. Gaan na Reproduksie > Dekking/KI//Embrio Inplanting Wizard > Voeg Nuwe Nuwe Dekking/KI/Embrio 

Inplanting By > Embrio Inplanting en teken die inplantings van die embrios in die ontvangerkoeie aan. 

6.2. Kies die skenker koei in die Multi Verander / Voeg Nuwe By gedeelte van die venster, kies die bul deur wie 

die embrio verwek is, kies die ontvanger koei, inplantdatum, ens. Om 'n embrio uit die voorraad in te plant, 

moet jy in die Embrio Groep en -ID velde die betrokke embrio wat ingeplant is, kies uit die voorraad. Kliek 

Voeg Dier By en indien alles korrek is, kliek Stoor. 

6.3. Om ‘n verslag van embriospoelings en inplantings te skep, gaan na: Verslae > Dekkings, Dragtighede en 

Kalwings > Embrio Spoelings en Inplantings. 

 

7. Stuur die inplantings data na Stamboek: 

7.1. Gaan na Data Stuur/Trek In > Stuur > Stamboek > Embrio Inplantings (Skedule O). 

7.2. Onder Seleksie Kriteria, kies die betrokke inplantings wat jy wil stuur. Nota: Indien jy spesifieke diere kies, 

is dit die ontvanger koeie se nommers wat sal verskyn. 

7.3. Kliek Lys Inplantings Volgens Seleksie Kriteria. Kontroleer of daar enige diere gemerk is onder die Foute 

afdeling. Indien alles korrek is, kliek Vertoon Drukstuk. 

7.4. Indien alles korrek en volledig is, kliek regs bo-aan die skerm op die drukker knoppie en druk die verslag. 

7.5. Teken die dokument by elke inplanting in afdelings B en D en stuur dit dan na die dataklerk by SA Stamboek 

wat met die betrokke ras werk.  

 

8. Teken dragtighede aan: 

8.1. Gaan na Reproduksie > Dragtigheidsondersoeke en teken die dragtighede van die ontvangerkoeie aan. 

8.2. In die Multi Verander / Voeg Nuwe By gedeelte van die skerm, kies die betrokke kalfseisoen links bo-aan 

die venster en voltooi die betrokke velde. Kliek regs bo-aan die skerm op Voeg Nuwe Ondersoek By. 

8.3. Voltooi die dragtigheidstydperke en wanneer alles korrek en volledig is, kliek Stoor. 

 

9. Teken kalwings aan: 

9.1. Gaan na Reproduksie > Kalwings en teken die kalwers aan wat gebore is uit die embrio inplantings. Let 

wel: Kies die ontvanger koei as die koei wat gekalf het. 

 

10. Stuur geboortekennisgewings: 

10.1 Gaan na Data Stuur/Trek In > Stuur > Stamboek/LNR > Geboortekennisgewings. Kliek op Lys Geboortes 

Nog Nie Gestuur Nie. 

 

 

Prosedure om die kolleksie van oösiete, in vitro bevrugting en embrio-inplantings 
aan te teken in BenguFarm:  
 

Tans maak BenguFarm nie spesifiek voorsiening vir die aantekening van die kolleksie van oösiete en in vitro 

bevrugting nie. Ons beveel aan dat die kolleksie van die oösiete hanteer word asof dit embrios is, m.a.w. asof die 

skenkerkoei gedek (gewoonlik KI) is, bevrugting in die skenkerkoei plaasgevind het en die embrios gespoel is. Die 

stappe om dit aan te teken is dan basies dieselfde as hierbo beskryf vir embrio spoeling en –inplantings. 
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Bylaag E 

 

Breedplan as Diensverskaffer –  

Opstellings, Data Stuur en -Intrek Funksies 
 

1. Opstellings: 
• Om die kudde op te stel, gaan in BenguFarm BEEF na Opstellings > Kuddes: 

o Onder Algemeen, vul by Genootskap LidNr jou telersgenootskap/Breedplan lidnommer (bv. 0123456, 

sonder die raskode) in en kliek op Stoor. 

o Diensverskaffers: 

▪ By Registrasie, Prestasie en Teelwaardes kies Breedplan as die diensverskaffer.  

Nota: BenguFarm BEEF sal vir jou 'n opsie gee om die ID formaat van nuwe diere in jou kudde te 

verander na die Breedplan formaat (YYNNNNHHHH). Kies hier “Nee”. (Die verstek format, nl. 

HHHHYYNNN, word aanvaar deur die meeste telersgenootskappe en Breedplan). [Indien jy per abuis 

“Ja” gekies het, kan jy die diere wie se ID nommers nou in die Breedplan format is terug verander 

na die ou formaat (HHHHYYNNNN), m.a.w. eers die Kuddekenmerk dan die Jaar van Geboorte en 

dan die Volgnommer. Om dit te doen, gaan na Lêer > Ondersteuning > Verander ID Nommers en/of 

Name. Kies dan opsie 1 met die verstek formaat (HHHHYYNNNN)]. 

▪ By Telersgenootskap, kies jou telersgenootskap, bv. SASANTA (SA Santa Gertrudis). 

▪ By Epos Dekkings, Geboortekennisgewings, Oordragte en Kansellasies, vul in jou 

registrerende owerheid/telersgenootskap se epos adres, bv. susan@santagertrudis.co.za 

▪ By Epos Prestasietoetsdata, vul in jou registrerende owerheid/ telersgenootskap se epos 

adres, bv. susan@santagertrudis.co.zaen kliek op Stoor. 

o Prestasietoetsdata: 

▪ By Maksimum Toelaatbare Ouderdomsverskil tussen Diere in Dieselfde 

Prestasietoetsgroep (dae), kies 100 dae. 

▪ By Prestasietoets Fases waarin Diere Getoets Word, merk die betrokke Breedplan gewigte 

(regterkantste kolom) wat jy normaalweg gaan aanteken. [Hierdie opstelling is nie krities nie – dit 

word net gebruik in die BenguFarm BEEF Dagboek om jou te herinner om diere te weeg op die 

betrokke datums vir die gekose gewigte]. Kliek op Stoor. 

o Let wel: Maak asseblief jou BenguFarm BEEF toe en weer oop vir die Breedplan funksies om te vertoon 

by Data Stuur/Trek In. 

• Om Breedpan opstellings te doen, gaan in BenguFarm BEEF na Opstellings > Breedplan (heel onder-

aan die lys): 

o Hier kan opstellings gedoen word vir Waarnemingskodes, Bestuursgroepe en 

Prestasietoetsgroepe soos benodig. Kliek op die “+” regs onder aan die skerm om ‘n nuwe rekord te 

skep en vul die betrokke Kode en Naam (beskrywing) in. Kliek op Stoor. 

o Hier kan jy ook die nuutste Ras- en Kuddegemiddelde Teelwaardes aanteken as jy wil hê dit moet 

vertoon word op BenguFarm BEEF hoofskerm saam met 'n dier se eie teelwaardes. Kliek op Stoor. 

Nota: Indien nodig, skakel asseblief met jou telersgenootskap of met Breedplan vir inligting oor hoe om die 

Breedplan opstellings hierbo te doen. 

 

2. Intrek van data ontvang van Breedplan/registrerende owerheid/ 

telersgenootskap: 
• Kontak asseblief jou telersgenootskap en versoek hulle om vir jou die volgende lêers te stuur vir 

intrek in plaassagteware soos BenguFarm: 

o ANIMALS.DAT 

o WEIGHTS.DAT 

o TRAITS.DAT 

o GROUPEBV.DAT 

o COMPUTER NUMBERS.DAT 
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• Om hierdie Breedplan datalêers in te trek, gaan na Data Stuur/Trek In > Trek In > Databasis 

> BreedPlan. Maak seker die kudde en ras (bo-aan die skerm) is korrek. Let wel: Indien die datalêer in 

zip formaat ontvang is, moet die DAT lêer eers “extract” word. Kliek regs op die zip lêer en kies Extract All.  

o Om die dierdata lêer (Breedplan hoofdata) in te trek, gaan na Stap 1, kliek op "Soek…" en kies 

die "..._ANIMALS.DAT" lêer. Kliek dan op "Trek in". 

Let wel: 

▪ Hierdie funksie sal slegs diere skep indien die dier nie reeds in BenguFarm BEEF databasis 

is nie. 

▪ Bestaande diere word onveranderd gelaat. Indien bestaande diere se data (bv. teelwaardes) 

opgedateer moet word, maak seker die opsie Dateer Bestaande Diere Op gemerk is. Let op 

dat EBVs ingetrek word vanaf die GROUPEBV lêer, nie die ANIMALS lêer nie. 

▪ Bestaande diere word slegs op rekenaarnommers gesoek. Indien die dier alreeds in die 

BenguFarm BEEF databasis is, maar die rekenaarnommer nie ingevul is nie, sal hierdie 

funksie die nie die bestaande dier identifiseer nie met die gevolg dat 'n nuwe dierrekord 

geskep sal word wat in effek 'n duplikaat van die oorspronklike dier sal wees.  

▪ Nadat die ANIMALS lêer ingetrek is, gaan na Diere > Verander Diere (tabel uitleg). Kliek op 

Laai 'n Nuwe Seleksie van Diere, skakel die Onaktiewe filter aan en kies ALLE diere. Terug 

in die Verander Diere skerm, by Kies Velde om te Vertoon kies Kuddekenmerk, Jaar en 

Volgnommer. Maak seker dat hierdie velde volledig en korrek is vir ALLE diere. 

Voltooi/verander waar nodig. Stoor. 

o Om die gewigte lêer in te trek, gaan na Stap 2, kliek op "Soek…" en kies die "..._WEIGHTS.DAT" 

lêer. Kliek dan op "Trek in". 

o Om die eienskappe lêer in te trek (indien van toepassing), gaan na Stap 3, kliek op "Soek…" en kies 

die "..._TRAITS.DAT" lêer. Kliek dan op "Trek in". 

o Om die rekenaarnommers lêer in te trek, gaan na Stap 1b, kliek op "Soek…" en kies die 

"..._COMPUTER NUMBERS.DAT" lêer. Kliek dan op "Trek In". 

o Om die teelwaardes lêer in te trek, gaan na Data Stuur/Trek In > Trek In > BreedPlan > 

Teelwaardes. Kliek op "Soek…" en kies die lêer "…_GROUPEBV.DAT". Kliek op "Trek In". Let wel: 

die Breedplan kudde- en rasgemiddelde teelwaaredes word nie ingesluit in die Breedplan EBV lêer 

nie. Om die nuutste ras- en kuddegemiddelde teelwaardes per hand in te voer in BenguFarm, sien 

paragraaf 1 hierbo. 

o Om prestasietoetsdata verwerk deur die LNR se Intergis in te trek, gaan na Data Stuur/Trek In > 

Trek In > Stamboek/LNR > Amptelike Prestasietoetsdata. 

 

Let wel: Om Logix (of Intergis) data (bv. ‘n BEEFDATA_.... lêer) in te trek in BenguFarm BEEF, moet jy 

dit intrek by die betrokke tipe data opsie onder die Stamboek/LNR of Logix Direk opsie en nie onder die 

Breedplan opsies nie. 

 

3. Stuur data na jou registrerende owerheid/telersgenootskap: 
• Om data te stuur na die betrokke telersgenootskap/registrerende owerheid, gaan na Data 

Stuur/Trek In > Stuur > Breedplan en kies Dekkings, Geboortekennisgewings, Gewigte of Oordragte en 
Kansellasies, afhangend van watter data jy wil stuur.  

• Om Dekkings, Geboortekennisgewings of Gewigte (insluitende Eienskappe, waar van toepassing) te 

stuur, kliek op Skep Elektroniese Lêer om ’n elektroniese lêer van die betrokke data te skep. BenguFarm 

BEEF sal  nou poog om die elektroniese lêer outomaties aan ’n e-pos boodskap te heg en in jou verstek e-
pos program (bv. Outlook) se “Outbox” te plaas. Let asseblief op die volgende rakende die instuur 

van Dekkings: 
o Behalwe vir die ID nommers, moet die betrokke bulle se KKM, Jaar en Volgnommer velde en/of die 

die Dier se Naam moet ingevul wees in BenguFarm voordat die elektroniese lêer geskep word. 

o Indien multi-bulle dekkings gedoen word, moet multi-bulle groepe voor die tyd by BreedPlan 
geregistreer word. Kontak jou telersgenootskap vir die prosedure om ‘n multi-bul groep te registreer.  

BreedPlan sal 'n naam aan daardie multi-sire groep toeken. VOORDAT jy dekkings aanteken, moet 
jy dus eers die groep by Breedplan registreer en die groep se naam by hulle kry. Let op dat alle bulle 

in ‘n groep se afdeling SP moet wees. Sodra die groep se naam ontvang is, moet jy in BenguFarm 
'n manlike dier met daardie kode skep. Die maklikste om dit te doen is by Diere > Voeg Diere by 

Wizard. Sit die groep se naam in as die IDNr (Visueel) en die Amptelike ID. Jy kan so ‘n “bul” onaktief 

maak (dis nie 'n werklike dier nie). Merk die “bul” as "Teel/KI Bul" sodat hy bo-aan die lys verskyn 
waar ‘n bul gekies moet word wanneer dekkings aangeteken word. Jy teken dus dekkings en 
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geboortes aan met hierdie dekbeeldige "bul". Die dekkings sal sodoende NIE in BenguFarm met ‘n 

regmekrie as "Multisire" gemerk word nie. BreedPlan tel die multi-bulle op omdat jy die naam van 
die multi-bul groep as “bul” gebruik het. Wanneer geboortes aangeteken word, moet hierdie 

groepnaam gekies word as die “vader”. 

• Indien BenguFarm BEEF vir een of ander rede nie die elektroniese lêer outomaties aan ’n e-pos kan heg nie, 

sal ’n boodskap verskyn om jou hiervan te waarsku. Let op waar jy die lêer stoor wat aan die e-pos geheg 
moet word (bv. C:\BenguFarm\Beef\Exports\Kudde of C:\Program Files\BenguelaSoft\BenguFarm\ 

Electronic\Send). Volg die instruksies op die boodskap skerm vir hulp om self ’n nuwe e-pos boodskap met 
jou e-pos program (bv. Outlook) te skep, die betrokke lêer aan die e-pos te heg en dit te stuur na die 

betrokke telersgenootskap/registrerende owerheid.  

• Oordragte en Kansellasies kan nie elektronies gestuur word nie. Wanneer die betrokke diere gekies 
is, kliek op (Druk) Oordragte of (Druk) Kansellasies afhangend van watter data jy wil stuur. Kliek op 

Eksporteer en skep ‘n pdf formaat lêer. Let op waar jy die lêer stoor word. Skep ’n nuwe e-pos boodskap 

met jou e-pos program (bv. Outlook), heg die lêer aan die e-pos en stuur dit na die betrokke 
telersgenootskap/registrerende owerheid.  

  



 75 

Bylaag F 
 

Berekenings in BenguFarm-BEEF –  
Beskrywings en Seleksie Riglyne 

 
 

Fases en Eienskappe Beskrywing 

Algemeen 

Ouderdom van Dier Die ouderdom van ‘n dier word as volg vertoon op die hoofskerm: 

• 0 – 634 dae in Dae 

• 635 - 730 dae in Maande 

• 731+ dae in Jare. 

Wanneer word ‘n kalf as 

gespeen beskou? 

'n Kalf word as gespeen beskou indien: 

• 'n Gewig met Gewigtipe = Speengewig (A2) aangeteken is binne die minimum 

en maksimum ouderdomsperk vir speengewig (151-270 dae oud); EN / OF 

• 'n Speen prosedure aangeteken is (Ander Data> Prosedures). 

Reproduksie en Geboorte (Fase A0) 

Verwagte Kalfdatum Verwagte kalfdatum berekenings in BenguFarm hang eerstens daarvan af of daar 

‘n dragtigheidsondersoek vir die betrokke dier gedoen is of nie: 
1. Indien ‘n dragtigheidsondersoek gedoen is, die dier dragtig bevind is en die 

tydperk dragtig aangeteken is in BenguFarm, word die verwagte kalfdatum as 

volg bereken: Ondersoekdatum MINUS Tydperk dragtig op ondersoekdatum PLUS 
Normale dragtigheidsperiode (soos opgestel by Opstellings > Kuddes > Dekking, 

Dragtigheid en Kalwing). 
2. Indien ‘n dragtigheidsondersoek wel gedoen is, die dier dragtig bevind is, maar 

die tydperk dragtig nie aangeteken is in BenguFarm nie: 
2.1. Die vroegste moontlike kalfdatum (indien gekies by Opstellings > Kuddes > 

Dragtighede en Kalwing > Bereken Eerste moontlike Verwagte Kalfdatum) 

word as volg bereken: Eerste dekdatum sedert die laaste kalfdatum OF waar 
verskeie dragtigheidsondersoeke sedert die laaste kalfdatum gedoen is, die 

eerste dekking sedert die vorige ondersoek PLUS Normale 
dragtigheidsperiode. 

2.2. Met die opstelling "Bereken Verwagte Kalfdatums sonder Dekinligting" 

[Opstellings > Kuddes > Dekking, Dragtighede en Kalwing] aangeskakel (dit 
is by verstek aangeskakel vir die GAME module), word die verwagte 

kalfdatum bereken sonder dat daar enige dekkings of 
dragtigheidsondersoeke in die program aangeteken is. 

2.2.1. Vir verse ouer as "Minimum Ouderdom van Verse by Eerste Dekking " 
(Opstellings > Kuddes > Dekking, Dragtigheid en Kalwing) word die 

verwagte kalfdatum bereken as datum van “Minimum Ouderdom van 

Verse by Eerste Dekking” PLUS die "Normale Periode Dragtig".  
2.2.2. Vir koeie met dae sedert laaste kalfdatum meer as die "Gemid. Periode 

van Kalwing tot weer Gedek word" (Opstellings > Kuddes > Dekking, 
Dragtigheid en Kalwing) word die verwagte kalfdatum bereken as die 

laaste kalfdatum PLUS die "Gemid. Periode van Kalwing tot weer Gedek 

word" (indien > 0, anders die “Ovulasiesiklus”) PLUS die "Normale 
Periode Dragtig". Hierdie berekening word vertoon op die hoofskerm en 

My Verslae (Laaste Dekking - Geen dekinligting maar het verwagte 
kalfdatums), Verse en Koeie naby Kalwing verslag, indien "Minimum dae 

sedert laaste Kalwing (geen dekkings)" gemerk is (by verstek gemerk in 

die GAME module) en die Verse en Koeie Gekalf/Nie Gekalf Nie" verslag. 
Hierdie metode bereken dus die vroegste moontlike kalfdatum. Deur die 

verstek “Minimum Ouderdom van Verse by Eerste Dekking” en/of 
"Gemid. Periode van Kalwing tot weer Gedek word" opstellings te 

verander, kan die verwagte kalfdatum berekening meer akkuraat 
gemaak word. 
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Fases en Eienskappe Beskrywing Algemene riglyne vir Seleksie 

Ouderdom Eerste Kalwing  

(OEK) 

Ouderdom (in maande) wanneer die 

koei vir die eerste keer gekalf het. 

Selekteer koeie met 'n lae ouderdom 

eerste kalwing, in ag genome wanneer 
hulle vir die eerste keer gepaar is. 

Ouderdom Laaste Kalwing  

(OLK) 

Ouderdom (in maande) wanneer die 

koei die laaste keer gekalf het. 

Nie gewoonlik gebruik in seleksie - 

slegs vir inligting. 

Eerste Tussenkalfperiode  

(Eerste TKP) 

Tydperk (in dae) tussen die eerste en 

tweede kalfdatums. 

Skot koeie met 'n hoë eerste inter-

kalwing periode uit, in ag genome 

wanneer hulle vir die eerste keer en vir 
die tweede keer gepaar is. 

Laaste Tussenkalfperiode  
(Laaste TKP) 

Tydperk (in dae) tussen die laaste 
twee kalfdatums. 

Skot koeie met 'n hoë laaste inter-
kalwing periode uit. 

Gemid. Tussenkalfperiode  

(Gemid. TKP) 

Gemiddelde tydperk (in dae) tussen 

kalwings oor al die kalfdatums. 

Skot koeie met 'n hoë gemiddelde inter-

kalwing periode uit. 

Dae Sedert Laaste Kalwing  
(DSLK) 

Die tydperk (in dae) sedert die laaste 
kalfdatum. 

Skot koeie met 'n hoë dae sedert laaste 
kalwing waarde uit. 

Reproduksie Indeks  
(RI) 

Die RI evalueer die algehele 
reproduksie prestasie van 'n koei, met 

OEK en die gemiddelde TKP in ag 

geneem. Let asseblief dat DSLK, om 
tegniese redes, nie in ag geneem 

word in die berekening van die RI nie. 
Met behulp van die RI kan koeie met 

verskillende OEK en TKPs direk 

vergelyk word, bv. 'n koei wat gekalf 
het op 24, 48 en 60 maande 

ouderdom sal dieselfde RI hê as 'n 
koei wat gekalf het op 36, 48 en 60 

maande. Let asseblief op dat die RI se 
standaard van vergelyking ‘n 

nasionale standaard is soos vasgestel 

deur SA Stamboek. 

Skot koeie met 'n lae reproduksie-
indeks uit. 

Geboortegewig verhouding  

(GGV) 

Die verhouding van kalfgewig by 

geboorte gedeel deur die koeigewig 

by kalwing, uitgedruk as 'n 
persentasie. 

Selekteer vir ‘n gemiddelde (± 7,4%) 

geboortegewig verhouding. Hoë (bo 

8,5%) geboortegewig verhoudings 
word geassosieer met moeilike 

kalwings. 

Tydgenote  
(Tydg.) 

'n Kontemporêre groep (of tydgenote) 
is 'n groep diere wat gebore is in 

dieselfde jaar en seisoen (dus 
ongeveer dieselfde ouderdom), op 

dieselfde plek (dieselfde trop of 
plaas), van dieselfde geslag, en 

dieselfde bestuur is van geboorte tot 

die tyd van meting (dieselfde 
voedingstatus, datum van meting, 

ens.) Alle prestasie indekse (met die 
uitsondering van Gestandariseerde 

Sentrale Groeitoetse (Fase C1 en C2) 

word bereken binne 'n kontemporêre 
groep. In Gestandariseerde Sentrale 

Groeitoetse word die GDT en VOV 
indekse bereken op 'n kumulatiewe 

rollende gemiddeld van alle bulle van 
die betrokke ras wat oor die afgelope 

10 jaar getoets is by daardie 

spesifieke toetssentrum. 

Die aantal tydgenote gee 'n aanduiding 
van die akkuraatheid van die indeks 

berekeninge: Hoe meer die aantal 
tydgenote, hoe meer betroubaar is die 

indekse. Hoe minder,  hoe minder 
betroubaar. 

Let wel: Korrek gedefiniëerde 

kontemporêre groepe (in BenguFarm 
genoem prestasietoetsgroepe) is uiters 

noodsaaklik vir akkurate 
prestasietoetsing en teelwaarde 

beramings. Kontemporêre groepe moet 

op so ‘n wyse gedefiniëer word dat alle 
betekenisvolle omgewingseffekte – 

behalwe daardie waarvoor daar in die 
evaluasiemodel gekorrigeer word, bv. 

kalfouderdom en moederouderdom – 
dieselfde is vir alle diere binne 'n 

spesifieke groep. Dit, gekombineer met 

goeie genetiese verbindings tussen 
groepe, sal verseker dat BLUP die 

genetiese en omgewingseffekte binne 
enige spesifieke groep effektief kan 

skei. 
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Voorspeen (Fase A1) 

100 Dae Aangepaste Gewig  

(100D G) 

Voorspeen gewig aangepas (of 

gekorrigeer) vir die ouderdom van die 
kalf (na 'n standaard ouderdom van 

100 dae) en aangepas vir die 
ouderdom van die moeder. Die 

ouderdom-van-moeder 

aanpassingsfaktor is 'n additiewe 
faktor om die kalf se gewig aan te pas 

na 'n volwasse koei basis en word 
bepaal deur die ouderdom van die 

moeder, ras van die moeder en die 

geslag van die kalf. 

Gebruik die 100 Dae GDO Indeks vir 

seleksie - sien hieronder. 
 

100 Dae GDO  

(100D GDO) 

Die ouderdom-van-moeder aangepaste 

gemiddelde gewigstoename (in g) per 
dag vanaf geboorte tot 100 dae 

ouderdom. 

Gebruik die 100 Dae GDO Indeks vir 

seleksie – sien hieronder. 
 

100 Dae GDO Indeks  
(100D Ind) 

Die 100 Dae GDO (Voorspeen) Indeks 
word bereken deur die kalf se 100 Dae 

GDO waarde te deel deur die 

gemiddelde 100 Dae GDO van die 
betrokke groep (tydgenote) kalwers en 

word uitgedruk as 'n persentasie. 
Omdat 'n kalf grootliks afhanklik is van 

sy moeder melk vir groei op 'n vroeë 
ouderdom, is die 100 Dae indeks 'n 

goeie evaluasie van 'n koei se 

melkproduksie. 

Skot koeie uit met twee of meer 
kalwers met 'n lae (onder 90) 100 Dae 

GDO Indeks en/of met 'n lae 

gemiddelde 100 Dae GDO Indeks oor 
al haar nageslag. Moenie verse (of 

bulle) met 'n lae 100 Dae Indeks hou 
vir vervanging nie. 

 

Speen (Fase A2) 

205 Dae Aangepaste Gewig  

(205D G) 

Speengewig aangepas (of gekorrigeer) 

vir die ouderdom van die kalf (na 'n 
standaard ouderdom van 205 dae) en 

aangepas vir die ouderdom van die 

moeder. Die ouderdom-van-moeder 
aanpassing faktor is 'n additiewe faktor 

om die kalf se gewig aan te pas na 'n 
volwasse koei basis en word bepaal 

deur die ouderdom van die moeder, 
ras van die moeder en die geslag van 

die kalf. 

Gebruik die 205 Dae GDO Indeks vir 

seleksie - sien hieronder. 
 

205 Dae GDO  
(205D GDO) 

Die ouderdom-van-moeder aangepaste 
gemiddelde gewigstoename (in g) per 

dag vanaf geboorte tot 205 dae 

ouderdom. 

Gebruik die 205 Dae GDO Indeks vir 
seleksie - sien hieronder. 

 

205 Dae GDO Indeks  

(205D Ind) 

Die 205 Dae GDO (Speen) Indeks word 

bereken deur die kalf se 205 Dae GDO 
waarde te deel deur die gemiddelde 

205 Dae GDO van die betrokke groep 

(tydgenote) kalwers en word uitgedruk 
as 'n persentasie. Die 205 Dae Indeks 

'n evaluasie van beide 'n koei se 
melkproduksie en die kalf se 

groeitempo tot by speenouderdom. 

Die 205 Dae GDO Indeks is 'n 

evaluering van beide' n koei se 
melkproduksie en die kalf se 

groeitempo tot op speen. Skot koeie 

uit met twee of meer kalwers met 'n 
lae (onder 90) 205 Dae GDO Indeks 

en/of met 'n lae gemiddelde 205 Dae 
GDO Indeks oor al haar nageslag. 

Moenie verse (of bulle) met 'n lae 205 

Dae GDO Indeks hou vir vervanging 
nie. 

Tydgenote (Tydg.) Sien hierbo.  
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Koeidoeltreffendheid  

(KD) 

Koeidoeltreffendheid evalueer die 

speengewig (aangepas vir ouderdom 

tot 205 dae) van 'n koei se kalf in 
vergelyking met haar eie metaboliese 

of onderhoudsgewig (gewig tot die 
mag 0.75) by kalwing (of speen indien 

nie aangeteken tydens kalwing). Bv. 'n 
koei van 500kg wat ‘n kalf van 250 kg 

speen is meer doeltreffend as 'n koei 

van 600kg wat ‘n kalf van dieselfde 
gewig speen. 

Gebruik die 

Koeidoeltreffendheidsindeks vir 

seleksie - sien hieronder. 
 

Koeidoeltreffendheidsindeks  

(KDI) 

Die Koeidoeltreffendheidsindeks word 

bereken deur die KD waarde te deel 
deur die gemiddelde KD van die 

spesifieke groep koeie en kalwers en 
word uitgedruk as 'n persentasie. 

Skot koeie uit met twee of meer lae 

(onder 90) 
Koeidoeltreffendheidsindekse en/of 

met 'n lae gemiddelde 
Koeidoeltreffendheidsindeks. 

Produksie per Produktiewe Jaar 

(PPJ) 

Die Produksie per Produktiewe Jaar 

bereking is die kg speenkalfproduksie 
(gekorrigeer na 205 dae ouderdom) 

per produtiewe jaar van die koei. Dit 
neem dus OEK, gemid. TKP en gemid. 

205 dae gewig van ‘n koei se kalwers 

in ag. 

Skot koeie uit met ‘n Produksie per 

Produktiewe Jaar syfer wat meer as 
10% onder die gemiddeld van die 

kudde is. 

Speengewigverhouding  

(SGV) 

Die kalf se ouderdom-aangepaste (tot 

205 dae) speengewig gedeel deur die 
koeigewig by speen van die kalf, 

uitgedruk as 'n persentasie. Indien by 

Opstellings > Kuddes > 
Prestasietoetsing die opsie Bereken 

Gemiddelde Moeder 
Speengewigverhouding gebaseer op 

Individuele Diere AFgeskakel word, 
word die speengewigte van meerlinge 
bymekaar getel om die verhouding te 
bereken. 

Streef na 'n gemiddelde 

Speengewigverhouding van 45 - 50%. 
Skot koeie uit met 'n lae (onder 40%) 

gemiddelde speengewig verhouding. 

% Kalwers Gespeen  

(vir ‘n spesifieke koei) 

Die aantal gespeende kalwers van ‘n 

koei gedeel deur die totale aantal 
kalwers wat gespeen kon gewees het 

as ‘n persentasie. (Nota: ‘n Kalf word 

as gespeen gereken indien dit 'n 
geldige speengewig het (geweeg binne 

die ouderdomsgrense vir 
prestasietoetsing) EN die kalf se 

gewigtipe moet “Speengewig” wees 

EN/OF die kalf moet ‘n “Speen” rekord 
het by Prosedures). 

Skot koeie uit met 'n lae % Kalwers 

Gespeen waarde. 

Dragtigheid % Die aantal koeie dragtig gedeel deur 
die aantal koeie wat gepaar is as ‘n 

persentasie. 

 

Kalf % Die aantal koeie gekalf gedeel deur die 
aantal koeie wat gepaar is as ‘n 

persentasie. 

 

  



 79 

12 Maande (Fase B1) 

365 Dae Aangepaste Gewig  

(365D G) 

Jaargewig aangepas (of gekorrigeer) 

vir die ouderdom van die dier (na 'n 
standaard ouderdom van 365 dae) en 

aangepas vir die ouderdom van die 
moeder. Die ouderdom-van-moeder 

aanpassingsfaktor is 'n additiewe 

faktor om die dier se gewig aan te pas 
na 'n volwasse koei basis en word 

bepaal deur die ouderdom van die 
moeder, ras van die moeder en die 

geslag van die kalf. 

Gebruik die 365 Dae GDO Indeks vir 

seleksie - sien hieronder. 
 

365 Dae GDO  
(365d GDO) 

Die gemiddelde gewigstoename (in g) 
per dag vanaf geboorte tot 365 dae 

ouderdom. 

Gebruik die 365 Dae GDO Indeks vir 
seleksie - sien hieronder. 

365 Dae GDO Indeks  
(365D Ind) 

365 Dae GDO (12 maande) Indeks 
word bereken deur die dier se 365 Dae 

GDO waarde te deel deur die 
gemiddelde 365 Dae GDO van die 

betrokke groep (tydgenote) diere, 

uitgedruk as 'n persentasie. 
Omdat die 365 Dag-indeks bereken 

word op die groei vanaf geboorte, dit 
is 'n funksie van beide die moeder se 

melkproduksie, die kalf se groeivermoë 
tot op speen en die naspeense 

groeivermoë tot 12 maande. 

Skot verse en bulle met 'n lae (onder 
90) 365 Dae GDO Indeks uit. 

18 Maande (Fase B2) 

540 Dae Aangepaste Gewig  
(540D G) 

18-maande gewig aangepas (of 
gekorrigeer) vir die ouderdom van die 

dier (na 'n standaard ouderdom van 
540 dae) en aangepas vir die 

ouderdom van die moeder. Die 

ouderdom-van-moeder aanpassing 
faktor is 'n additiewe faktor om die dier 

se gewig aan te pas na 'n volwasse 
koei basis en word bepaal deur die 

ouderdom van die moeder, ras van die 
moeder en die geslag van die kalf. 

Gebruik die 540 Dae GDO Indeks vir 
seleksie - sien hieronder. 

 

540 Dae GDO  

(540D GDO) 

Die gemiddelde gewigstoename (in g) 

per dag vanaf geboorte tot 540 dae 
ouderdom. 

Gebruik die 540 Dae GDO Indeks vir 

seleksie - sien hieronder. 

540 Dae GDO Indeks  

(540D Ind) 

540 Dae GDO (18 maande) Indeks 

word bereken deur die dier se 540 Dae 
GDO waarde te deel deur die 

gemiddelde 540 Dae GDO van die 
betrokke groep (tydgenote) kalwers, 

uitgedruk as 'n persentasie. 

Omdat die 540 Dae-indeks bereken 
word op die groei vanaf geboorte, is 

dit nie net 'n funksie van naspeense 
groeivermoë nie, maar ook 

groeivermoë tot op speen. 

Skot verse en bulle met 'n lae (onder 

90) 540 Dae GDO Indeks uit. 

Gestandariseerde Sentrale Groeitoetse (Fase C) en Op-die-Plaas Groeitoetse (Fase D) 

Gemiddelde Daaglikse Toename 

(GDT) 

Die gemiddelde gewigstoename (in g) 

per dag gedurende die groeitoets. 

Gebruik die GDT Indeks vir seleksie - 

sien hieronder. 
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GDT indeks  

(GDT Ind) 

GDT indeks word bereken deur die bul 

se GDT waarde te deel deur die 

gemiddelde GDT van die betrokke 
groep (tydgenote) bulle, uitgedruk as 

'n persentasie. 
Die GDT indeks is 'n evaluering van 'n 

bul se naspeense groeivermoë. 

Skot bulle met 'n lae (onder 90) GDT 

Indeks uit. 

Gemiddelde Daaglikse toename 
per dag van Ouderdom  

(GDO) 

Die gemiddelde gewigstoename (in g) 
per dag vanaf geboorte tot aan die 

einde van die Fase C of -D toets. 

Gebruik die GDO Indeks vir seleksie - 
sien hieronder. 

 

GDO Indeks  
(GDO Ind) 

GDO Indeks word bereken deur die bul 
se GDO waarde te deel deur die 

gemiddelde GDO van die betrokke 
groep (tydgenote) bulle, uitgedruk as 

'n persentasie. 
Die GDO Indeks (soos die 540 Dae 

GDO Indeks) is 'n funksie van beide 

voorspeense- en naspeense groei. 

Skot bulle met 'n lae (onder 90) GDO 
Indeks uit. 

 

Voeromsetverhouding  

(VOV)  

[Slegs Gestandariseerde 
Sentrale Groeitoetse] 

Die aantal kg voer wat die bul verbruik 

per kg gewigstoename tydens die Fase 

C toetsperiode (84 dae). 
Let wel: Hoe laer die VOV waarde, 

hoe beter. 

Gebruik die VOV Indeks vir seleksie - 

sien hieronder. 

Voeromsetverhouding Indeks 

(VOV Ind)  

[Slegs Gestandariseerde 
Sentrale Groeitoetse] 

Voeromsetverhouding indeks druk die 

gemiddelde VOV van die betrokke 

groep (tyd) bulle uit as persentasie van 
die bul se VOV waarde. 

Let wel: Hoe hoër die VOV Indeks, 
hoe beter. 

Die VOV indeks is 'n evaluering van die 

doeltreffendheid van die omskakeling 
van voer in gewigstoename. 

Skot bulle met 'n lae (onder 90) VOV 

Indeks uit. 

Residuele Voerinname (RVI) Residuele voerinname is 'n maatstaf 

van voerdoeltreffendheid en word 
gedefinieer as die verskil tussen die 

werklike voerinname 'n dier en sy 
verwagte voerinname gebaseer op die 

grootte en groei. Dit is onafhanklik van 
die vlak van produksie, en hoe laer die 

waarde is hoe meer doeltreffend is die 

dier. 

Skot diere uit met 'n hoë Residuele 

Voerinname waarde. 

Risuduele Daaglikse Toename 
(RDT) en RDT indeks 

Residuele Daaglikse Toename word 

gedefinieer as die verskil tussen die 

werklike en voorspelde daaglikse 
gewigstoename gebaseer op die 

regressie van die daaglikse 
gewigstoename op metaboliese mid 

gewig en voerinname. Residuele 
daaglikse toename verteenwoordig die 

hoeveelheid van die liggaamsgewig-

toename wat nie verreken word deur 
verskille in voerinname en metaboliese 

mid gewig. In die algemeen, is 
Residuele Daaglikse Toename 

geassosieer met vinniger groeitempos 

terwyl dit onafhanklik is van verskille in 
voerinname. 

Skot diere uit met 'n lae Residuele 

Voerinname waarde. 
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Kleiberverhouding  

(KV)  

[Slegs Op-die-Plaas Groeitoetse] 

Die bul se GDT gedeel deur die 

metaboliese of onderhoudsgewig 

(eindgewig tot die mag 0.75). 

Gebruik die Kleiberverhouding Indeks 

vir seleksie - sien hieronder. 

 

Kleiberverhouding Indeks  

(KV Ind) [Slegs Op-die-Plaas 
Groeitoetse] 

Kleiberverhouding indeks word 

bereken deur die bul se KV waarde te 
deel deur die gemiddelde KV van die 

betrokke groep (tydgenote) bulle, 

uitgedruk as 'n persentasie. 
Die Kleiberverhouding is 'n indirekte 

evaluasie van die doeltreffendheid van 
die omskakeling van voer in 

gewigstoename. 

Skot bulle met 'n lae (onder 90) 

Kleiberverhouding Indeks uit. 

Liggaamsmates 

Gekorrigeerde Skrotumomtrek 

(Gekor. SO) 

Skrotumomtrek soos gemeet aan die 

einde van die Fase C of -D toets 

aangepas (gekorrigeer) vir die 
liggaamsgewig van die bul na 'n 

standaardgewig (bv. 425 kg) per ras. 
Skrotumomtrek is 'n indirekte evaluasie 

van testes volume. Groter testes word 

geassosieer met 'n groter volume 
semen produksie en ook tot 'n mindere 

mate, met hoër gehalte semen. 

Skot bulle met 'n lae (10% of meer 

onder die gemiddelde en/of onder die 

minimum rasstandaard) Gekorrigeerde 
Skrotumomvang uit. (bv. kudde 

gemiddeld = 340mm – skot bulle met 
'n aangepaste skrotumomvang onder 

315mm uit). 

Gekorrigeerde Skouerhoogte (of 

Heuphoogte, afhangend van 

ras) (Gekor. SH (of HH)) 

Skouerhoogte (of Heuphoogte) soos 

gemeet aan die einde van die Fase C 

of -D toets aangepas (gekorrigeer)  vir 
die ouderdom van die bul na 'n 

standaard ouderdom van 365 dae. 
Skouerhoogte (of Heuphoogte) is 'n 

aanduiding van die raamgrootte van 

die dier. 

Skot bulle met uiters lae of hoë 

Aangepaste Skouerhoogte (of 

Heuphoogte) uit. 

Gekorrigeerde Liggaamslengte 

(Gekor. LL) 

Liggaamslengte soos gemeet aan die 

einde van die Fase C of -D toets 

aangepas aangepas (gekorrigeer) vir 
die ouderdom van die bul na 'n 

standaard ouderdom van 365 dae. 

Selekteer bulle met 'n bogemiddelde 

Aangepaste Liggaamslengte. 

 

Lengte/Hoogte verhouding  

(H:L verhouding) 

Liggaamslengte gedeel deur 

Skouerhoogte (of Heuphoogte) 

verhouding. 

Selekteer bulle met 'n bogemiddelde 

Lengte/Hoogte Verhouding. 

Bosluisweerstand   

Bosluisweerstand Indeks  

(BW Ind)  
[Slegs veld Op-die-Plaas 

Groeitoetse] 

Die aantal bosluise op spesifieke 

plekke op die liggaam van die bul kan 
met gereelde tussenposes tydens die 

Fase D toets getel word. Die 
Bosluisweerstand Indeks word bereken 

deur die gebruik van die logaritme van 

die totale aantal bosluise op ‘n bul in 
verhouding met die logaritme van die 

gemiddelde aantal bosluise getel op 
die betrokke groep (tydgenote) bulle, 

uitgedruk as 'n persentasie. 

Die Bosluisweerstand Indeks evalueer 
die relatiewe weerstand van die dier 

teen bosluis besmetting. 

Selekteer bulle met 'n bogemiddelde 

Bosluisweerstand Indeks. 
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Karkaseienskappe (RTU Metings) 

Binnespierse Vet (marmering) % 

(BSV %) 

Die % binnespierse vet (marmering) in 

die oogspier, soos gemeet deur 
ultrasoniese skandering van die 

lewendige dier. 
Hoër binnespierse vet % hou verband 

met smaakliker en sagte vleis. 

Gebruik die binnespierse vet % Indeks 

vir seleksie - sien hieronder. 

Binnespierse Vet (marmering) % 
Indeks  

(BSV % Ind) 

Binnespierse Vet % Indeks word 
bereken deur die dier se BSV % 

waarde te deel deur die gemiddelde 

BSV% waarde van die betrokke groep 
(tydgenote) diere, uitgedruk as 'n 

persentasie. 

Selekteer vir 'n bogemiddelde 
Binnespierse Vet % Indeks INDIEN dit 

as belangrik geag word en/of van 

ekonomiese waarde is vir jou mark. 

Karkas Rooivleis %  

(KRV %) 

Die persentasie van die karkasgewig 

wat bestaan uit vleis, insluitende 

binnespierse vet. 

Gebruik die Karkas Rooivleis % Indeks 

vir seleksie - sien hieronder. 

Karkas Rooivleis % Indeks  

(KRV % Ind) 

Karkas Rooivleis % indeks word 

bereken deur die dier se KRV % 

waarde te deel deur die gemiddelde 
KRV % waarde van die betrokke groep 

(tydgenote) diere, uitgedruk as 'n 
persentasie. 

Selekteer vir 'n bogemiddelde Karkas 

Rooivleis % Indeks. 

Spier %  

(S %) 

Die persentasie spier in die karkas 

relatief tot die lewende gewig van die 
dier. Die S % berekening is lewende 

gewig x uitslag % x KRV %. 

Gebruik die Spier % Indeks vir seleksie 

- sien hieronder. 

Spier % Indeks  
(S % Ind) 

Spier % indeks word bereken deur die 
bul se S % waarde te deel deur die 

gemiddelde S % waarde van die 
betrokke groep (tydgenote) diere, 

uitgedruk as 'n persentasie. 

Selekteer vir 'n bogemiddelde Spier % 
Indeks. 

Kg Voorspelde Rooivleis  
(Kg VRV) 

'n Beraming van die kilogram spier wat 
die lewendige dier sal produseer (in 

karkas vorm). 

Selekteer vir 'n bogemiddelde Kg 
Voorspelde Rooivleis. 

 

Retensie van Nageslag (slegs vir geregistreerde/stoet beeste) 

Goedkeuring %  

(Goedgek. %) 

[Slegs van toepassing op 
stoetteling beeste met verpligte 

inspeksie vir registrasie 
doeleindes] 

Goedkeuring % is die aantal nageslag 

goedgekeur tydens inspeksie, gedeel 

deur die aantal nageslag wat 
aangebied was vir inspeksie, uitgedruk 

as 'n persentasie. 

Selekteer koeie en bulle met 'n 

bogemiddelde Goedkeuring % oor hul 

nageslag. 
 

Pelviese Metings 

Aangepaste Pelviese Area  
(APA) 

Aangepaste Pelviese Area word 
bereken deur die pelviese opening 

hoogte te vermenigvuldig met die 

pelvis opening breedte, aangepas vir 
die dier se ouderdom en geslag. 

Aangepaste Pelviese Area word gebruik 
om die kalwingsgemak te voorspel by 

verse. 

Skot verse met 'n lae Aangepaste 
Pelviese Area uit of gebruik die 

Aangepaste Pelviese Area Indeks vir 

seleksie - sien hieronder. 
 

Aangepaste Pelviese Area 
Indeks (APA Ind) 

Aangepaste Pelviese Area Indeks word 
bereken deur die dier se APA waarde 

te deel deur die gemiddelde APA van 
die betrokke groep (tydgenote) diere, 

uitgedruk as ‘n persentasie. 

Skot verse met 'n lae (onder 90) 
Aangepaste Pelviese Area Indeks uit. 
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Bylaag G 
 

Kontakbesonderhede 
 
Vir navrae en hulp met betrekking tot BenguFarm BEEF, skakel asseblief jou toegekende agent. 

 

NAAM KAPASITEIT KANTOOR SEL NO E-POS 

Leslie Bergh Projekleier & Agent Pretoria 082 801 2026 bengufarm@gmail.com 

Naomi Havenga Registrasie van Sagteware Pretoria 082 696 8306 havenga.naomi@gmail.com 

Johan de Jager Agent Potchefstroom 083 305 1042 jjager@mweb.agric.za 

Martiens Aveling Agent Bethlehem 083 309 7355 aveling@telkomsa.net 

Erick Joosten Agent Somerset-Wes 082 204 2379 erickjoosten@gmail.com 

Internasionale skakelkode vir Suid-Afrika: +27  

 
Webwerf: www.bengufarm.co.za 

 
BenguFarm agente maak gebruik van Teamviewer sagteware vir afstand (Internet) ondersteuning. 

Teamviewer kan, indien geïnstalleer, vanuit BenguFarm oopgemaak word deur op die hoofskerm te gaan na Hulp > 

Teamviewer Afstand Ondersteuning. Indien nie geïnstalleer, kan Teamviewer afgelaai en geïnstalleer word by 
www.teamviewer.com. Indien jy ondersteuning met behulp van Teamviewer benodig, maak jou Teamviewer oop 

(maak seker jou Internet verbinding is aangeskakel), kontak jou BenguFarm agent en verskaf aan hom/haar jou 
Teamviewer ID en wagwoord. 

 

 
 

Opleidingskursusse en individuele opleiding 
 
BenguFarm BEEF gebruikers word per e-pos deur middel van die BenguFarm Nuusbrief in kennis gestel van die 
betrokke datums, plekke en ander detail wanneer daar kursusse gereël is. Hierdie inligting word ook op die webwerf 

www.bengufarm.co.za > Training geplaas. 
 

Vir individuele of klein groepie (1-3 persone) of aanlyn opleiding, kontak jou BenguFarm agent of kontak mnr. Leslie 

Bergh by 082 801 2026 of e-pos bengufarm@gmail.com of mnr. Johan de Jager by 083 305 1048 of e-pos 
jjager@mweb.co.za. 

 

mailto:erickjoosten@gmail.com

